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This is a monthly deep audit. The crawler performed a full-site scan including

Lighthouse performance, axe-core accessibility (WCAG 2.2 AA), cross-browser compatibility,

security headers, schema markup validation, and SEO best-practice checks.

Because this site is not a repository we control, Apex Sentinel **cannot automatically

apply fixes** — instead, each finding below includes an AI-generated plain-English

explanation + step-by-step recommended fix you can hand to a developer or execute

in your CMS directly.

Executive Summary

Overall grade: F

DIMENSION COUNT MEANING

Pages crawled 250 Full sitemap + linked pages

P0 (critical) 1 Site-down or compliance-breaking

P1 (urgent) 4 Significant revenue / SEO / UX impact

https://leafologycannabiscompany.com/


DIMENSION COUNT MEANING

P2 (high) 506 Quality / ranking / trust degradation

P3 (medium) 794 Polish + optimization

"Do first" items 4 AI-flagged top priorities

Quick wins (< 30 min) 55 Fastest ROI items

Top 10 Actions (Ranked)

If you only have time for ten things this month, do these — in this order.

1. [P0] 🔴  DO FIRST Sensitive artifact exposed: /wp-login.php — _An attacker gaining admin access could

deface your site, steal customer data, inject malware, or take your dispensary offline—directly harming

customer trust and revenue._

Page: https://leafologycannabiscompany.com/wp-login.php

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST Slow LCP (mobile): 6652ms — _Mobile visitors (likely 60%+ of cannabis shoppers)

abandon slow sites within 3 seconds, directly reducing store visits, product discovery, and age-gated entry

conversions._

Page: https://leafologycannabiscompany.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST A11y: Elements must meet minimum color contrast ratio thresholds (×36) — _Low

contrast violates accessibility law (ADA in the US) and excludes customers with vision impairment from

browsing or purchasing; it also signals poor quality to all visitors and may trigger automated legal risk for

your business._

Page: https://leafologycannabiscompany.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST A11y: All touch targets must be 24px large, or leave sufficient space (×5) — _Mobile

users—particularly those with limited dexterity or vision—may struggle to open product categories,

frustrating them and causing lost sales. This also exposes you to accessibility complaints and potential legal

liability under WCAG compliance expectations._

Page: https://leafologycannabiscompany.com/

Effort: Quick win (< 30 min)

1. [P1] 🟠  HIGH Lighthouse bestPractices (desktop): 56/100 — _A low Best Practices score signals to

Google that your site may have trust or security concerns, which can reduce organic search visibility and

customer confidence—especially critical for a cannabis retailer where compliance and legitimacy directly

influence purchase decisions._

https://leafologycannabiscompany.com/wp-login.php
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https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/


Page: https://leafologycannabiscompany.com/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH Missing meta description — _A missing meta description reduces click-through rate from

search results; potential customers see a generic snippet instead of your best sales pitch, costing you traffic

and revenue._

Page: https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-

plains/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH No JSON-LD schema — _Missing schema markup reduces visibility in Google Search results

and eliminates opportunities for featured snippets or rich results, directly impacting organic traffic to your

educational content and brand authority in cannabis retail._

Page: https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-

plains/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH Missing meta description — _Missing meta descriptions reduce click-through rates from

search results, meaning fewer visitors discovering your educational content and product offerings, even if

the page ranks well._

Page: https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH Missing meta description — _Customers searching for cannabis education content see a

broken or generic preview, reducing click-through rate from search results and losing potential traffic to

competitors with complete meta descriptions._

Page: https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-

flavonoids-in-white-plains/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH Missing meta description — _Missing meta descriptions reduce click-through rates from

search results; customers see a jumbled preview instead of your marketing message, costing you organic

traffic and sales._

Page: https://leafologycannabiscompany.com/blog/no-smoke-no-problem/

Effort: Quick win (< 30 min)

Findings by Severity

P0 — 1 finding

1. Sensitive artifact exposed: /wp-login.php

Severity: P0 | Priority: 🔴  DO FIRST
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Effort: Quick win (< 30 min)

Business category: security

Page URL: https://leafologycannabiscompany.com/wp-login.php

Rule: tier5.exposed.artifact

What it means (plain English)

Your WordPress admin login page (/wp-login.php) is publicly accessible and visible to search engines and

attackers. While this is WordPress's default behavior, it's a security risk because bad actors can attempt to

guess passwords or exploit known vulnerabilities. Blocking this page at your web server (before it even reaches

WordPress) prevents unauthorized access attempts.

Why it matters for your business: An attacker gaining admin access could deface your site, steal customer

data, inject malware, or take your dispensary offline—directly harming customer trust and revenue.

Technical root cause: WordPress exposes /wp-login.php by default, and your server (or CDN/firewall) is not

configured to block or redirect this path before it reaches WordPress.

Recommended fix — step by step

1. Log in to your WordPress hosting control panel (cPanel, Plesk, or your host's dashboard) and locate the

.htaccess file in your public_html or www root directory.

2. Add these lines near the top of .htaccess (before any existing WordPress rules): <IfModule mod_rewrite.c>

RewriteEngine On RewriteRule ^wp-login\.php$ - [F,L] RewriteRule ^wp-admin/$ - [F,L] </IfModule>

3. Save and test by visiting https://leafologycannabiscompany.com/wp-login.php in a browser—you should see

a 403 Forbidden error.

4. If you use a security plugin (Wordfence, Sucuri, iThemes Security), enable 'Limit Login Attempts' and 'Hide

Admin Area' in its settings as an additional layer.

5. Consider enabling two-factor authentication (2FA) on all admin accounts: install 'Wordfence Security' or

'Google Authenticator' plugin and activate 2FA for every user with admin or editor role.

P1 — 4 findings

1. Slow LCP (mobile): 6652ms

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: revenue

Page URL: https://leafologycannabiscompany.com/

Rule: tier3.cwv.lcp-mobile

What it means (plain English)

Your homepage takes 6.6 seconds to display its largest visual element (usually a hero image or banner) on

mobile devices. Google and users consider anything over 2.5 seconds slow. This delay happens because the

page loads 210 requests, 829KB of JavaScript, and 2.7MB of images — far more than necessary for a first

impression.

Why it matters for your business: Mobile visitors (likely 60%+ of cannabis shoppers) abandon slow sites

within 3 seconds, directly reducing store visits, product discovery, and age-gated entry conversions.

https://leafologycannabiscompany.com/wp-login.php
https://leafologycannabiscompany.com/wp-login.php
https://leafologycannabiscompany.com/


Technical root cause: The homepage is bloated with unoptimized images (2.7MB total), unminified or render-

blocking JavaScript (829KB), and excessive third-party requests. WordPress themes often load all assets on

every page and don't lazy-load images below the fold.

Recommended fix — step by step

1. Install ShortPixel Image Optimizer or Smush Pro (free tier): activate, bulk-optimize all existing images,

enable WebP conversion and lazy-loading in settings.

2. Install Autoptimize: Settings → CSS, JavaScript, HTML → enable minify and aggregate for JS/CSS; enable

'Defer JavaScript' under JS options.

3. In WordPress Admin → Settings → Media, confirm 'Image Sizes' has Large set to max 1200px width;

regenerate thumbnails using Regenerate Thumbnails plugin.

4. Audit plugins: Dashboard → Plugins, deactivate any unused plugins (contact forms, analytics duplicates,

page builders not in active use); remove 2-3 least-critical ones.

5. Test with Google PageSpeed Insights (paste https://leafologycannabiscompany.com/ into

tool.google.com/speed/page-insights); identify 'Eliminate render-blocking resources' items and defer them

via Autoptimize.

6. Use GTmetrix (gtmetrix.com) to waterfall: identify slow third-party domains (ads, analytics, chat widgets);

disable or defer non-critical ones.

7. Install WP Super Cache or W3 Total Cache; enable page caching (set 3600s TTL) and browser caching in

settings.

2. A11y: Elements must meet minimum color contrast ratio thresholds (×36)

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: compliance

Page URL: https://leafologycannabiscompany.com/

Rule: tier9.a11y.color-contrast

What it means (plain English)

Your website has 36 places where text and background colors don't have enough contrast — meaning visitors

with low vision or color blindness can't easily read buttons, links, and menu items. The most common issue is

white text (#ffffff) on a bright blue background (#1ea8e0), which fails the legal accessibility standard (WCAG 2

AA). This affects navigation menus, 'Shop Now' buttons, and 'Add to Cart' buttons.

Why it matters for your business: Low contrast violates accessibility law (ADA in the US) and excludes

customers with vision impairment from browsing or purchasing; it also signals poor quality to all visitors and

may trigger automated legal risk for your business.

Technical root cause: The site's color palette (white text on #1ea8e0 cyan) has a contrast ratio of 2.71:1, but

WCAG 2 AA requires 4.5:1 for normal text. This is baked into the theme CSS and affects multiple component

templates (buttons, navigation, sliders).

Recommended fix — step by step

1. Log into WordPress Admin → Appearance → Customize (or Theme File Editor if using a custom theme)

2. Locate the button/CTA color rules (likely in style.css or a custom CSS section); find background-color:

#1ea8e0 and foreground-color: #ffffff

3. Replace #1ea8e0 with a darker blue such as #0066cc or #0052a3, OR change text from #ffffff to #1a1a1a

(dark gray/black)

https://leafologycannabiscompany.com/
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4. Test contrast using WebAIM Contrast Checker (https://webaim.org/resources/contrastchecker/) — enter the

new hex codes to confirm 4.5:1 or higher ratio

5. Apply the same fix to all instances: primary CTA buttons, secondary outline buttons (btn-primary-outline),

and menu links

6. Use browser DevTools (F12 → Inspect) to find all selectors with #1ea8e0 and update in one place (e.g.,

global CSS variable or theme options)

7. Re-test the homepage, product pages, and checkout flow using axe DevTools browser extension to confirm

all 36 instances are fixed

8. If your theme has a theme customizer color picker, use it to update brand colors globally rather than editing

raw CSS

3. A11y: All touch targets must be 24px large, or leave sufficient space (×5)

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://leafologycannabiscompany.com/

Rule: tier9.a11y.target-size

What it means (plain English)

Your navigation menu has five small dropdown buttons (the tiny arrows that expand submenus) that are only

19×8 pixels. Accessibility standards require all clickable elements to be at least 24×24 pixels OR have sufficient

spacing around them so users can easily tap or click without hitting adjacent buttons. This is especially

important on mobile devices where fingers are larger than mouse pointers.

Why it matters for your business: Mobile users—particularly those with limited dexterity or vision—may

struggle to open product categories, frustrating them and causing lost sales. This also exposes you to

accessibility complaints and potential legal liability under WCAG compliance expectations.

Technical root cause: The submenu toggle buttons use a CSS class (btn-reset) that strips default button

sizing, and the dropdown arrow icons are styled to only 19px wide by 8px tall without adequate padding or

margin spacing to meet the 24px minimum touch target requirement.

Recommended fix — step by step

1. In WordPress admin, go to Appearance → Customize → Additional CSS (or your child theme's style.css if you

have one).

2. Add this CSS rule: button[aria-label*="Submenu"] { min-width: 24px; min-height:
24px; padding: 8px 12px; } to ensure all submenu buttons meet the 24×24px minimum.

3. If padding alone doesn't increase visible size, add display: inline-flex; align-items:
center; justify-content: center;  to center the icon inside the larger button.

4. Test on mobile by opening https://leafologycannabiscompany.com/ on an iPhone or Android device and

verify the dropdown arrows are now easier to tap without hitting the neighboring menu items.

5. Run an accessibility audit using the axe DevTools browser extension (free, available for Chrome/Firefox) to

confirm all 5 buttons now pass the target-size rule.

6. If your theme uses a page builder (Elementor, Divi, etc.), go to the menu/navigation module settings and

increase the 'Touch Target Size' or 'Icon Size' setting to 24px or larger as an alternative.

4. Lighthouse bestPractices (desktop): 56/100

https://webaim.org/resources/contrastchecker/)
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Severity: P1 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: compliance

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lighthouse.bestPractices-desktop

What it means (plain English)

Your site's Lighthouse Best Practices score is 56 out of 100, which is significantly below the healthy target of

90. This score reflects issues with how your site handles security, third-party code, browser compatibility, and

user trust signals. Lighthouse is Google's automated audit tool that checks for practices that affect how safe,

reliable, and user-friendly your site appears to search engines and visitors.

Why it matters for your business: A low Best Practices score signals to Google that your site may have trust

or security concerns, which can reduce organic search visibility and customer confidence—especially critical for

a cannabis retailer where compliance and legitimacy directly influence purchase decisions.

Technical root cause: The detailed Lighthouse report shows specific failures in areas like insecure third-party

dependencies, missing security headers, outdated JavaScript libraries, or unverified HTTPS implementations.

WordPress sites often accumulate these issues through plugins that bundle old libraries or lack proper security

configuration.

Recommended fix — step by step

1. Download and open the full Lighthouse HTML report at /Users/markwallace/BKH/apex-sentinel/runs/2026-

04-19T06-18-18-831Z/lighthouse/leafology-cannabis/lighthouse-desktop.html to see the exact failures

(e.g., 'Uses vulnerable JavaScript library' or 'Missing security header X-Frame-Options').

2. In WordPress admin, go to Plugins → Installed Plugins and deactivate any plugins you don't actively use;

check each plugin's release date and deactivate those not updated in 12+ months.

3. Install and activate a security hardening plugin (e.g., Wordfence or All In One WP Security & Firewall); enable

'Hide WordPress Version' and activate 'Prevent Plugin/Theme Enumeration' in settings.

4. Go to Dashboard → Yoast SEO (if installed) or use a tool like HeadersCheck.com to verify your site is

returning security headers (X-Frame-Options: SAMEORIGIN, X-Content-Type-Options: nosniff, Content-

Security-Policy). If missing, ask your hosting provider to add them via .htaccess or server config.

5. Check Settings → General and Settings → Reading to confirm your WordPress address and home URL both

use https:// (not http://); if not, update both and resave.

6. In WordPress admin, navigate to Tools → Site Health and review any red or yellow warnings; these often

pinpoint security or Best Practices gaps.

7. After fixes, re-run Lighthouse (via Chrome DevTools → Lighthouse → Generate report) to confirm the score

improves above 80.

P2 — 506 findings

1. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://leafologycannabiscompany.com/
http://);/


Page URL: https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-

in-white-plains/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about cannabis strains doesn't have a meta description — the 150-160 character summary that

appears under your page title in Google search results. Without it, Google will randomly pull text from your

page, which may not be compelling or relevant to searchers.

Why it matters for your business: A missing meta description reduces click-through rate from search results;

potential customers see a generic snippet instead of your best sales pitch, costing you traffic and revenue.

Technical root cause: The WordPress post was published without a meta description being filled in the SEO

plugin (or no SEO plugin is installed). WordPress does not auto-generate these.

Recommended fix — step by step

1. Install Yoast SEO (free version) via WordPress Dashboard → Plugins → Add New → search 'Yoast SEO' →

Install Now → Activate

2. Go to Posts → All Posts, click 'Edit' on the 'Beginners Guide to Different Cannabis Strains' post

3. Scroll to the Yoast SEO box at the bottom; click the 'Readability' tab

4. In the 'Meta description' field, write 150–160 characters covering the post topic, e.g.: 'Explore popular

cannabis strains in White Plains. Learn strain types, effects, and how to choose the right product for your

needs.'

5. Click 'Save Draft' or 'Update' to publish the change

6. Set a recurring task (monthly) to audit blog posts in Yoast's 'SEO' dashboard for missing or thin descriptions

across all blog posts

2. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-

in-white-plains/

Rule: tier2.schema.none

What it means (plain English)

Your blog post lacks JSON-LD structured data — machine-readable code that tells Google what your content is

about. Without it, search engines can't confidently categorize your post as a guide, article, or educational

content, which means lower chances of appearing in rich snippets (special formatted results) or knowledge

panels.

Why it matters for your business: Missing schema markup reduces visibility in Google Search results and

eliminates opportunities for featured snippets or rich results, directly impacting organic traffic to your

educational content and brand authority in cannabis retail.

Technical root cause: WordPress site is not outputting JSON-LD schema blocks for blog posts. This typically

happens when the active theme and plugins don't include schema generation, or the site lacks an SEO plugin

with schema functionality enabled.

Recommended fix — step by step
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1. Install and activate the free 'Yoast SEO' plugin: WordPress admin → Plugins → Add New → search 'Yoast

SEO' → Install Now → Activate

2. Go to Yoast SEO → Settings → Appearance in Search → scroll to 'Schema output' and ensure 'Enable' is

toggled ON

3. Edit the affected blog post: WordPress admin → Posts → The Beginner's Guide to Different Cannabis Strains

in White Plains

4. In the Yoast SEO metabox (below editor), set Content Type to 'Article' and fill in Headline, Publish Date, and

Author fields

5. Verify schema output: publish the post, visit the live URL, open browser DevTools (F12) → Sources, search

for 'schema.org' in page HTML to confirm JSON-LD block is present

6. Repeat for all blog posts in your archive to establish consistent schema coverage

3. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about cannabis and pain relief is missing a meta description—the 150-160 character summary

that appears under your page title in Google search results. Without it, Google generates a random snippet from

your content, which often looks unprofessional and doesn't tell potential customers why they should click.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer visitors discovering your educational content and product offerings, even if the page ranks well.

Technical root cause: The WordPress post was published without a meta description field filled in, likely

because no SEO plugin is managing this field or the description was left blank during publishing.

Recommended fix — step by step

1. Install Yoast SEO (free version) via WordPress Dashboard → Plugins → Add New → search 'Yoast SEO' →

Install Now → Activate.

2. Go to Posts → Edit the 'What Can Weed Do for Pain' post.

3. Scroll to the Yoast SEO box at the bottom; under 'Snippet Editor' click the pencil icon next to the meta

description field.

4. Write a 155-160 character description like: 'Learn how cannabis may help manage chronic pain, including

effects, strains, and dosing advice from Leafology Cannabis Co.'

5. Click the checkmark and update the post.

6. Repeat this fix for all other blog posts missing meta descriptions by filtering in the Posts list for ones without

Yoast indicators.

4. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/


Page URL: https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-

and-flavonoids-in-white-plains/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about cannabis terpenes and flavonoids is missing a meta description — the 150-160 character

summary that appears below your page title in Google search results. Without it, Google generates a random

snippet from your page content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Customers searching for cannabis education content see a broken or

generic preview, reducing click-through rate from search results and losing potential traffic to competitors with

complete meta descriptions.

Technical root cause: The WordPress post was published without filling in the meta description field in the SEO

plugin (likely Yoast SEO, Rank Math, or All in One SEO), or the theme does not enforce this field as required

during publishing.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → find 'The Science of Cannabis: Understanding Terpenes and

Flavonoids in White Plains'

2. Scroll to the SEO plugin section at the bottom of the editor (Yoast, Rank Math, or All in One SEO depending

on which you use)

3. In the meta description field, write a unique 155-160 character description: e.g., 'Discover how cannabis

terpenes and flavonoids create unique effects. Learn the science behind strain profiles at Leafology

Cannabis Co in White Plains.'

4. Ensure the description includes your primary keyword (cannabis + location) and a call-to-action if space

allows

5. Click Update to save the post

6. Check Google Search Console (in 24-48 hours) to verify the new description appears in search results

5. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about smoke-free cannabis consumption has no meta description—the short text snippet that

appears under your page title in Google search results. Without it, Google generates a random excerpt from

your content, which often looks unprofessional and doesn't tell potential customers why they should click.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

customers see a jumbled preview instead of your marketing message, costing you organic traffic and sales.

Technical root cause: The WordPress SEO plugin (likely Yoast, Rank Math, or All in One SEO) is either not

configured for this post, or the description field was left blank when the post was published.

Recommended fix — step by step

1. Log into WordPress admin → Posts → All Posts → find 'no-smoke-no-problem' post → click Edit.
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2. Scroll to the SEO plugin panel at the bottom of the editor (look for Yoast, Rank Math, or similar branding).

3. Locate the 'Meta Description' or 'Description' field and enter a 150-160 character summary, e.g., 'Explore

smoke-free cannabis methods: vaping, edibles, and tinctures. Discover the benefits and best practices for

healthier consumption at Leafology.'

4. Click 'Update' to save the post.

5. Repeat this process for all blog posts showing this error (audit your top 10 blog posts first).

6. Consider setting a WordPress plugin reminder or editorial checklist to enforce meta descriptions on all

future posts at publish time.

6. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis products lacks structured data — machine-readable markup that tells Google

what your content is about. Without it, search engines have to guess whether a page is a product listing, an

article, a review, or something else. This is particularly important for cannabis sites, where clarity helps Google

understand compliance context.

Why it matters for your business: Missing schema markup reduces your chances of appearing in Google's

rich results (like snippets or carousels), which typically drive 15–30% of organic traffic to content sites. It also

makes it harder for search engines to correctly categorize your age-restricted cannabis content.

Technical root cause: The page contains no JSON-LD blocks in its HTML head or body. WordPress doesn't

automatically output structured data unless you use an SEO plugin or manually add it to your theme template.

Recommended fix — step by step

1. Install the free Yoast SEO plugin (Plugins → Add New → search 'Yoast SEO' → Install Now → Activate).

2. Go to the blog post editor (Posts → Edit the 'No Smoke, No Problem' post).

3. In the Yoast SEO panel (bottom of the editor), ensure 'Content type' is set to 'Blog post' and fill in the 'Focus

keyphrase' field with your target keyword.

4. Scroll to Yoast's 'Schema' section and confirm Article schema is enabled (it should auto-enable for posts).

5. Go to Yoast Settings (Dashboard → SEO → Settings → Schema) and enable 'Organization' schema with your

dispensary details (name, address, phone).

6. If your post reviews or recommends specific cannabis strains/products, edit the Yoast schema to include

Product or Review schema via the 'Structured data blocks' option.

7. Save and re-publish the post; verify the schema appears by pasting the URL into Google's Rich Results Test

(search.google.com/test/rich-results).

7. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://leafologycannabiscompany.com/blog/no-smoke-no-problem/


Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-

exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about cannabis edibles in White Plains is missing a meta description — the 150-160 character

summary that appears below the page title in Google search results. Without it, Google may auto-generate a

less compelling snippet, reducing click-through rates from search.

Why it matters for your business: Missing meta descriptions lower click-through rates from organic search;

for a lifestyle cannabis retailer competing for local traffic, this directly reduces qualified visitors and potential

customers finding your edibles content.

Technical root cause: The WordPress post was published without manually entering a meta description in the

SEO plugin (likely Yoast SEO or Rank Math), and no default fallback was configured.

Recommended fix — step by step

1. Log into WordPress → Posts → select the blog post 'No Smoke, No Problem…'

2. Scroll to the SEO plugin section (Yoast SEO or Rank Math) at the bottom of the editor

3. Find the 'Meta description' field and enter a unique 150-160 character description, e.g.: 'Explore premium

cannabis edibles in White Plains & Westchester. Flavors, dosing, and effects explained by Leafology

Cannabis Co.'

4. Ensure the description includes your location (White Plains/Westchester) and primary keyword (edibles)

5. Click 'Update' to save the post

6. Repeat this process for all other blog posts missing meta descriptions (audit the entire /blog/ section)

8. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-

exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/

Rule: tier2.schema.none

What it means (plain English)

Your blog post isn't labeled with machine-readable metadata (JSON-LD) that search engines use to understand

what the page is about. This is like publishing a book without a title or table of contents — humans can read it,

but automated systems can't categorize it properly. Without this markup, search engines may struggle to

display your content in rich results (like knowledge panels or featured snippets).

Why it matters for your business: Missing schema markup reduces the likelihood your blog content appears in

Google's enhanced search results, limiting organic traffic to your lifestyle content and competitive blog pages.

Technical root cause: The WordPress installation is not generating or inserting JSON-LD schema blocks for

blog posts. This typically happens when no SEO plugin is active, or an existing plugin isn't configured to output

schema for post types.

Recommended fix — step by step

1. Install Yoast SEO (free tier) via WordPress Admin → Plugins → Add New → search 'Yoast SEO' → Install →

Activate.

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/
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2. Go to Yoast SEO → Settings → Features → toggle 'Schema output' ON.

3. Go to Yoast SEO → Settings → Taxonomies → ensure 'Blog' or your post type is set to 'Show in search

results'.

4. Edit the affected blog post → scroll to Yoast meta box at bottom → confirm 'Focus keyphrase' is filled (e.g.,

'cannabis edibles White Plains') and readability/SEO lights are green.

5. Save the post. Verify schema is now present by visiting the URL, right-clicking → Inspect → search for

'<script type="application/ld+json">' in the HTML.

6. Repeat for other lifestyle blog posts to ensure consistent schema coverage.

9. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-

elevating-your-cannabis-experience-with-potent-and-portable-options/

Rule: tier2.schema.none

What it means (plain English)

Your blog post doesn't include structured data — machine-readable code that tells Google and other search

engines what your content is about. Without it, search engines have to guess whether a page is a blog post,

product review, or something else, which means your content is less likely to appear in rich search results (like

snippet boxes or knowledge panels).

Why it matters for your business: Missing schema markup reduces your chances of ranking in featured

snippets and specialty search results, which directly impacts organic traffic to your blog content and brand

authority in the cannabis lifestyle space.

Technical root cause: WordPress themes and plugins don't automatically add JSON-LD schema to blog posts.

The schema must be explicitly generated via a plugin like Yoast SEO, RankMath, or All in One SEO, or hand-

coded into the post template.

Recommended fix — step by step

1. Install a schema-aware SEO plugin: go to WordPress Admin → Plugins → Add New → search 'Yoast SEO' →

Install and Activate (free tier includes basic schema)

2. Go to Yoast SEO → Search Appearance → Content Types → toggle 'Show BlogPosting schema' to ON

3. Edit the affected blog post in WordPress → scroll to the Yoast SEO meta box → verify 'Schema' tab shows

'BlogPosting' selected

4. If using a different plugin (RankMath, All in One SEO), navigate to that plugin's schema settings and enable

'Article' or 'BlogPosting' for posts

5. Regenerate your sitemap: go to the SEO plugin → Sitemaps → regenerate XML sitemap

6. Test the page: open Google Search Console → URL Inspection → paste the blog URL → inspect → scroll to

'Rich Results' to confirm schema is detected

10. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-elevating-your-cannabis-experience-with-potent-and-portable-options/
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Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-elevate-your-culinary-

creations-cooking-with-cannabis-in-white-plains-westchester/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page doesn't have a meta description — the 155-character summary that appears below the

page title in Google search results. Without it, Google generates a random snippet from your content, which is

often awkward or incomplete. This matters because people decide whether to click your link based partly on

that summary.

Why it matters for your business: A weak or missing description reduces click-through rate from search

results, meaning fewer visitors reach this content even if the page ranks well for cannabis cooking keywords in

your area.

Technical root cause: The WordPress blog post was published without a meta description field being filled in.

Most WordPress themes and SEO plugins provide this field by default, but it requires manual input for each

post.

Recommended fix — step by step

1. Log into WordPress admin → Posts → select the 'No Smoke, No Problem...' post

2. Scroll to the SEO plugin section (likely Yoast SEO, Rank Math, or All in One SEO) below the editor

3. Locate the 'Meta Description' field and write a 150–160 character description, e.g.: 'Discover cannabis

cooking tips and edible recipes for Westchester. Learn how to infuse cannabis into your favorite dishes

safely and legally.'

4. Include your target keyword ('cannabis cooking', 'edibles', or 'Westchester') naturally in the description

5. Click 'Update' or 'Save' to publish the change

6. Repeat this process for all other blog posts lacking descriptions (use your SEO plugin's audit tool to find

them)

11. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-elevate-your-culinary-

creations-cooking-with-cannabis-in-white-plains-westchester/

Rule: tier2.schema.none

What it means (plain English)

Your blog post is missing structured data—a machine-readable format that tells Google what your content is

about. Without it, search engines treat your post as plain text and can't easily understand that it's an article

about cannabis cooking. This makes it harder for Google to rank it and show it in search results.

Why it matters for your business: Missing schema markup reduces your chances of ranking in Google search

results for cannabis-related queries and blocks eligibility for rich snippets (like star ratings or publication date

displays) that drive clicks.

Technical root cause: WordPress sites need either a dedicated SEO plugin (like Yoast SEO, Rank Math, or All in

One SEO) configured to auto-generate JSON-LD, or manual schema code added to the page template. Your site

is currently generating none.

Recommended fix — step by step

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-elevate-your-culinary-creations-cooking-with-cannabis-in-white-plains-westchester/
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1. Install and activate Yoast SEO Premium (if not already installed): WordPress Dashboard → Plugins → Add

New → search 'Yoast SEO' → Install Now → Activate

2. Go to Yoast SEO → Settings → Advanced Settings and enable 'Crawl optimization' and 'XML sitemaps'

3. Navigate to the blog post editor and scroll to the Yoast SEO metabox at the bottom; ensure 'Content type' is

set to 'Article' and fill in 'Article meta' fields (publication date, author)

4. Alternatively, if using Rank Math: Activate Rank Math plugin, go to Rank Math → Settings → Schema and

enable 'Article' schema for blog posts

5. Publish or update the post; verify schema was added by visiting the post URL in Google's Rich Results Test

(https://search.google.com/test/rich-results) and pasting the URL

6. Repeat for all published blog posts, or use the plugin's bulk schema assignment feature

12. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/differences-between-distillate-live-resin-and-rosin-

vapes-in-white-plains-westchester/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about vape types is missing a meta description — the short text (usually 150–160 characters)

that appears under your page title in Google search results. Without it, Google generates a random snippet from

the page, which often looks unprofessional and fails to convince readers to click.

Why it matters for your business: A missing or auto-generated description reduces click-through rate from

search results, directly lowering traffic to a high-intent content page that could drive dispensary visits or

product awareness.

Technical root cause: The WordPress post was published without manually setting a meta description field,

either because no SEO plugin was configured to require it, or the field was left blank during editorial workflow.

Recommended fix — step by step

1. Log into WordPress admin → Posts → edit the affected post ('Differences Between Distillate, Live Resin, and

Rosin Vapes…')

2. Scroll to the Yoast SEO or Rank Math box at the bottom of the editor (if installed; if not, install one via

Plugins → Add New → search 'Yoast SEO')

3. In the SEO plugin's 'Snippet Editor' or 'Meta Description' field, write a description 155–160 characters

mentioning the vape types and White Plains location, e.g.: 'Learn the differences between distillate, live

resin, and rosin vapes. Shop premium vape products at Leafology Cannabis in Westchester.'

4. Click 'Update' to save the post

5. Audit all other blog posts for missing descriptions using Yoast's 'SEO → Internal Linking' or 'All Posts' view

(filter by description status)

6. Set a workflow rule: before publishing any post, require Yoast to show a green light (all SEO checks passing)

13. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

https://search.google.com/test/rich-results)
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Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about cannabis tinctures doesn't have a meta description — the 155-character summary that

appears under your page title in Google search results. Without it, Google generates a random snippet from

your content, which often looks unprofessional and fails to convince people to click through.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer potential customers discover your educational content and your brand awareness suffers in

organic search.

Technical root cause: The WordPress page or post editor didn't have a meta description field filled in, either

because the SEO plugin (likely Yoast SEO or Rank Math) wasn't configured on this post, or the field was left

blank during publishing.

Recommended fix — step by step

1. Log in to WordPress → Posts → Blog → find 'What is Cannabis Tincture?' → scroll to the Yoast SEO or Rank

Math section at the bottom

2. Locate the 'Meta description' field and write a 150–160 character description that includes your target

keyword (e.g., 'Learn what cannabis tinctures are, how they work, and why they're a popular consumption

method for medical patients.')

3. Verify the description preview shows as a full sentence in the search result mockup (green bar = good, red

bar = too long)

4. Click 'Update' to save the post

5. Repeat this process for all other blog posts missing meta descriptions (run a full site scan in your SEO plugin

to identify them)

14. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis flower has no structured data markup — this is invisible code that tells Google

what your page is about. Without it, search engines have to guess whether your content is a blog post, product

review, or something else entirely. This is especially important for cannabis content, where clarity helps Google

confidently rank and display your pages.

Why it matters for your business: Missing schema markup reduces your chances of appearing in Google's

rich snippets (the enhanced search results with ratings, images, or other details), which limits click-through

rates from organic search and makes it harder for customers to find your educational content.

Technical root cause: WordPress installations often rely on plugins like Yoast SEO or RankMath to generate

schema.org JSON-LD blocks automatically. Either no SEO plugin is active, or the plugin is installed but schema

generation is disabled or misconfigured.

Recommended fix — step by step

https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/
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1. Log in to WordPress admin and navigate to Plugins. Search for and install 'Yoast SEO' (free version is

sufficient) if not already present.

2. Activate the plugin, then go to Yoast SEO → Settings → Features and confirm that Schema output is toggled

ON.

3. Go to Yoast SEO → Settings → Site representation and verify your business name, logo, and contact info are

filled in — this populates organization schema globally.

4. Edit the blog post at /blog/what-is-cannabis-flower/ and scroll to the Yoast metabox at the bottom. Set

'Article type' to 'Blog post' (or 'How-to' if it includes steps).

5. Click 'Save draft' and refresh the page; Yoast will now generate schema. Verify by viewing the page source

(Ctrl+U or Cmd+U) and searching for 'schemaorg' to confirm JSON-LD blocks are present.

6. Run the updated URL through Google's Rich Results Test (search.google.com/test/rich-results) to confirm

schema is valid and no warnings appear.

15. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about vapes vs. pre-rolls doesn't have a meta description — the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random snippet from your

content, which often looks unprofessional and doesn't persuade clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see auto-generated text instead of your sales-focused summary, costing you qualified

traffic to a high-intent comparison page.

Technical root cause: The WordPress page or post was published without filling in the meta description field,

either because the SEO plugin (Yoast, Rank Math, etc.) wasn't configured or the field was left blank during

publishing.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'Vapes vs. Pre-Rolls' post

2. Scroll to the SEO plugin panel (Yoast, Rank Math, or All in One SEO) at the bottom of the editor

3. In the 'Meta description' field, write a 155–160 character summary: e.g., 'Comparing vapes and pre-rolls:

potency, convenience, cost & effects. Find the best option for your needs.'

4. Check the plugin's preview to confirm it displays correctly in a mock Google result

5. Click 'Update' to save the post

6. Repeat for other blog posts flagged in your audit (audit your /blog/ archive to identify all missing

descriptions)

16. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/


Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post doesn't have a meta description—the 155-character summary that appears below the page title

in Google search results. Without it, Google generates a random excerpt from your content, which may not

highlight why someone should click your link. For a lifestyle cannabis site, this means potential customers see a

less compelling preview.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer visitors land on your blog content even if you rank well, directly impacting traffic and brand

awareness.

Technical root cause: The WordPress page or post object is missing the meta description field in its SEO

plugin settings (or the SEO plugin is not installed/active), so no description is being written to the page's HTML

head.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: WordPress Admin → Plugins → Add New → search

'Yoast SEO' → Install Now → Activate.

2. Navigate to Posts → Edit the affected post 'Choose the Right Cannabis'.

3. Scroll to the Yoast SEO panel at the bottom of the editor; click 'Edit snippet'.

4. In the 'Meta description' field, write a 155–160 character summary, e.g., 'Learn how to choose the right

cannabis strain for your needs. Explore effects, flavors, and THC levels to find your perfect match.'

5. Click 'Set as meta description' and save the post.

6. Repeat for all other blog posts missing descriptions: Posts → filter by 'Yoast SEO → Meta description' status

(if available) or manually check 5–10 high-traffic posts.

17. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/

Rule: tier2.schema.none

What it means (plain English)

Your blog post lacks JSON-LD structured data, which is invisible markup that tells search engines what your

content is about. Without it, Google has to guess whether a page is a product listing, an article, or something

else — and it often guesses wrong. This is especially important for cannabis retailers, where clear, machine-

readable content helps search engines confidently surface your educational content.

Why it matters for your business: Missing schema reduces your chances of appearing in Google's featured

snippets and blog carousels, directly limiting organic traffic to your educational content and indirect product

discovery.

Technical root cause: WordPress sites don't add JSON-LD schema by default. Most sites need either a

dedicated SEO plugin (like Yoast or Rank Math) or manual code insertion to generate and output schema blocks.

Recommended fix — step by step

https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/
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1. Install and activate Yoast SEO (free version) via WordPress admin > Plugins > Add New.

2. Go to Yoast SEO > Settings > Feature Manager and toggle 'XML Sitemaps' to ON (if not already enabled).

3. In Yoast SEO > Settings > Search Appearance, enable 'Knowledge Graph' and fill in your business name,

logo, and social profiles.

4. Edit the affected blog post (Leafology > Posts > Edit 'Choose the Right Cannabis').

5. In the Yoast meta box at the bottom, set 'Readability focus keyword' to 'cannabis strains' or your target

term, then set 'SEO' to 'Green light'.

6. In the post editor, ensure the post has a clear title, intro paragraph (summary), and body text — Yoast will

auto-generate BlogPosting schema once these are present.

7. Publish or update the post, then verify schema was added by visiting the page URL in Google's Rich Results

Test (search.google.com/test/rich-results).

18. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/types-of-concentrates/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about cannabis concentrates has no meta description — the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random snippet from your

page content, which often looks unprofessional and may not highlight your key message to potential customers.

Why it matters for your business: Customers searching for 'types of cannabis concentrates' see a vague or

incomplete description in Google, reducing click-through rate and losing qualified traffic to competitors with

better search listings.

Technical root cause: The WordPress page or post is missing the meta description field in its SEO settings

(typically in Yoast SEO, Rank Math, or native WordPress blocks), so no description tag is being output in the

HTML head.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Types of Concentrates (or search for it in All Posts)

2. Scroll to the Yoast SEO (or Rank Math / SEMrush) settings panel at the bottom of the editor

3. Click into the 'Meta description' field and write a 155–160 character summary: e.g., 'Explore cannabis

concentrates: wax, shatter, rosin & more. Learn potency, flavor profiles & consumption methods at

Leafology.'

4. Ensure the description includes a relevant keyword (e.g., 'cannabis concentrates') naturally

5. Click 'Update' to save the post

6. Repeat this process for all blog posts and product pages flagged in your SEO audit

19. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://leafologycannabiscompany.com/blog/types-of-concentrates/


Page URL: https://leafologycannabiscompany.com/blog/thc-vs-cbd/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about THC vs CBD doesn't have a meta description — the 160-character summary that appears

below the page title in Google search results. Without it, Google generates a random excerpt from your content,

which often looks unprofessional and doesn't tell potential customers what the post is actually about.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a confusing snippet instead of a clear value proposition, and you lose control over how

your content appears in search.

Technical root cause: The WordPress page or post editor wasn't populated with a meta description field, either

because no SEO plugin is active or the field was left blank during publication.

Recommended fix — step by step

1. Install Yoast SEO (free version) from WordPress admin → Plugins → Add New, search 'Yoast SEO', click

Install and Activate.

2. Go to Posts → Blog → edit the 'THC vs CBD' post.

3. Scroll to the Yoast SEO box at the bottom; in the 'Meta description' field, write: 'Learn the differences

between THC and CBD, including effects, legality, and how to choose for your needs.' (aim for 155–160

characters).

4. Click the green traffic light icon in Yoast to confirm the description is optimized.

5. Click Publish/Update.

6. Repeat this process for all other blog posts and key pages on your site (check GSC or your analytics for

high-traffic posts first).

7. Set a WordPress reminder to add meta descriptions to all new posts before publishing.

20. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/thc-vs-cbd/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about THC vs CBD has no structured data markup — metadata that tells Google what type of

content this is (article, product, FAQ, etc.). Without it, search engines have to guess the page's purpose, which

can hurt rankings for relevant queries and reduce your chances of appearing in rich results like Featured

Snippets.

Why it matters for your business: Missing schema markup reduces organic search visibility for educational

cannabis content, which is a key traffic driver for lifestyle dispensary sites and can lower click-through rates

from search results.

Technical root cause: WordPress does not automatically output JSON-LD schema.org blocks; you need a

dedicated SEO or schema plugin to generate and insert them into page headers.

Recommended fix — step by step

1. Install the free Yoast SEO plugin (WordPress.org plugins → search 'Yoast SEO' → activate).

https://leafologycannabiscompany.com/blog/thc-vs-cbd/
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2. Go to WordPress admin → Yoast SEO → Tools → File Editor → enable JSON-LD output if not already on.

3. Edit the blog post (WordPress admin → Posts → 'THC vs CBD' → edit).

4. Scroll to the Yoast SEO metabox (bottom of editor) → click 'Schema' tab → select 'Article' from the

dropdown.

5. Fill in Author, Publication Date, and Image fields in that schema block.

6. Publish and wait 48 hours, then verify via Google Search Console → URL Inspection → see 'Rich result'

status.

7. Repeat schema markup for all other blog posts (Yoast can bulk-apply article schema via settings if posts

match a pattern).

21. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-

shelf-life/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about cannabis edibles doesn't have a meta description—the 160-character summary that

appears below your page title in Google search results. Without it, Google generates a random snippet from

your page content, which often looks incomplete or unappealing to shoppers deciding whether to click.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer potential customers visit your content even when you rank well for cannabis-related keywords.

Technical root cause: The WordPress post was published without manually entering a meta description in the

SEO plugin (Yoast, Rankmath, or similar), or no SEO plugin is configured to enforce this field.

Recommended fix — step by step

1. Install or open your existing SEO plugin (Yoast SEO, Rank Math, or SEOPress) in WordPress admin.

2. Navigate to the blog post editor for 'Do Cannabis Edibles Expire: Storage Tips and Shelf Life'.

3. Scroll to the SEO plugin panel (usually below the editor) and locate the 'Meta Description' field.

4. Write a description 155–160 characters that includes the target keyword and a call-to-action: e.g., 'Learn

how long cannabis edibles last, proper storage methods, and shelf-life tips for potency. Expert guide from

Leafology.'

5. Set the plugin to show a red/yellow/green traffic light—aim for green (optimal length).

6. Click 'Update' to save the post.

7. Create a checklist: before publishing any new blog post, always fill in the meta description field.

22. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-

shelf-life/

https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-shelf-life/
https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-shelf-life/
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https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-shelf-life/


Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis edibles doesn't include JSON-LD schema markup — machine-readable code that

tells search engines what the page is about, who wrote it, and when it was published. Without it, Google has to

guess the content type and context, which can reduce visibility in search results and rich snippets (like review

stars or article bylines).

Why it matters for your business: Missing schema markup costs you rich snippet placements in search

results, which reduces click-through rates from organic search and makes your educational content less

discoverable to customers researching cannabis products.

Technical root cause: The WordPress site either has no schema plugin active, or the plugin is not configured to

output Article/BlogPosting schema for blog posts. Most WordPress sites ship with no schema by default.

Recommended fix — step by step

1. Install the Yoast SEO plugin (free version is sufficient) via WordPress Admin → Plugins → Add New, search

'Yoast SEO', click Install and Activate.

2. Go to WordPress Admin → Yoast SEO → General, and complete the Site Representation setup (company

name, logo, social profiles) — this seeds schema across all pages.

3. Edit the blog post URL (https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-

tips-and-shelf-life/) and scroll to the Yoast SEO meta box at the bottom. Verify 'Article type' is set to 'Blog

post' and fill in any missing fields (Author, Publication date).

4. Save the post and wait 30 seconds, then view page source (right-click → View Page Source, Ctrl+F

'application/ld+json') to confirm JSON-LD blocks appear.

5. Repeat steps 3–4 for all other blog posts and cornerstone content pages.

23. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about pre-rolls has no structured data—a machine-readable format that tells Google exactly

what type of content this is, who wrote it, and when it was published. Without it, search engines have to guess

your content's meaning, which hurts visibility in search results and rich snippets (those fancy cards with

ratings, images, and excerpts).

Why it matters for your business: Missing schema reduces click-through rates from search results and

prevents your blog from appearing in Featured Snippets or Knowledge Panels, limiting organic traffic to your

content marketing efforts.

Technical root cause: WordPress doesn't automatically output schema.org JSON-LD blocks for blog posts.

Most SEO plugins generate this, but either no plugin is active, or the plugin isn't configured to output Article or

BlogPosting schema.

Recommended fix — step by step

https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-shelf-life/)
https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-shelf-life/)
https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/


1. Install Yoast SEO (free version) if not already active: WordPress Admin → Plugins → Add New → search

'Yoast SEO' → Install & Activate

2. Go to Yoast SEO → Settings → Features → toggle ON 'Schema' and 'XML sitemaps'

3. Edit the affected blog post (Leafology Cannabis Co Admin → Posts → Pre-Roll Joint Blunt Spliff Joint)

4. Scroll to the Yoast SEO metabox at bottom → ensure 'Article type' is set to 'BlogPosting' (not 'Standard')

5. In that same metabox, fill in: Author name (if blank), Publication date (should auto-populate), and ensure

'Show date in snippet' is enabled

6. Publish/Update the post

7. Test the post URL in Google Search Console → URL Inspection tool to confirm schema is now rendering

24. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-dispensary/

Rule: tier2.meta.no-description

What it means (plain English)

Meta descriptions are the 160-character summaries that appear under your page title in Google search results.

Without one, Google will auto-generate a snippet from your page text, which often looks incomplete or

irrelevant. This specific blog post about cannabis terminology is missing that description entirely.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results

because potential customers see an awkward or incomplete preview instead of a compelling reason to visit your

post—this directly impacts traffic to your educational content.

Technical root cause: The WordPress page or post was published without the SEO plugin (likely Yoast SEO or

Rank Math) being configured to add a meta description, or the plugin's description field was left blank during

editing.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts → search for 'cannabis-vs-marijuana-vs-dispensary' and click Edit

2. Scroll to the SEO plugin section (Yoast SEO or Rank Math, depending on your plugin) below the editor

3. Find the 'Meta description' field and write a 155–160 character summary, e.g.: 'Learn the differences

between cannabis, marijuana, and dispensaries. Understand terminology and find quality products at

Leafology.'

4. Click 'Update' to save

5. Repeat this process for all blog posts that show 'no description' warnings in your SEO plugin's audit or

dashboard

25. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/exploring-legal-weed-dispensary-westchester-nyc/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-dispensary/
https://leafologycannabiscompany.com/blog/exploring-legal-weed-dispensary-westchester-nyc/


What it means (plain English)

This blog post doesn't have a meta description — the 160-character summary that appears below your headline

in Google search results. Without it, Google will auto-generate one from your page text, which is often

incomplete or unhelpful. This reduces click-through rates from search because potential customers can't see a

clear, compelling preview of what the page offers.

Why it matters for your business: Lower search result click-through rates mean fewer qualified visitors from

organic search, directly reducing foot traffic and online orders for your Westchester location.

Technical root cause: The WordPress theme or SEO plugin (likely Yoast SEO or Rank Math) is not enforcing

meta descriptions on blog posts, or the post was published without one and never filled in.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Edit the affected blog post

2. Scroll to the SEO plugin section at the bottom (if using Yoast SEO, look for 'Yoast SEO' box; if Rank Math,

click 'Rank Math' on the right sidebar)

3. Find the 'Meta description' field and enter a 155–160 character description that includes the target keyword

(e.g., 'Legal cannabis dispensary in Westchester, NYC. Explore our flower, edibles, and concentrates with

expert guidance.')

4. Click 'Update' to save

5. Repeat for all other blog posts missing descriptions (use Posts → All Posts, filter by SEO plugin status if

available)

6. Set a reminder to fill in meta descriptions before publishing new posts going forward

26. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-

harrison-westchester-nyc/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about dry herb vaporizers doesn't have a meta description — the 155-character summary that

appears under your page title in Google search results. Without it, Google generates a random snippet from

your content, which often looks unprofessional and fails to persuade clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

even if your page ranks well, fewer people click through to your site, directly lowering traffic and customer

inquiries.

Technical root cause: The WordPress SEO plugin (likely Yoast, Rank Math, or All in One SEO) either isn't active

on this post, or the description field was left blank when the post was published.

Recommended fix — step by step

1. Log into WordPress admin → Posts → search for 'best dry herb vaporizers' → open that post

2. Scroll to the SEO plugin panel at the bottom (Yoast, Rank Math, or All in One SEO); if you don't see one,

install Yoast SEO free plugin first

https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-harrison-westchester-nyc/
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3. Click into the meta description field and write 155 characters max: e.g., 'Discover the top dry herb

vaporizers in White Plains, Scarsdale & Westchester. Expert reviews & buying guide for premium vaping

experience.'

4. Make sure the description includes your local keywords (White Plains, Scarsdale, Harrison, Westchester,

NYC) since this is a geo-targeted post

5. Click 'Update' to save the post

6. Repeat this process for any other blog posts missing descriptions (check your SEO plugin's audit report)

27. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-

harrison-westchester-nyc/

Rule: tier2.schema.none

What it means (plain English)

Your blog post doesn't include structured data — machine-readable code that tells Google what your content is

about (e.g., article title, author, publish date). Without it, search engines have to guess your content's

relevance, and they may miss important details like local service areas (White Plains, Scarsdale, etc.) that could

drive local search traffic.

Why it matters for your business: Missing schema markup reduces your visibility in local search results and

product-comparison features, directly lowering qualified traffic to your blog and product pages — especially

damaging for a multi-location dispensary competing on local keywords.

Technical root cause: WordPress is not automatically generating Article or LocalBusiness schema.org JSON-

LD blocks. Either no SEO plugin with schema generation is active, or the blog post type is not configured to

output structured data.

Recommended fix — step by step

1. Install Yoast SEO (free version) or Rank Math (free version) — both auto-generate Article schema for blog

posts.

2. Activate the plugin, then go to its settings (Yoast: SEO → Settings → Integrations; Rank Math: Rank Math →

Settings → General Settings) and enable 'Schema markup for posts.'

3. Edit the affected blog post and scroll to the plugin's meta box (Yoast: 'SEO' panel at bottom; Rank Math:

'Rank Math' side panel). Confirm the schema type is set to 'Article.'

4. Add local business schema via the plugin's Organization settings (Yoast: SEO → General; Rank Math: Rank

Math → Knowledge Graph). Enter your dispensary name, license number, address(es), and phone.

5. Republish the blog post to trigger schema output.

6. Verify output by visiting https://schema.org/validator and pasting your blog post URL — you should see

Article and Organization blocks.

28. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-harrison-westchester-nyc/
https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-harrison-westchester-nyc/
https://schema.org/validator


Page URL: https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/

Rule: tier2.schema.none

What it means (plain English)

Your blog posts lack JSON-LD structured data — machine-readable code that tells Google what your content is

about (e.g., article title, author, publish date). Without it, search engines have to guess your content's meaning,

which hurts rankings and may prevent rich results (like review stars or article snippets) from appearing in

search.

Why it matters for your business: Missing schema reduces your visibility in Google Search results for

competitive cannabis keywords, directly limiting organic traffic to your high-value blog content.

Technical root cause: WordPress typically requires an SEO plugin (like Yoast, Rank Math, or All in One SEO) to

auto-generate JSON-LD blocks, or manual code insertion. Your site is not using one, or it is disabled for blog

posts.

Recommended fix — step by step

1. Install Yoast SEO Free (or Rank Math Free) via WordPress Admin → Plugins → Add New → search 'Yoast SEO'

→ Install Now → Activate.

2. Go to Yoast SEO → General → Features and verify 'Schema' is toggled ON.

3. Edit the affected blog post (/blog/discover-the-best-pre-roll-brands-nyc/) and scroll to the Yoast block at

the bottom; confirm 'Article' is selected under 'Schema type'.

4. Update the post (even if no content changes) to regenerate schema; inspect the page source (Ctrl+F, search

'schema.org') to confirm a JSON-LD block now appears.

5. Repeat for all blog posts; use WordPress bulk edit or a plugin like SEO Framework to auto-apply schema to

existing posts.

29. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post doesn't have a meta description — the 155-character snippet that appears below your page title

in Google search results. Without it, Google generates a random excerpt from your content, which may not

highlight your most compelling selling points or keywords.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see generic or off-topic text instead of your best pitch, costing you qualified traffic to a

high-intent content page.

Technical root cause: The WordPress post or page was published without filling the meta description field in

the SEO plugin (likely Yoast SEO, Rank Math, or core WordPress block editor), or no description was set during

post creation.

Recommended fix — step by step

1. Log in to WordPress → Posts → search for 'Exploring THC Tincture 1000mg Guide' → open the post

2. Scroll to the Yoast SEO (or Rank Math) panel at the bottom of the editor

https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/
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3. Click into the 'Snippet Preview' or 'Meta Description' field

4. Write a 150–160 character description that includes the target keyword and a clear value prop, e.g. 'Learn

how to use 1000mg THC tinctures safely: dosing guide, effects, and strain recommendations for cannabis

consumers.'

5. Ensure the green light appears in the SEO plugin's readability checker

6. Click 'Update' to save the post

7. Repeat this process for all other blog posts flagged with the same issue (bulk-check via Yoast SEO →

Internal Linking or search Console)

30. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about THC tinctures has no structured data—invisible HTML markup that tells Google what your

page is about. Without it, search engines guess at your content's meaning and may rank you lower or display

generic snippets instead of rich snippets (like star ratings or product details). This is especially important for

cannabis retail, where clear product information helps legitimate users find you.

Why it matters for your business: Missing schema reduces click-through rate from search results and makes

your educational content less likely to appear in featured snippets, limiting organic traffic to your blog and

product pages.

Technical root cause: The WordPress site lacks a schema markup plugin or manual JSON-LD blocks. Google

cannot automatically infer that this is a guide about a specific cannabis product without explicit labeling.

Recommended fix — step by step

1. Install the free Yoast SEO plugin (Plugins → Add New → search 'Yoast SEO' → Install & Activate)

2. Go to Yoast SEO → General → Features and ensure 'Schema' is enabled (toggle on)

3. Edit the affected blog post (Posts → Exploring THC Tincture → Edit)

4. In the Yoast metabox at the bottom, click 'Schema' tab and select 'BlogPosting' from the dropdown

5. In the same block, set 'Article type' to 'BlogPosting' and ensure 'Author' and 'Publication date' fields are

populated

6. Update the post and verify schema is present by running the URL through Google's Rich Results Test

(https://search.google.com/test/rich-results)

31. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/

Rule: tier2.schema.none

https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/
https://search.google.com/test/rich-results)
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What it means (plain English)

Your blog post about Watermelon Diesel strain doesn't include JSON-LD structured data — machine-readable

code that tells Google what the page is about (in this case, a blog post about a cannabis strain). Without it,

search engines have to guess your content type and may not display it optimally in search results or AI

summaries.

Why it matters for your business: Missing schema reduces your chances of appearing in Google's rich

snippets, knowledge panels, and AI-powered search features — all critical for cannabis retailers competing for

local search visibility and building brand authority.

Technical root cause: WordPress blog posts often lack automatic structured data markup. Either the active

theme doesn't include schema.org JSON-LD blocks, or the SEO plugin (if installed) isn't configured to output

them for post types.

Recommended fix — step by step

1. Install or activate Yoast SEO Free (if not already active): go to Plugins → Add New → search 'Yoast SEO' →

Install & Activate

2. Go to Yoast SEO → Settings → Search Appearance → Content Types, and enable 'Blog posts' toggle

3. Go to the Watermelon Diesel post editor → scroll to Yoast SEO panel → verify 'Show in search results' is ON

4. Go to Yoast SEO → Integrations → Google Search Console → connect your GSC account to verify indexing

5. Wait 48 hours, then visit https://search.google.com/test/rich-results and paste your blog post URL to

confirm schema is now rendering

6. Repeat for other blog posts using bulk edit: Posts → select all → Edit → Yoast settings → Apply to all

32. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/the-devil-driver-strain/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about the Devil Driver strain is missing a meta description—the 150–160 character summary that

appears below the page title in Google search results. Without it, Google may auto-generate a snippet from

your content, which often looks unprofessional and may not include your key selling points or keywords.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer potential customers visit your strain guides and product pages, even if they rank well in Google.

Technical root cause: The WordPress post was published without manually entering a meta description in the

SEO plugin (likely Yoast SEO or Rank Math), and no default fallback was configured.

Recommended fix — step by step

1. Log in to WordPress admin → edit the 'The Devil Driver Strain' post

2. Scroll to the Yoast SEO (or Rank Math) metabox below the editor

3. Locate the 'Meta description' field (usually shows a character counter below the title field)

4. Write a 155–160 character description: e.g., 'Devil Driver cannabis strain: potent hybrid effects, flavor profile

& THC content. Learn growing tips & user reviews at Leafology.'

5. Ensure the description includes the strain name and one key benefit (effects, flavor, or use-case)

https://search.google.com/test/rich-results
https://leafologycannabiscompany.com/blog/the-devil-driver-strain/


6. Click 'Update' to save the post

7. Check the preview in Google Search Console (Search Appearance → HTML Improvements) to verify it

displays correctly

33. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/the-devil-driver-strain/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about the Devil Driver strain has no structured data—that's metadata in a machine-readable

format that tells Google what the page is about. Without it, search engines have to guess whether you're selling

flower, discussing terpenes, or running a review site. This makes it harder for Google to show your content in

relevant search results and blocks access to rich snippets (the extra details that appear below your link in

search).

Why it matters for your business: Missing schema reduces your visibility in Google Search for strain queries

and product searches, directly limiting organic traffic to high-value blog content that could drive dispensary

visits or online orders.

Technical root cause: The WordPress theme or active plugins are not generating JSON-LD blocks for blog

posts. Most modern WordPress SEO plugins (Yoast, RankMath, All in One SEO) automatically inject schema if

configured; this site either lacks that setup or has it disabled.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: WordPress Dashboard → Plugins → Add New → search

'Yoast SEO' → Install & Activate

2. Go to Yoast SEO → Integrations → API credentials and verify Google Search Console is connected (shows

your site in Google's eyes)

3. Edit the blog post at /blog/the-devil-driver-strain/ → scroll to Yoast SEO metabox at bottom → verify

'Schema' tab shows Article type; if blank, click 'Edit Schema' and confirm Article is selected

4. If Yoast shows schema but Google Search Console doesn't index it, go to WordPress Dashboard → Yoast

SEO → Tools → Site Audit and run a full crawl; fix any 'Missing schema' warnings

5. Test the post URL in Google's Rich Results Test (search.google.com/test/rich-results) and verify Article

schema appears in the preview

34. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/

Rule: tier2.meta.no-description

What it means (plain English)

https://leafologycannabiscompany.com/blog/the-devil-driver-strain/
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This blog post about THC concentrates doesn't have a meta description—the 160-character summary that

appears below the page title in Google search results. Without it, Google auto-generates a snippet from your

page text, which is often choppy or irrelevant and wastes an opportunity to tell potential customers what they're

clicking on.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a poor preview and choose a competitor's link instead, directly reducing organic traffic

and product discovery.

Technical root cause: The WordPress post or page was published without filling in the meta description field,

either because Yoast SEO (or another SEO plugin) wasn't active, or the editor didn't complete the SEO checklist

before publishing.

Recommended fix — step by step

1. Log in to WordPress → Posts → Find 'Exploring THC Concentrate' post

2. Scroll to the Yoast SEO metabox (usually below the editor); if missing, ensure Yoast SEO plugin is activated

(Plugins → Installed Plugins → check 'Yoast SEO' is active)

3. Click into the Yoast metabox and locate the 'Snippet' section showing the preview

4. Write a 155–160 character meta description: e.g., 'Learn about THC concentrates: types, potency, effects &

safety. Expert guide for cannabis consumers at Leafology.'

5. Ensure the description naturally includes your target keyword ('THC concentrates') and a benefit or clear

value proposition

6. Click 'Update' to save the post

7. Repeat this process for all blog posts in the blog index (Posts → check for posts with red 'Missing

Description' flags in Yoast)

35. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about pre-roll brands doesn't have a meta description — the short text (usually 150–160

characters) that appears below your page title in Google search results. Without it, Google generates a random

snippet from your page content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

directly lowering organic traffic to your blog content and diminishing the SEO value of your topical authority on

cannabis products.

Technical root cause: The WordPress post was published without filling in the meta description field in your

SEO plugin (likely Yoast SEO or Rank Math), or the plugin was not installed when the post was created.

Recommended fix — step by step

1. Log in to WordPress → Posts → Edit the 'Finding the Best Pre-Roll Brands' post

2. Scroll to the Yoast SEO or Rank Math meta box at the bottom of the editor

3. In the 'Meta description' field, write 150–160 characters summarizing the post (e.g., 'Discover the top-rated

pre-roll brands for quality, taste, and value. Our guide helps you choose the best pre-rolls for your

https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/


preferences.')

4. Click 'Update' to save the change

5. Repeat this process for all other blog posts missing meta descriptions using the Pages list view to bulk-

identify gaps

36. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/finding-your-green/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post doesn't have a meta description—the 155-character summary that appears under your page title

in Google search results. Without it, Google will auto-generate something from your page text, which often

looks choppy or incomplete. This makes your listing less appealing to people searching for cannabis content.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a poorly summarized snippet instead of your compelling description, hurting traffic and

conversions.

Technical root cause: The WordPress post or page was published without manually entering a meta

description in the Yoast SEO or WordPress native meta box. Most WordPress installations don't auto-populate

this field.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Blog → find 'Finding Your Green' post

2. Scroll to the Yoast SEO meta box at the bottom of the editor (or the native WordPress 'Search appearance'

box if Yoast is not installed)

3. In the 'Meta description' field, write 150–160 characters that include your target keyword (e.g., 'Discover

how to choose the right cannabis strain for your lifestyle. Expert tips on finding your perfect green at

Leafology.')

4. Click 'Update' to save

5. Repeat for all other blog posts flagged in this audit

37. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about Revelry's Baby Yoda Pre-Rolls has no structured data markup—that's metadata in a

machine-readable format (JSON-LD) that tells Google what the page is about. Without it, search engines have

to guess whether a page is a product review, a blog post, or promotional content, which hurts your visibility in

search results.

https://leafologycannabiscompany.com/blog/finding-your-green/
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Why it matters for your business: Missing schema markup reduces the likelihood that Google displays your

product reviews and blog posts in rich search results (like star ratings or product snippets), which drives down

click-through rates from organic search traffic.

Technical root cause: WordPress doesn't automatically add JSON-LD schema to blog posts unless a plugin

(like Yoast SEO, Rank Math, or All in One SEO) is installed and configured to generate it. The site either lacks

this plugin or it's not activated for blog post schema.

Recommended fix — step by step

1. Install and activate Yoast SEO Premium (free version works): Go to WordPress Admin → Plugins → Add New,

search 'Yoast SEO', install, activate.

2. Go to Yoast SEO → Search Appearance → Content Types and enable 'Show' for Posts.

3. Edit the affected blog post: https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/ and

scroll to the Yoast metabox at the bottom. Set the 'Content type' dropdown to 'BlogPosting' if available, or

ensure the toggle 'Show in search results' is ON.

4. If the post describes a product, add a 'Product' schema block: In the WordPress block editor, add a custom

HTML block and paste: <script type="application/ld+json">

{"@context":"https://schema.org","@type":"Product","name":"Revelry's Baby Yoda Pre-Rolls","review":

{"@type":"Review","reviewRating":{"@type":"Rating","ratingValue":"4.5","bestRating":"5"}}}</script>

(customize rating/details to match your content).

5. Go to Yoast SEO → Tools → File Editor and verify the plugin's PHP is not disabled.

6. Install the Schema plugin 'All in One Schema Rich Snippets' as an alternative if Yoast doesn't suit your

workflow: Plugins → Add New → search 'all in one schema' → install 'All in One Schema Rich Snippets' by

Awesome Motive.

7. After saving, test the page at https://validator.schema.org/ and https://search.google.com/test/rich-results to

confirm schema appears.

38. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about tinctures doesn't have a meta description—the 160-character summary that appears under

your page title in Google search results. Without it, Google generates a random snippet from your page content,

which often looks incomplete or unprofessional to potential customers browsing search results.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search engines;

customers are less likely to click your listing if the preview looks generic or cut off, directly affecting traffic to

your product content.

Technical root cause: The WordPress post was published without manually entering a meta description in the

SEO plugin (likely Yoast SEO, Rank Math, or All in One SEO), and no default description was auto-generated.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → Edit the 'Tinctures (Including 1000mg Options)' post

2. Scroll to the SEO plugin panel at the bottom (Yoast, Rank Math, or All in One SEO depending on your setup)

https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/
https://validator.schema.org/
https://search.google.com/test/rich-results
https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/


3. Find the 'Meta Description' or 'Description' field and write a 155–160 character summary, e.g., 'Explore our

premium cannabis tinctures, including high-potency 1000mg options. Fast-acting, discreet dosing for all

experience levels.'

4. Ensure the description includes your target keyword (e.g., 'cannabis tinctures') naturally

5. Click 'Update' to save the post

6. Repeat this process for all other blog posts and product pages missing descriptions (audit your site's other

high-traffic content first)

39. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about cannabis strains in Westchester lacks a meta description — a 160-character summary that

appears below the page title in Google search results. Without it, Google may auto-generate a snippet from

your content, which often looks broken or irrelevant and fails to entice clicks.

Why it matters for your business: A missing meta description reduces click-through rate from search results,

directly cutting traffic to a high-intent page (people searching for local strain info are close to visiting or

buying).

Technical root cause: The WordPress post was published without filling in the meta description field in the SEO

plugin (likely Yoast SEO or Rank Math), or the field was left blank intentionally.

Recommended fix — step by step

1. Log into WordPress admin → Posts → open the 'Strains in Westchester, NY' post

2. Scroll to the Yoast SEO or Rank Math metabox at the bottom of the editor

3. Find the 'Meta description' field and enter: 'Discover popular cannabis strains available at Leafology in

Westchester, NY. Learn effects, flavors & availability.' (keep it under 160 characters)

4. Click 'Save draft' or 'Update' to confirm the change

5. Check WordPress All Posts list view to confirm the metabox no longer shows a red warning for missing

description

6. In Google Search Console → Pages → filter by this URL to see the updated description appear in impressions

(may take 1–2 weeks for Google to re-crawl)

40. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/

Rule: tier2.meta.no-description

What it means (plain English)

https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/
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This blog post has no meta description — the 155-character summary that appears below your page title in

Google search results. Without it, Google may auto-generate a snippet from your page content, which often

looks incomplete or irrelevant to searchers. This reduces click-through rates from search results.

Why it matters for your business: Missing meta descriptions lower your organic search click-through rate,

meaning fewer visitors from Google even when your page ranks well for keywords like 'lowest cost weed

Westchester.'

Technical root cause: The WordPress page or post was published without filling in the meta description field,

likely in Yoast SEO, Rank Math, or the native WordPress excerpt field that serves as the meta description

source.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → Blog → open 'Lowest Cost Weed Per Gram in Westchester' post

2. Scroll to the Yoast SEO or Rank Math metabox at the bottom of the editor (or find 'Excerpt' field if no SEO

plugin is active)

3. Write a description 155–160 characters long that includes the target keyword and a benefit, e.g., 'Find the

cheapest cannabis per gram in Westchester. Compare prices across licensed dispensaries and save on your

next purchase.'

4. Click 'Save' or 'Publish' to apply the change

5. Repeat for all other blog posts missing descriptions (run a WordPress plugin audit: SEO → Site Audit in Yoast

or Dashboard in Rank Math to identify all affected pages)

41. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about weed pricing has no structured data—think of it as metadata that tells Google what your

page is really about. Without it, search engines have to guess whether your content is a news article, a product

review, or something else entirely. This makes it harder for Google to categorize and rank your content.

Why it matters for your business: Missing schema data reduces your chances of appearing in Google's rich

snippets (those fancy preview boxes) and knowledge panels, which drive click-through rates on search results

for cannabis pricing and product queries.

Technical root cause: WordPress does not automatically inject JSON-LD schema markup into blog posts

unless explicitly configured via a plugin or custom theme code. Your current setup is missing SEO schema

implementation.

Recommended fix — step by step

1. Install Yoast SEO (free version) or Rank Math (free version) via WordPress admin → Plugins → Add New

2. Activate 'Schema' or 'Structured Data' feature in the plugin settings (Yoast: SEO → Settings → Integrations;

Rank Math: Rank Math → Settings → General Settings → Content AI toggle schema)

3. Edit the affected blog post (WordPress admin → Posts → 'Lowest Cost Weed Per Gram' post)

4. Confirm the plugin has auto-populated Article schema in the post editor (usually visible in a Schema block

or 'Schema' tab)

https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/


5. If schema is not visible, manually add via Rank Math Schema Generator: copy the generated JSON-LD block

and paste into post HTML editor (switch from Visual → Code editor, paste before closing body tag)

6. Publish/update the post, then test using Google's Rich Results Test (search.google.com/test/rich-results) to

verify schema renders correctly

42. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about medical cannabis access has no structured data markup — that's code that tells Google

what the page is about in a machine-readable format. Without it, search engines have to guess whether this is a

blog post, a product, or general information, which can hurt how your content ranks and displays in search

results.

Why it matters for your business: Missing schema reduces your visibility in Google's organic search results

and in rich snippets (like 'Top Stories' or FAQ carousels), directly limiting blog traffic that could drive dispensary

foot traffic and brand authority.

Technical root cause: WordPress by default does not output JSON-LD schema blocks; they must be added

either manually in the post template, via a plugin like Yoast SEO or Rank Math, or through custom code in

functions.php.

Recommended fix — step by step

1. Install and activate Yoast SEO (free version) from WordPress.org Plugins → Add New.

2. Navigate to Posts → your blog post 'Westchester Medical Weed Access' and scroll to the Yoast SEO sidebar

below the editor.

3. In Yoast, set the Content Type to 'Blog Post', fill in the Focus Keyword field with 'medical cannabis access',

and ensure the Readability is at least 'Orange' (medium).

4. Yoast will auto-generate BlogPosting schema; verify by visiting the live post URL and inspecting the page

source (Ctrl+F / Cmd+F 'schema.org/BlogPosting').

5. Apply the same setup to all other blog posts in your archive for consistency.

43. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page is missing a meta description — a 150-160 character summary that appears below the page

title in Google search results. Without it, Google may auto-generate a snippet from your page text, which often

https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/
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looks incomplete or irrelevant. Visitors decide whether to click your link based partly on this preview, so a

missing or poor description costs clicks.

Why it matters for your business: Lower click-through rates from Google search results mean fewer visitors

discovering your cannabis lifestyle content and brand, directly reducing traffic and potential customer

engagement.

Technical root cause: The WordPress page or post does not have a meta description field filled in. By default,

WordPress doesn't auto-populate this; it must be manually entered in the SEO plugin (Yoast, Rank Math, etc.) or

the post editor.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'White Plains Cannabis Mural' post

2. Scroll to the Yoast SEO / Rank Math / All in One SEO metabox below the editor

3. Locate the 'Meta description' field

4. Write a 150-160 character description that includes target keyword and compelling value (example: 'Explore

Leafology's White Plains cannabis mural. Local street art celebrating cannabis culture and community

heritage.')

5. Click 'Update' to save the post

6. Repeat this process for all other blog posts missing meta descriptions (run a report in your SEO plugin to

identify them all)

44. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about pre-roll brands in White Plains is missing a meta description — that's the 160-character

summary that appears under your page title in Google search results. Without it, Google generates a random

snippet from your page, which often looks incomplete and doesn't persuade people to click.

Why it matters for your business: Unoptimized search results mean lower click-through rates from customers

searching for pre-roll products in your area, directly reducing organic traffic and foot traffic to your dispensary.

Technical root cause: The WordPress page or post has no custom meta description field filled in. By default,

WordPress doesn't auto-generate these; they must be added manually or via an SEO plugin.

Recommended fix — step by step

1. Install Yoast SEO plugin (free version is sufficient) if not already active: Plugins → Add New → search 'Yoast

SEO' → Install Now → Activate

2. Navigate to Posts → Blog → find 'Best Pre-Roll Brands in White Plains' → click Edit

3. Scroll down to the Yoast SEO box and locate the 'Snippet Editor' section

4. Click in the meta description field and write: 'Discover the best pre-roll brands available in White Plains at

Leafology Cannabis Co. Premium quality, lab-tested, ready to enjoy.' (keep it under 160 characters)

5. Click 'Save Draft' or 'Update' to apply the change

6. Repeat this process for all blog posts flagged as missing descriptions

https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/


45. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about pre-roll brands has no JSON-LD structured data — this is code that tells Google what your

content is about (article, product, organization, etc.). Without it, search engines have to guess the context of

your page, which can hurt rankings for relevant searches and prevent your content from appearing in rich

snippets (the fancy preview cards in search results).

Why it matters for your business: Blog posts that rank higher and appear with rich snippets drive more

organic traffic to your site, which is especially valuable for lifestyle cannabis content where search intent is high

and competition is strong.

Technical root cause: WordPress doesn't automatically output JSON-LD schema; you need either a dedicated

SEO plugin (like Yoast, RankMath, or All in One SEO) or manual code insertion to generate and inject schema

markup into the page head.

Recommended fix — step by step

1. Install and activate Yoast SEO plugin (if not already installed): WordPress Admin → Plugins → Add New →

search 'Yoast SEO' → Install Now → Activate.

2. Navigate to Yoast SEO → Settings → Search Appearance → Content Types and ensure 'Posts' is toggled to

'Show in search results'.

3. Go back to the blog post editor (Blog → Posts → 'Best Pre-Roll Brands in White Plains') and scroll to the

Yoast SEO box at the bottom; set 'SEO Title', 'Slug', and 'Meta Description' fields.

4. In the Yoast box, check the 'Schema' tab and verify that 'Article' schema is selected (it should auto-detect

for blog posts).

5. Publish or update the post and wait 24 hours, then verify schema output: visit Google Rich Results Test

(search.google.com/test/rich-results) and paste the post URL.

6. Repeat steps 3–5 for all other blog posts to ensure consistent schema markup across your blog.

46. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis and pain relief doesn't include structured data—invisible code that tells Google

what type of content it is (article, product, FAQ, etc.). Without it, search engines have to guess your content's

purpose, which can hurt rankings and prevent rich features like star ratings or snippet previews from appearing

in search results.
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Why it matters for your business: Missing schema markup reduces your visibility in search results for

informational queries, making it harder for patients researching cannabis benefits to find your content over

competitors who have properly tagged theirs.

Technical root cause: WordPress doesn't automatically add JSON-LD schema to blog posts; you need either a

plugin like Yoast SEO, RankMath, or All in One SEO to generate it, or manual code insertion in the post template.

Recommended fix — step by step

1. Install and activate a schema-enabled SEO plugin (Yoast SEO, RankMath, or All in One SEO—all have free

tiers).

2. Go to the plugin settings and enable 'Schema' or 'Structured Data' features.

3. Edit the affected blog post (https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/) and

set its content type to 'Article' in the plugin's schema options.

4. Add a featured image to the post if missing (schema uses it for richer snippets).

5. Add author information in the post metadata (most plugins pull this automatically once enabled).

6. Save and check the post in Google Search Console → URL Inspection → Rich Results tab to confirm schema

is detected.

7. Repeat for all other blog posts in your archive.

47. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-

and-flavonoids-in-white-plains/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis terpenes has no structured data markup—machine-readable code that tells

Google what the page is about. Google uses this to understand content type, author, publish date, and more.

Without it, search engines have to guess your content's relevance, especially important for cannabis education

content where clarity matters.

Why it matters for your business: Missing schema reduces your chances of appearing in Google's featured

snippets, knowledge panels, and rich search results for educational cannabis queries—losing visibility to

customers searching 'cannabis terpenes' or similar educational topics.

Technical root cause: WordPress by default does not output JSON-LD schema markup. Most SEO plugins

(Yoast, RankMath, All in One SEO) auto-generate this for posts, but either the plugin is inactive, misconfigured,

or set to a schema type that doesn't match your content.

Recommended fix — step by step

1. Log into WordPress admin → Plugins. Search for and install 'Yoast SEO' (free tier includes schema) if not

already active.

2. Activate Yoast SEO, then go to the blog post editor → Yoast SEO panel (right sidebar) → Readability tab →

ensure Content Type is set to 'Article' or 'Blog Post'.

3. In Yoast settings (WordPress admin → SEO → Settings → Search Appearance → Content Types), enable

'Show posts in search results' and confirm Article schema is active.

https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/)
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4. Edit the affected blog post, scroll to Yoast SEO panel, verify the Focus Keyphrase is set (e.g., 'cannabis

terpenes'), and save.

5. Use Google's Rich Results Test (https://search.google.com/test/rich-results) to paste your blog URL and

confirm schema is now detected.

6. Repeat steps 4–5 for your other blog posts to ensure consistent schema coverage.

48. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-

elevating-your-cannabis-experience-with-potent-and-portable-options/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post lacks a meta description—the 150-160 character summary that appears under your page title in

Google search results. Without it, Google generates a random snippet from your content, which often looks

unprofessional and doesn't encourage clicks. For a lifestyle cannabis brand, a compelling description is your

chance to stand out in search results.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

directly lowering traffic to high-value content like this vaping guide. In a competitive dispensary market, lost

search visibility means lost customers.

Technical root cause: The WordPress page or post editor did not have a meta description filled in. This

commonly happens when publishing without using an SEO plugin like Yoast SEO or when the plugin is inactive.

Recommended fix — step by step

1. Install and activate Yoast SEO (if not already active): WordPress Admin → Plugins → Add New → search

'Yoast SEO' → Install Now → Activate.

2. Navigate to Posts → Edit the 'No Smoke, No Problem' post.

3. Scroll to the Yoast SEO metabox at the bottom of the editor and locate the 'Snippet Editor' section.

4. Click the pencil icon next to the meta description field and write a 155-160 character description: e.g.,

'Discover vaping tips for cannabis in Westchester. Learn how to enjoy potent, portable options discreetly

and safely.'

5. Ensure the description includes the target keyword ('vaping cannabis Westchester' or similar) naturally.

6. Click 'Save Draft' then 'Update' to publish the change.

49. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/differences-between-distillate-live-resin-and-rosin-

vapes-in-white-plains-westchester/

Rule: tier2.schema.none

What it means (plain English)
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Your blog post about vape types is missing structured data — machine-readable code that tells Google what

your content is about. Without it, search engines have to guess whether you're selling products, offering

educational content, or just running a lifestyle blog. This makes it harder for Google to understand and rank

your pages.

Why it matters for your business: Missing schema reduces your chances of appearing in Google search

results for cannabis education queries, which drives organic traffic to your blog and builds authority for your

dispensary.

Technical root cause: WordPress isn't automatically generating JSON-LD schema blocks for blog posts. Either

an SEO plugin isn't active, or it's not configured to output schema for your content type.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: Go to Plugins → Add New → search 'Yoast SEO' →

Install and Activate

2. Go to Yoast SEO → Settings → Site Representation and fill in your business name, logo, and contact details

3. Navigate to the blog post editor for the vape comparison post → scroll to Yoast SEO meta box → check that

'Focus keyphrase' is set (e.g., 'distillate vs live resin vapes') and 'Readability' is green

4. In Yoast SEO → Integrations → Google Search Console, paste your site's Google Search Console property ID

(this auto-enables schema validation)

5. Re-save the blog post to trigger schema generation

6. Go to Google Rich Results Test (https://search.google.com/test/rich-results) → paste the blog post URL →

verify that 'Article' schema appears in the results

50. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis tinctures has no structured data markup — essentially, search engines can't

automatically understand what the page is about. Structured data (JSON-LD) is like a digital label that tells

Google, Bing, and other search engines exactly what your content is: an article, a product, a review, etc.

Without it, search engines have to guess, which often means your content ranks lower and doesn't appear in

rich search results (like featured snippets or knowledge panels).

Why it matters for your business: Missing schema markup reduces your visibility in organic search results for

cannabis education queries, which drives foot traffic and online orders — and it prevents you from appearing in

Google's answer boxes where customers often find quick information before visiting a dispensary.

Technical root cause: WordPress blog posts by default do not include JSON-LD schema blocks. Either the

theme or a plugin like Yoast SEO, RankMath, or All in One SEO is responsible for injecting this markup, and it's

either not installed, not activated, or not configured for blog post schema.

Recommended fix — step by step

1. Go to Plugins → Installed Plugins and check if Yoast SEO, RankMath, or All in One SEO is installed and

active; if not, install one (Yoast SEO is most common for cannabis sites).

https://search.google.com/test/rich-results)
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2. If using Yoast SEO: go to Yoast SEO → Settings → Search Appearance → Content Types and enable 'Show

schema output' for Posts.

3. Go to Yoast SEO → Integrations → Google Search Console and connect your GSC property so Yoast can

validate schema markup.

4. Edit the affected blog post (or create a new one) and in the Yoast SEO metabox at the bottom, set the 'SEO

Title' and 'Meta Description'; Yoast will auto-generate Article schema.

5. Optional: If the plugin doesn't auto-generate schema, manually add a JSON-LD Article block in the post

editor by installing a schema plugin like Schema Pro or using the 'Custom HTML' block to paste Article

markup.

6. Publish and wait 24–48 hours, then use Google's Rich Results Test (https://search.google.com/test/rich-

results) to verify schema appears on the post.

51. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about vapes vs pre-rolls has no structured data — extra code that tells search engines what

content is on the page. Without it, Google cannot easily understand that this is a comparison article, which

means it won't rank as well for relevant searches and won't display special rich snippets (like star ratings or

article metadata) in search results.

Why it matters for your business: Missing schema reduces the chance that your educational content ranks in

Google search results or appears as a featured snippet, costing you organic traffic from customers researching

products before purchase.

Technical root cause: WordPress is not outputting JSON-LD schema blocks for blog posts. This typically

happens when either no SEO plugin is active, the plugin's schema settings are disabled, or the theme doesn't

include default schema support.

Recommended fix — step by step

1. Install and activate the free Yoast SEO plugin (if not already installed): go to Plugins → Add New, search

'Yoast SEO', click Install Now, then Activate.

2. Go to Yoast SEO → Settings → Search Appearance, click the Article tab, and toggle 'Show article metadata'

to ON.

3. Go to Yoast SEO → Settings → Search Appearance → Schema, ensure 'Organization' is set to your

dispensary name, 'Website' is your domain, and save.

4. Edit the affected blog post (Posts → Edit 'Vapes vs Pre-Rolls'), scroll to the Yoast SEO meta box at bottom,

and check that 'Article type' is set to 'Blog post'; click Update.

5. Open Google Search Console (search.google.com/search-console), select your property, go to Index →

Coverage, and re-request indexing for the blog post URL to force Google to re-scan the schema.

52. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

https://search.google.com/test/rich-results)
https://search.google.com/test/rich-results)
https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/


Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/types-of-concentrates/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis concentrates doesn't include JSON-LD structured data—machine-readable code

that tells Google what the page is about (an article, its author, publish date, etc.). Without it, search engines

have to guess the content's meaning, which reduces the chance your post ranks well for relevant searches and

shows rich snippets (like star ratings or publication dates) in search results.

Why it matters for your business: Missing schema markup reduces organic search visibility and click-through

rates for your educational content, which is a key way cannabis retailers build trust and drive qualified traffic

before purchase.

Technical root cause: WordPress does not automatically generate JSON-LD schema for blog posts unless a

plugin (like Yoast SEO, Rank Math, or All in One SEO) is configured to do so, or custom code is added to the

theme.

Recommended fix — step by step

1. Install and activate Yoast SEO (free tier) or Rank Math (free tier) from wp-admin → Plugins → Add New

2. Open the plugin settings (Yoast: wp-admin → Yoast SEO → Settings; Rank Math: wp-admin → Rank Math →

Settings)

3. Enable 'Schema' or 'Structured Data' output in General settings, ensuring 'Blog' or 'Article' schema is

toggled on

4. Go to the blog post editor (wp-admin → Posts → Edit 'Types of Concentrates')

5. Verify the SEO plugin now shows a Schema preview panel at the bottom; confirm 'Article' type is selected

6. Save and visit the live post, then test at Google's Rich Results Test (https://search.google.com/test/rich-

results) to confirm JSON-LD is present

7. Repeat for other blog posts in your library

53. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post about pre-roll brands doesn't have a meta description — the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random snippet from your

content, which often looks incomplete or irrelevant to searchers.

Why it matters for your business: A missing meta description reduces click-through rate from search results,

meaning fewer visitors discover your blog content and brand even when your page ranks well.

Technical root cause: The WordPress page was published without a meta description being added, either

manually or via an SEO plugin like Yoast SEO or Rank Math.

Recommended fix — step by step

https://leafologycannabiscompany.com/blog/types-of-concentrates/
https://search.google.com/test/rich-results)
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1. Log in to WordPress → go to Posts → find 'Discover the Best Pre-Roll Brands NYC'

2. Install Yoast SEO (free) if not already active: Plugins → Add New → search 'Yoast SEO' → Install & Activate

3. Edit the post and scroll to the Yoast SEO box at the bottom

4. Click 'Edit snippet' and write a 150–160 character meta description that includes a call-to-action (e.g.,

'Explore top pre-roll brands in NYC. Find quality products, reviews & where to buy. Shop now at Leafology.')

5. Save the post and wait 2–3 days for Google to re-crawl and update the snippet in search results

54. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about THC concentrates doesn't include JSON-LD structured data — machine-readable code

that tells Google what your content is about. Without it, search engines have to guess whether your page is a

blog post, product listing, or something else, which reduces the chance Google shows it in rich results (like

featured snippets or knowledge panels).

Why it matters for your business: Missing schema means your educational content won't appear in Google's

enhanced search results, reducing organic traffic and credibility signals that could drive customers to your

dispensary.

Technical root cause: WordPress doesn't automatically output JSON-LD schema for blog posts unless

explicitly added via a plugin or custom code. Most themes output basic metadata but not structured data.

Recommended fix — step by step

1. Install and activate Yoast SEO or RankMath (both free versions support JSON-LD schema generation).

2. Once activated, go to the plugin settings → Schema → enable 'Article' schema for blog posts.

3. Edit the affected blog post (Exploring THC Concentrate) and verify the Yoast/RankMath panel shows a green

checkmark for schema.

4. Publish/update the post to regenerate its schema markup.

5. Wait 1-2 weeks, then check Google Search Console (Enhancements → Rich Results) to confirm Google

recognizes the schema.

55. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about pre-roll brands has no structured data markup — that's code that tells Google what the

page is about (a blog post, product review, etc.). Without it, search engines have to guess your content's

https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/
https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/


meaning, which often leads to lower visibility or incorrect categorization in search results.

Why it matters for your business: Missing schema reduces the chance your blog content appears in Google

search results with rich snippets (star ratings, publication date, author), lowering click-through rates and

organic traffic to your lifestyle content.

Technical root cause: WordPress doesn't automatically add JSON-LD schema to blog posts; an SEO plugin or

custom theme code is required to inject it. Leafology appears to lack schema-generation plugin configuration.

Recommended fix — step by step

1. Install Yoast SEO (free) or Rank Math (free tier) via WordPress Admin → Plugins → Add New

2. Activate the plugin and run its setup wizard, allowing it to auto-enable schema generation

3. Go to the affected blog post → edit it → scroll to the SEO plugin panel at the bottom

4. Confirm the plugin has auto-detected 'Blog Post' as the content type; if not, manually select it from the

schema dropdown

5. Publish/update the post, then test it using Google's Rich Results Test (search.google.com/test/rich-results)

by pasting the blog URL

6. Repeat for all other blog posts to ensure consistent schema coverage

56. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/finding-your-green/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about finding your green product doesn't include JSON-LD schema markup — structured data

that tells Google what your content is about (a blog post, product review, etc.). Search engines use this to

better understand and display your content in search results. Without it, you're missing an opportunity to

appear in rich snippets (special formatted results with images, ratings, or excerpts).

Why it matters for your business: Missing schema markup reduces your visibility in Google search results and

voice search, making it harder for customers searching for cannabis education or strain information to discover

your blog content.

Technical root cause: WordPress doesn't automatically add JSON-LD schema to blog posts unless a plugin

inserts it or a theme includes it natively. Your current setup is not generating or injecting this structured data

markup.

Recommended fix — step by step

1. Install the free Yoast SEO plugin: go to WordPress dashboard → Plugins → Add New, search 'Yoast SEO',

install and activate.

2. After activation, go to Yoast SEO → Settings → Features and toggle 'Schema output' to ON.

3. Visit Yoast SEO → Tools → File editor and confirm Schema tab is visible (should auto-enable after step 2).

4. Open the affected blog post (finding-your-green) in the editor and scroll to the Yoast SEO sidebar on the

right.

5. Click 'Schema' tab in the Yoast panel and verify 'Article' schema is listed; if not, ensure 'Content type'

dropdown is set to 'Article'.

https://leafologycannabiscompany.com/blog/finding-your-green/


6. Publish/update the post, then test in Google's Rich Results Test (https://search.google.com/test/rich-results)

by pasting the post URL.

7. Repeat steps 4–6 for 3–5 other blog posts to establish a pattern.

57. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page is missing a meta description — the 155-character summary that appears below your page

title in Google search results. Without it, Google may auto-generate a snippet from your content, which often

looks unprofessional or doesn't match your message.

Why it matters for your business: Customers searching for vaporizer information may see a poorly-formatted

or irrelevant snippet in search results instead of your branded messaging, reducing click-through rate from

organic search.

Technical root cause: The WordPress page editor did not have a meta description field filled in, and no SEO

plugin (such as Yoast SEO or Rank Math) is capturing or enforcing one.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → Blog → find 'Premium Flower Vaporizers' post → scroll to Yoast SEO

box (or install Yoast SEO plugin if missing)

2. In the Yoast SEO metabox, locate the 'SEO title' and 'Meta description' fields

3. Write a 155-character description that includes your brand name and a call-to-action, e.g. 'Shop premium

vaporizers at Leafology Cannabis Co. Discreet, efficient delivery. Licensed & trusted.'

4. Enable Yoast SEO's Readability check to ensure the description is compelling

5. Click 'Update' on the post

6. Repeat this process for all blog posts missing meta descriptions by filtering unpublished drafts or using

Yoast's Content Audit tool

58. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about vaporizers doesn't include JSON-LD schema — that's code that tells Google what your

content is about (a blog post, a product, an article, etc.). Without it, search engines have to guess, which means

they might not display your content correctly in search results or understand it well enough to rank it

competitively.

https://search.google.com/test/rich-results)
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Why it matters for your business: Missing schema reduces the chance your blog content ranks and appears in

Google's search results with rich snippets (like publication date, author, or images), lowering organic traffic and

credibility compared to competitors with proper schema markup.

Technical root cause: WordPress isn't automatically outputting structured data blocks for blog posts. Either

your SEO plugin (like Yoast or RankMath) isn't configured to generate schema for blog posts, or it's disabled, or

no plugin is handling schema generation at all.

Recommended fix — step by step

1. Install or activate an SEO plugin: Go to WordPress Admin → Plugins → Add New, search for 'Yoast SEO' or

'RankMath', install, and activate.

2. If using Yoast SEO: Go to Yoast SEO → Settings → Search appearance → Content types → toggle 'Show in

search results' ON for Posts.

3. If using RankMath: Go to RankMath → Search Appearance → Content Types → enable schema for Blog

Posts.

4. Edit the vaporizer blog post: Go to Posts → Edit, scroll down to the SEO plugin's meta box, confirm 'Snippet

preview' shows the post title and excerpt (this confirms schema is active).

5. Publish/update the post and wait 24–48 hours for Google to re-crawl.

6. Verify schema was added: Go to Google's Rich Results Test (search.google.com/test/rich-results), paste the

blog post URL, and confirm you see 'BlogPosting' schema in the output.

59. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post page doesn't have a meta description — that's the 155-character summary that appears under

your page title in Google search results. Without it, Google generates one automatically, which often looks

choppy or irrelevant. For a lifestyle cannabis brand, this is a missed opportunity to control how your content

appears in search and convince people to click.

Why it matters for your business: Missing meta descriptions lower click-through rates from search results,

which means fewer visitors to your blog content and reduced engagement with your brand storytelling.

Technical root cause: The WordPress page or post was published without filling in the meta description field in

your SEO plugin (likely Yoast SEO or Rank Math), or the plugin is not installed.

Recommended fix — step by step

1. Log in to WordPress → Posts → Edit 'The Quest for the Perfect Puff'

2. Scroll to the bottom of the editor and locate the Yoast SEO or Rank Math metabox

3. If you don't see an SEO section, install Yoast SEO plugin: WordPress Dashboard → Plugins → Add New →

search 'Yoast SEO' → Install & Activate

4. In the SEO metabox, click 'Edit snippet' and write a meta description (150–160 characters) that includes

your target keyword and a call-to-action, e.g., 'Discover the science and ritual behind finding your ideal

cannabis experience. Read our guide to consumption methods and effects.'

5. Click 'Update' and save the post

https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/


6. Repeat this process for other blog posts missing meta descriptions

60. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about tinctures has no structured data markup—that's metadata (think: a digital label) that tells

search engines what the page is about, who wrote it, when it was published, and whether it's a review or article.

Without it, Google has to guess, which means your content ranks less prominently for relevant searches.

Why it matters for your business: Missing schema markup reduces the chance your educational content

appears in Google's rich results (like snippets or carousel cards), which directly lowers organic traffic to your

blog and product pages.

Technical root cause: The WordPress site either has no SEO plugin with schema generation enabled, or the

plugin is installed but schema output is disabled in settings. Most likely, the active theme or plugin isn't

configured to emit JSON-LD blocks for blog posts.

Recommended fix — step by step

1. Install Yoast SEO (free version) from WordPress admin → Plugins → Add New, search 'Yoast SEO', click

Install & Activate

2. Go to Yoast SEO → Settings → Schema, and toggle 'Enable Schema' to ON

3. Choose 'Article' as the default schema type for blog posts under Yoast SEO → Settings → Schema →

Content Types

4. Edit the affected post (/blog/tinctures-including-1000mg-options/) and ensure the Yoast meta box shows

'Schema: Article' (if not, save/update the post to trigger schema generation)

5. Visit the post in a private browser window, right-click → View Page Source, and search for '"@type":

"Article"' to confirm JSON-LD is now present

6. Optional: run the URL through Google's Rich Results Test (search.google.com/test/rich-results) to validate

schema markup

61. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about cannabis strains doesn't include structured data—a standardized format that tells search

engines what your content is about. This makes it harder for Google to understand and categorize your page,

potentially hurting its visibility in search results and preventing rich snippets (like star ratings or article

metadata) from appearing.

https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/
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Why it matters for your business: Without schema markup, your blog content is less likely to rank well in

Google Search and won't show enhanced snippets that could improve click-through rates from local customers

searching for strain information in your area.

Technical root cause: WordPress sites need either a dedicated SEO plugin (like Yoast, RankMath, or All in One

SEO) or manual code insertion to output JSON-LD schema. The site currently has neither configured for blog

posts.

Recommended fix — step by step

1. Install RankMath SEO (free tier) or Yoast SEO from WordPress Plugins dashboard → search 'RankMath' →

Install → Activate

2. In RankMath settings (Dashboard → RankMath → Settings → General), enable 'Schema' and choose 'Yes' for

'Enable Schema'

3. Go to Dashboard → RankMath → Schema and add a 'BlogPosting' schema template

4. Edit the affected blog post (Posts → Strains in Westchester, NY), scroll to RankMath Meta Box, and verify

'Article Type' is set to 'BlogPosting'

5. Add a featured image to the post if missing (RankMath uses this for schema image field)

6. Publish and wait 1–2 weeks, then check Google Search Console (Console → URL Inspection) to confirm

schema is detected

62. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/

Rule: tier2.meta.no-description

What it means (plain English)

This blog post doesn't have a meta description — a 160-character summary that appears below the page title in

Google search results. Without it, Google generates a random snippet from your content, which often looks

unprofessional and doesn't convince people to click your link.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer visitors discover your blog content about cannabis access, even if the page ranks well.

Technical root cause: The WordPress post was published without filling in the meta description field in an SEO

plugin (likely Yoast SEO, Rank Math, or All in One SEO), or no plugin is installed to manage these fields.

Recommended fix — step by step

1. Log in to WordPress → Posts → search for 'westchester-medical-weed-access'

2. Open the post for editing

3. Scroll to the SEO plugin panel (Yoast, Rank Math, or All in One SEO) at the bottom of the editor

4. Locate the 'Meta Description' field and enter a 150–160 character summary, e.g., 'Learn about medical

cannabis access in Westchester County, NY. Leafology explains legal requirements, qualifying conditions,

and how to apply for your card.'

5. Click Update/Save

6. In the same plugin, verify the focus keyword is set to a relevant term (e.g., 'medical marijuana Westchester')

to guide future meta descriptions

https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/


7. Apply this same fix to all other blog posts missing descriptions: Posts → filter by plugin status or use bulk

edit tools in Yoast/Rank Math

63. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about the White Plains cannabis mural has no structured data — think of it as metadata that tells

Google what the page is about in a machine-readable format. Without it, search engines have to guess whether

your content is a blog post, product listing, or news article, which means they may rank it lower or display it less

attractively in search results.

Why it matters for your business: Missing schema reduces your visibility in Google search results and

knowledge panels, making it harder for customers searching for cannabis content and local dispensary

information to find your blog posts and brand authority content.

Technical root cause: WordPress is not automatically generating JSON-LD schema.org blocks for blog posts.

Either no SEO plugin is active, or the plugin's schema generation feature is disabled or not configured for blog

post content types.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: WordPress dashboard → Plugins → Add New → search

'Yoast SEO' → Install and Activate

2. Go to Yoast SEO → Settings → Content Types & Taxonomies, and ensure 'Posts' is set to 'Show in search

results' and schema is enabled

3. Edit the affected blog post (Blog → White Plains cannabis mural) and scroll to the Yoast SEO panel at the

bottom; ensure 'Article type' is set to 'Article' or 'BlogPosting'

4. Save the post and verify schema is now present by visiting https://validator.schema.org and pasting the post

URL

5. Repeat for all other blog posts in your /blog/ section to ensure consistent schema coverage

64. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

65. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/

https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/
https://validator.schema.org/
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Rule: tier2.meta.no-description

Detail

Page has no meta description.

66. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

67. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/exploring-legal-weed-dispensary-westchester-nyc/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

68. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

69. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

70. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/

Rule: tier2.schema.none

https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-dispensary/
https://leafologycannabiscompany.com/blog/exploring-legal-weed-dispensary-westchester-nyc/
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Detail

Page has no JSON-LD structured data blocks.

71. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

72. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

73. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/topicals-in-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

74. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/topicals-in-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

75. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/

Rule: tier2.meta.no-description

Detail

https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/
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Page has no meta description.

76. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

77. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

78. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

79. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/edibles-in-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

80. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/edibles-in-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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81. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-

county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

82. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-

county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

83. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

84. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

85. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/stress-relief-strains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/
https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/
https://leafologycannabiscompany.com/blog/stress-relief-strains/


86. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/stress-relief-strains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

87. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

88. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

89. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

90. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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91. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/winter-inspired-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

92. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/winter-inspired-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

93. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/best-strains-winter-nights/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

94. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/best-strains-winter-nights/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

95. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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96. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

97. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-

hydrated-skin/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

98. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-

hydrated-skin/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

99. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-

your-goals/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

100. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-

your-goals/

Rule: tier2.schema.none

Detail
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Page has no JSON-LD structured data blocks.

101. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-

february/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

102. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-

february/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

103. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-

heres-what-actually-matters/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

104. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-

heres-what-actually-matters/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

105. Missing meta description

Severity: P2

https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
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Page URL: https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-

enjoyment/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

106. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-

enjoyment/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

107. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

108. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

109. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/sweet-treats-for-your-valentine-cone-edibles-

worth-exploring/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

110. No JSON-LD schema

https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-enjoyment/
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Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/sweet-treats-for-your-valentine-cone-edibles-

worth-exploring/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

111. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-

plains-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

112. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-

plains-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

113. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-

resin-picks-at-a-white-plains-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

114. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-

resin-picks-at-a-white-plains-dispensary/

Rule: tier2.schema.none

Detail
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Page has no JSON-LD structured data blocks.

115. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-

plains-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

116. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-

plains-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

117. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

118. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/shop/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

119. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/shop/

Rule: tier2.schema.none

https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-plains-dispensary/
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Detail

Page has no JSON-LD structured data blocks.

120. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/order-confirmation/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

121. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/order-confirmation/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

122. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/specials/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

123. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/specials/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

124. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/

Rule: tier2.meta.no-description

Detail

https://leafologycannabiscompany.com/order-confirmation/
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Page has no meta description.

125. Missing canonical

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

126. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

127. 6 image(s) missing alt text

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

128. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/about/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

129. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/about/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/blog/
https://leafologycannabiscompany.com/blog/
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130. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/contact/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

131. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/contact/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

132. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/terms-conditions/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

133. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/terms-conditions/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

134. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/faq/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/contact/
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135. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/faq/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

136. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

137. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

138. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/news/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

139. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/news/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/faq/
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140. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/accessibility-statement/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

141. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/accessibility-statement/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

142. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-

westchester-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

143. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/high-roller-club-rewards/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

144. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/high-roller-club-rewards/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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145. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/whiteplainsdiner/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

146. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/medical-customers/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

147. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/medical-customers/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

148. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

149. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/whiteplainsdiner/
https://leafologycannabiscompany.com/medical-customers/
https://leafologycannabiscompany.com/medical-customers/
https://leafologycannabiscompany.com/delivery/
https://leafologycannabiscompany.com/delivery/


150. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/flower/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

151. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/flower/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

152. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/pre-rolls/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

153. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/pre-rolls/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

154. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/vaporizers/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/flower/
https://leafologycannabiscompany.com/flower/
https://leafologycannabiscompany.com/pre-rolls/
https://leafologycannabiscompany.com/pre-rolls/
https://leafologycannabiscompany.com/vaporizers/


155. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/vaporizers/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

156. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

157. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

158. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/the-leafology-guarantee/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

159. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/the-leafology-guarantee/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/vaporizers/
https://leafologycannabiscompany.com/edibles/
https://leafologycannabiscompany.com/edibles/
https://leafologycannabiscompany.com/the-leafology-guarantee/
https://leafologycannabiscompany.com/the-leafology-guarantee/


160. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/home/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

161. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

162. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

163. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

164. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/home/
https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/
https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/
https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/


165. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

166. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

167. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

168. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

169. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/


170. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

171. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

172. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

173. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

174. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/


175. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

176. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

177. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

178. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

179. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/


180. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

181. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

182. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

183. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

184. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/
https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/


185. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

186. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

187. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

188. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

189. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/


190. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

191. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

192. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

193. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

194. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/


195. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

196. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

197. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/brass-knuckles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

198. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/brass-knuckles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

199. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/brand/brass-knuckles/
https://leafologycannabiscompany.com/brand/brass-knuckles/
https://leafologycannabiscompany.com/brand/


200. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

201. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/cone-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

202. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/cone-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

203. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/dank-gummies/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

204. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/dank-gummies/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/brand/
https://leafologycannabiscompany.com/brand/cone-edibles/
https://leafologycannabiscompany.com/brand/cone-edibles/
https://leafologycannabiscompany.com/brand/dank-gummies/
https://leafologycannabiscompany.com/brand/dank-gummies/


205. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/dog-walkers/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

206. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/dog-walkers/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

207. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/eureka-vapes/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

208. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/eureka-vapes/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

209. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/holiday-vapes/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/brand/dog-walkers/
https://leafologycannabiscompany.com/brand/dog-walkers/
https://leafologycannabiscompany.com/brand/eureka-vapes/
https://leafologycannabiscompany.com/brand/eureka-vapes/
https://leafologycannabiscompany.com/brand/holiday-vapes/


210. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/holiday-vapes/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

211. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/jams-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

212. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/jams-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

213. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/lychee-vapes/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

214. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/lychee-vapes/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/brand/holiday-vapes/
https://leafologycannabiscompany.com/brand/jams-edibles/
https://leafologycannabiscompany.com/brand/jams-edibles/
https://leafologycannabiscompany.com/brand/lychee-vapes/
https://leafologycannabiscompany.com/brand/lychee-vapes/


215. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/moods-vapes/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

216. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/moods-vapes/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

217. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/rythm-vape-pen/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

218. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/rythm-vape-pen/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

219. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/weed-cones-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/brand/moods-vapes/
https://leafologycannabiscompany.com/brand/moods-vapes/
https://leafologycannabiscompany.com/brand/rythm-vape-pen/
https://leafologycannabiscompany.com/brand/rythm-vape-pen/
https://leafologycannabiscompany.com/brand/weed-cones-edibles/


220. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/brand/weed-cones-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

221. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/promos-events/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

222. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/promos-events/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

223. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/holidaydeals/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

224. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/holidaydeals/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/brand/weed-cones-edibles/
https://leafologycannabiscompany.com/promos-events/
https://leafologycannabiscompany.com/promos-events/
https://leafologycannabiscompany.com/holidaydeals/
https://leafologycannabiscompany.com/holidaydeals/


225. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

226. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

227. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/dispensary-near/darien-ct/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

228. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/dispensary-near/darien-ct/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

229. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/
https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/
https://leafologycannabiscompany.com/dispensary-near/darien-ct/
https://leafologycannabiscompany.com/dispensary-near/darien-ct/
https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/


230. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

231. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/harrison-ny/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

232. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/harrison-ny/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

233. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

234. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/
https://leafologycannabiscompany.com/weed-delivery/harrison-ny/
https://leafologycannabiscompany.com/weed-delivery/harrison-ny/
https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/
https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/


235. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

236. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

237. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/dispensary-near/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

238. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/dispensary-near/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

239. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/
https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/
https://leafologycannabiscompany.com/dispensary-near/
https://leafologycannabiscompany.com/dispensary-near/
https://leafologycannabiscompany.com/weed-delivery/


240. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/weed-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

241. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/edibles-dosing-guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

242. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/edibles-dosing-guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

243. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/how-to-keep-weed-fresh/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

244. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/how-to-keep-weed-fresh/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/weed-delivery/
https://leafologycannabiscompany.com/edibles-dosing-guide/
https://leafologycannabiscompany.com/edibles-dosing-guide/
https://leafologycannabiscompany.com/how-to-keep-weed-fresh/
https://leafologycannabiscompany.com/how-to-keep-weed-fresh/


245. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

246. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

247. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/march-strain-madness-westchester/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

248. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/march-strain-madness-westchester/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

249. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/
https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/
https://leafologycannabiscompany.com/march-strain-madness-westchester/
https://leafologycannabiscompany.com/march-strain-madness-westchester/
https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/


250. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

251. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

252. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

253. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

254. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/


255. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-1/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

256. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-1/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

257. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-2/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

258. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-2/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

259. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-3/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/blog/pin/example-pin-1/
https://leafologycannabiscompany.com/blog/pin/example-pin-1/
https://leafologycannabiscompany.com/blog/pin/example-pin-2/
https://leafologycannabiscompany.com/blog/pin/example-pin-2/
https://leafologycannabiscompany.com/blog/pin/example-pin-3/


260. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-3/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

261. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

262. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/calendar/pop-ups/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

263. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/calendar/pop-ups/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

264. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/calendar/promos/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/blog/pin/example-pin-3/
https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/
https://leafologycannabiscompany.com/calendar/pop-ups/
https://leafologycannabiscompany.com/calendar/pop-ups/
https://leafologycannabiscompany.com/calendar/promos/


265. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/calendar/promos/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

266. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/location/leafology-ny-white-plains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

267. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/location/leafology-ny-white-plains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

268. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-

6377ef894f37d5000a8ea822/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

269. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-

6377ef894f37d5000a8ea822/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/calendar/promos/
https://leafologycannabiscompany.com/location/leafology-ny-white-plains/
https://leafologycannabiscompany.com/location/leafology-ny-white-plains/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/


270. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-

6377ef634f37d5000a8ea45b/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

271. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-

6377ef634f37d5000a8ea45b/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

272. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-

6377ef8d4f37d5000a8ea864/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

273. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-

6377ef8d4f37d5000a8ea864/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

274. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-

lemon-glue-di-6377ef8e4f37d5000a8ea87f/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/


Detail

Page has no meta description.

275. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-

lemon-glue-di-6377ef8e4f37d5000a8ea87f/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

276. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-

larry-cake-di-6377ef534f37d5000a8e9d6c/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

277. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-

larry-cake-di-6377ef534f37d5000a8e9d6c/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

278. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-

haze-di-6377ef904f37d5000a8ea8c6/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

279. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/


Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-

haze-di-6377ef904f37d5000a8ea8c6/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

280. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-

6377efab4f37d5000a8eab37/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

281. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-

6377efab4f37d5000a8eab37/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

282. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-

6377ef9e4f37d5000a8eaa27/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

283. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-

6377ef9e4f37d5000a8eaa27/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/


284. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-

cake-di-6377ef9f4f37d5000a8eaa34/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

285. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-

cake-di-6377ef9f4f37d5000a8eaa34/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

286. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-

6377ef934f37d5000a8ea93a/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

287. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-

6377ef934f37d5000a8ea93a/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

288. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-

chocolate-di-6377ef904f37d5000a8ea8d5/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/


Detail

Page has no meta description.

289. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-

chocolate-di-6377ef904f37d5000a8ea8d5/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

290. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-

6377ef534f37d5000a8e9da4/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

291. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-

6377ef534f37d5000a8e9da4/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

292. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-

di-6377ef9a4f37d5000a8ea9b9/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

293. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/


Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-

di-6377ef9a4f37d5000a8ea9b9/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

294. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-

6377ef7b4f37d5000a8ea6a6/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

295. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-

6377ef7b4f37d5000a8ea6a6/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

296. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-

citrus-sunburst-di-6377ef764f37d5000a8ea628/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

297. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-

citrus-sunburst-di-6377ef764f37d5000a8ea628/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/


298. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-

6377ef614f37d5000a8ea393/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

299. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-

6377ef614f37d5000a8ea393/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

300. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-

blend-di-6377ef824f37d5000a8ea736/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

301. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-

blend-di-6377ef824f37d5000a8ea736/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

302. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-

mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/


Detail

Page has no meta description.

303. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-

mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

304. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-

6377ef834f37d5000a8ea765/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

305. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-

6377ef834f37d5000a8ea765/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

306. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-

pie-di-6377ef794f37d5000a8ea679/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

307. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/


Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-

pie-di-6377ef794f37d5000a8ea679/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

308. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-

di-6377ef8a4f37d5000a8ea82d/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

309. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-

di-6377ef8a4f37d5000a8ea82d/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

310. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-

di-6377ef734f37d5000a8ea5eb/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

311. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-

di-6377ef734f37d5000a8ea5eb/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/


312. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-

di-6377ef584f37d5000a8e9f31/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

313. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-

di-6377ef584f37d5000a8e9f31/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

314. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-

6377ef9a4f37d5000a8ea9c0/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

315. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-

6377ef9a4f37d5000a8ea9c0/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

316. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-

6377efb74f37d5000a8eac63/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/


Detail

Page has no meta description.

317. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-

6377efb74f37d5000a8eac63/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

318. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-

6377efba4f37d5000a8eacb2/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

319. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-

6377efba4f37d5000a8eacb2/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

320. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-

berry-di-6377efb84f37d5000a8eac7c/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

321. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/


Page URL: https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-

berry-di-6377efb84f37d5000a8eac7c/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

322. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-

orange-di-6377ef704f37d5000a8ea5c1/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

323. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-

orange-di-6377ef704f37d5000a8ea5c1/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

324. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-

di-6377ef8e4f37d5000a8ea88f/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

325. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-

di-6377ef8e4f37d5000a8ea88f/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/


326. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-

verde-di-6377ef764f37d5000a8ea631/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

327. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-

verde-di-6377ef764f37d5000a8ea631/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

328. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-

glue-di-6377ef584f37d5000a8e9f12/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

329. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-

glue-di-6377ef584f37d5000a8e9f12/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

330. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-

di-6377ef6f4f37d5000a8ea5a8/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/


Detail

Page has no meta description.

331. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-

di-6377ef6f4f37d5000a8ea5a8/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

332. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-

fruit-rosemary-di-6377ef574f37d5000a8e9eaf/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

333. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-

fruit-rosemary-di-6377ef574f37d5000a8e9eaf/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

334. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-

6377ef6c4f37d5000a8ea588/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

335. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/


Page URL: https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-

6377ef6c4f37d5000a8ea588/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

336. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-

choice-di-6377ef824f37d5000a8ea745/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

337. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-

choice-di-6377ef824f37d5000a8ea745/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

338. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-

6377ef854f37d5000a8ea7ad/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

339. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-

6377ef854f37d5000a8ea7ad/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/


340. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-

mints-di-6377efbc4f37d5000a8ead0d/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

341. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-

mints-di-6377efbc4f37d5000a8ead0d/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

342. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-

creamsicle-di-6377efa94f37d5000a8eab0d/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

343. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-

creamsicle-di-6377efa94f37d5000a8eab0d/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

344. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-

6377ef5d4f37d5000a8ea18f/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/


Detail

Page has no meta description.

345. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-

6377ef5d4f37d5000a8ea18f/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

346. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-

6377efb54f37d5000a8eac24/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

347. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-

6377efb54f37d5000a8eac24/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

348. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-

cherry-charm-di-6377efbb4f37d5000a8eace1/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

349. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/


Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-

cherry-charm-di-6377efbb4f37d5000a8eace1/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

350. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-

6377ef914f37d5000a8ea8e4/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

351. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-

6377ef914f37d5000a8ea8e4/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

352. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-

6377ef8d4f37d5000a8ea86c/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

353. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-

6377ef8d4f37d5000a8ea86c/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/


354. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-

di-6377ef634f37d5000a8ea48d/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

355. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-

di-6377ef634f37d5000a8ea48d/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

356. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-

jelly-di-6377efb84f37d5000a8eac81/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

357. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-

jelly-di-6377efb84f37d5000a8eac81/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

358. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-

hitter-di-6377efa84f37d5000a8eab05/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/


Detail

Page has no meta description.

359. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-

hitter-di-6377efa84f37d5000a8eab05/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

360. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-

6377efa54f37d5000a8eaaba/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

361. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-

6377efa54f37d5000a8eaaba/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

362. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-

dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

363. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/


Page URL: https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-

dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

364. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-

6377ef534f37d5000a8e9d85/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

365. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-

6377ef534f37d5000a8e9d85/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

366. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-

6377ef614f37d5000a8ea3f4/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

367. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-

6377ef614f37d5000a8ea3f4/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/


368. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-

6377efbc4f37d5000a8ead06/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

369. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-

6377efbc4f37d5000a8ead06/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

370. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-

souffle-di-6377efab4f37d5000a8eab26/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

371. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-

souffle-di-6377efab4f37d5000a8eab26/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

372. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-

6377ef744f37d5000a8ea60c/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/


Detail

Page has no meta description.

373. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-

6377ef744f37d5000a8ea60c/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

374. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-

6377ef614f37d5000a8ea3ae/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

375. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-

6377ef614f37d5000a8ea3ae/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

376. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-

ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

377. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/


Page URL: https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-

ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

378. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-

6377efac4f37d5000a8eab40/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

379. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-

6377efac4f37d5000a8eab40/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

380. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-

6377ef7c4f37d5000a8ea6b8/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

381. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-

6377ef7c4f37d5000a8ea6b8/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/


382. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-

burst-di-6377efb84f37d5000a8eac8d/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

383. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-

burst-di-6377efb84f37d5000a8eac8d/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

384. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-

apple-di-6377ef764f37d5000a8ea62c/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

385. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-

apple-di-6377ef764f37d5000a8ea62c/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

386. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-

6377efb54f37d5000a8eac11/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/


Detail

Page has no meta description.

387. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-

6377efb54f37d5000a8eac11/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

388. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-

6377efa24f37d5000a8eaa58/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

389. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-

6377efa24f37d5000a8eaa58/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

390. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-

yoda-di-6377efb94f37d5000a8eac9f/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

391. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/


Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-

yoda-di-6377efb94f37d5000a8eac9f/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

392. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-

martian-di-6377ef8f4f37d5000a8ea8b0/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

393. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-

martian-di-6377ef8f4f37d5000a8ea8b0/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

394. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-

6377efb24f37d5000a8eabb4/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

395. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-

6377efb24f37d5000a8eabb4/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/


396. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-

di-6377efaa4f37d5000a8eab17/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

397. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-

di-6377efaa4f37d5000a8eab17/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

398. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-

watermelon-di-6377ef7e4f37d5000a8ea6ea/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

399. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-

watermelon-di-6377ef7e4f37d5000a8ea6ea/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

400. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-

di-6377ef934f37d5000a8ea92c/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/


Detail

Page has no meta description.

401. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-

di-6377ef934f37d5000a8ea92c/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

402. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-

6377ef6b4f37d5000a8ea576/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

403. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-

6377ef6b4f37d5000a8ea576/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

404. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-

6377ef724f37d5000a8ea5e3/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

405. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/


Page URL: https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-

6377ef724f37d5000a8ea5e3/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

406. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-

indica-granimals-di-6377ef634f37d5000a8ea47d/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

407. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-

indica-granimals-di-6377ef634f37d5000a8ea47d/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

408. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-

hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

409. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-

hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/


410. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-

6377ef684f37d5000a8ea557/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

411. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-

6377ef684f37d5000a8ea557/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

412. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-

6377ef714f37d5000a8ea5db/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

413. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-

6377ef714f37d5000a8ea5db/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

414. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-

punch-di-6377ef874f37d5000a8ea7f1/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/


Detail

Page has no meta description.

415. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-

punch-di-6377ef874f37d5000a8ea7f1/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

416. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-

di-6377ef8d4f37d5000a8ea874/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

417. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-

di-6377ef8d4f37d5000a8ea874/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

418. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-

6377efb44f37d5000a8eac08/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

419. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/


Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-

6377efb44f37d5000a8eac08/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

420. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-

6377ef7b4f37d5000a8ea6ae/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

421. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-

6377ef7b4f37d5000a8ea6ae/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

422. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-

passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

423. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-

passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/


424. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-

mimosa-di-6377efae4f37d5000a8eab68/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

425. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-

mimosa-di-6377efae4f37d5000a8eab68/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

426. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-

di-6377ef944f37d5000a8ea95a/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

427. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-

di-6377ef944f37d5000a8ea95a/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

428. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-

6377ef634f37d5000a8ea497/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/


Detail

Page has no meta description.

429. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-

6377ef634f37d5000a8ea497/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

430. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-

cruise-232-di-6377efb04f37d5000a8eab95/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

431. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-

cruise-232-di-6377efb04f37d5000a8eab95/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

432. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-

1-x-do-lato-di-6377efb74f37d5000a8eac73/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

433. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/


Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-

1-x-do-lato-di-6377efb74f37d5000a8eac73/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

434. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-

herer-x-strawpicana-di-6377ef784f37d5000a8ea669/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

435. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-

herer-x-strawpicana-di-6377ef784f37d5000a8ea669/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

436. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-

chocolate-chip-di-6377ef6a4f37d5000a8ea570/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

437. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-

chocolate-chip-di-6377ef6a4f37d5000a8ea570/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/


438. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-

di-6377ef924f37d5000a8ea91f/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

439. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-

di-6377ef924f37d5000a8ea91f/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

440. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-

gelato-di-6377ef5a4f37d5000a8ea00f/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

441. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-

gelato-di-6377ef5a4f37d5000a8ea00f/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

442. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-

di-6377efa04f37d5000a8eaa41/

Rule: tier2.meta.no-description

https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/


Detail

Page has no meta description.

443. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-

di-6377efa04f37d5000a8eaa41/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

444. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-

6377ef834f37d5000a8ea75d/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

445. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-

6377ef834f37d5000a8ea75d/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

446. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-

di-6377ef684f37d5000a8ea54e/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

447. No JSON-LD schema

Severity: P2

https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/


Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-

di-6377ef684f37d5000a8ea54e/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

448. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-

6377ef704f37d5000a8ea5b5/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

449. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-

6377ef704f37d5000a8ea5b5/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

450. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-

6377ef664f37d5000a8ea52e/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

451. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-

6377ef664f37d5000a8ea52e/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.
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452. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/pax-era/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

453. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/pax-era/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

454. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

455. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

456. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/ginger-beer-50mg/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/product/pax-era/
https://leafologycannabiscompany.com/product/pax-era/
https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/
https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/
https://leafologycannabiscompany.com/product/ginger-beer-50mg/


457. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/ginger-beer-50mg/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

458. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/raspberry-truffle-bite/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

459. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/raspberry-truffle-bite/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

460. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/pineapple-skunk/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

461. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/pineapple-skunk/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/ginger-beer-50mg/
https://leafologycannabiscompany.com/product/raspberry-truffle-bite/
https://leafologycannabiscompany.com/product/raspberry-truffle-bite/
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https://leafologycannabiscompany.com/product/pineapple-skunk/


462. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

463. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

464. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/grapefruit/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

465. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/grapefruit/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

466. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/
https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/
https://leafologycannabiscompany.com/product/grapefruit/
https://leafologycannabiscompany.com/product/grapefruit/
https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/


467. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

468. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

469. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

470. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/banana-bread/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

471. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/banana-bread/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/
https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/
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472. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/uranium-v2/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

473. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/uranium-v2/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

474. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

475. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

476. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/sirius-black/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/product/uranium-v2/
https://leafologycannabiscompany.com/product/uranium-v2/
https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/
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https://leafologycannabiscompany.com/product/sirius-black/


477. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/sirius-black/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

478. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/g-13-cartridge-1g/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

479. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/g-13-cartridge-1g/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

480. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

481. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/sirius-black/
https://leafologycannabiscompany.com/product/g-13-cartridge-1g/
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482. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/brownie-truffles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

483. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/brownie-truffles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

484. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

485. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

486. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/trainwreck/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/product/brownie-truffles/
https://leafologycannabiscompany.com/product/brownie-truffles/
https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/
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https://leafologycannabiscompany.com/product/trainwreck/


487. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/trainwreck/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

488. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/dog-park/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

489. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/dog-park/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

490. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

491. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://leafologycannabiscompany.com/product/trainwreck/
https://leafologycannabiscompany.com/product/dog-park/
https://leafologycannabiscompany.com/product/dog-park/
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https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/


492. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/indica-transdermal-patch/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

493. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/indica-transdermal-patch/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

494. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

495. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

496. Missing meta description

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://leafologycannabiscompany.com/product/indica-transdermal-patch/
https://leafologycannabiscompany.com/product/indica-transdermal-patch/
https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/
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https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/


497. No JSON-LD schema

Severity: P2

Page URL: https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

498. Missing security header: strict-transport-security

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.header.strict-transport-security

Detail

strict-transport-security not present on homepage response. Affects fortress score and CSP posture.

499. Missing security header: x-frame-options

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.header.x-frame-options

Detail

x-frame-options not present on homepage response. Affects fortress score and CSP posture.

500. Missing security header: content-security-policy

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.header.content-security-policy

Detail

content-security-policy not present on homepage response. Affects fortress score and CSP posture.

501. 428 tap targets under 44px at mobile-320

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/


502. 452 tap targets under 44px at mobile-375

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

503. 455 tap targets under 44px at mobile-414

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

504. 459 tap targets under 44px at tablet-768

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

505. A11y: Heading levels should only increase by one

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier9.a11y.heading-order

Detail

Ensure the order of headings is semantically correct

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/heading-order?application=playwright

506. A11y: All page content should be contained by landmarks (×6)

Severity: P2

Page URL: https://leafologycannabiscompany.com/

Rule: tier9.a11y.region

https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://dequeuniversity.com/rules/axe/4.11/heading-order?application=playwright
https://leafologycannabiscompany.com/


Detail

Ensure all page content is contained by landmarks

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/region?application=playwright

P3 — 794 findings

1. Title length 122 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-

in-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Beginners Guide to Different Cannabis Strains in White Plains –

Leafology Dispensary White plains | Dispensary near me"

2. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-

in-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

3. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-

in-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

4. Title length 83 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/

https://dequeuniversity.com/rules/axe/4.11/region?application=playwright
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/


Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What Can Weed Do For Pain? – Leafology Dispensary White plains |

Dispensary near me"

5. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

6. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

7. Title length 119 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-

and-flavonoids-in-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Science of Cannabis: Understanding Terpenes and Flavonoids –

Leafology Dispensary White plains | Dispensary near me"

8. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-

and-flavonoids-in-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

9. Missing Twitter card

https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/
https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/
https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/
https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/
https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/
https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-

and-flavonoids-in-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

10. Title length 78 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "No Smoke? No Problem! – Leafology Dispensary White plains | Dispensary

near me"

11. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

12. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

13. Title length 127 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-

exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Indulge Your Senses: Exploring the Flavorful World of Cannabis Edibles –

Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/
https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/
https://leafologycannabiscompany.com/blog/no-smoke-no-problem/
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14. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-

exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

15. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-

exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

16. 2 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-

exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

17. Title length 147 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-

elevating-your-cannabis-experience-with-potent-and-portable-options/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Vaping in Westchester: Elevating Your Cannabis Experience with Potent and

Portable Options – Leafology Dispensary White plains | Dispensary near me"

18. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-

elevating-your-cannabis-experience-with-potent-and-portable-options/

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/
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Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

19. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-

elevating-your-cannabis-experience-with-potent-and-portable-options/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

20. Title length 111 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-elevate-your-culinary-

creations-cooking-with-cannabis-in-white-plains-westchester/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Elevate Your Culinary Creations: Cooking with Cannabis – Leafology

Dispensary White plains | Dispensary near me"

21. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-elevate-your-culinary-

creations-cooking-with-cannabis-in-white-plains-westchester/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

22. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/no-smoke-no-problem-elevate-your-culinary-

creations-cooking-with-cannabis-in-white-plains-westchester/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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23. Title length 149 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/differences-between-distillate-live-resin-and-rosin-

vapes-in-white-plains-westchester/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Canna-Vocab: Exploring the Differences Between “Distillate”, “Live Resin”,

and “Rosin” Vapes – Leafology Dispensary White plains | Dispensary near me"

24. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/differences-between-distillate-live-resin-and-rosin-

vapes-in-white-plains-westchester/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

25. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/differences-between-distillate-live-resin-and-rosin-

vapes-in-white-plains-westchester/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

26. Title length 121 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What is Cannabis Tincture? Its Benefits and How Do You Use Them? –

Leafology Dispensary White plains | Dispensary near me"

27. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/

Rule: tier2.meta.no-og

https://leafologycannabiscompany.com/blog/differences-between-distillate-live-resin-and-rosin-vapes-in-white-plains-westchester/
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Detail

Page missing og:title and/or og:image.

28. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

29. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What is Cannabis Flower? Everything You Need to Know – Leafology

Dispensary White plains | Dispensary near me"

30. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

31. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

32. Title length 117 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/

Rule: tier2.meta.title-length

https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/
https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/
https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/
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Detail

Title should be 20-65 chars. Got: "Vapes vs. Pre-Rolls: Which Cannabis Option is Right for You? – Leafology

Dispensary White plains | Dispensary near me"

33. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

34. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

35. Title length 118 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Ultimate Guide to Choose the Right Cannabis Products For You? – Leafology

Dispensary White plains | Dispensary near me"

36. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

37. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/

https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/
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Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

38. Title length 125 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/types-of-concentrates/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Types of Concentrates: How to Choose the Right Concentrates For You? –

Leafology Dispensary White plains | Dispensary near me"

39. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/types-of-concentrates/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

40. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/types-of-concentrates/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

41. Title length 113 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/thc-vs-cbd/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "THC vs. CBD: What’s the Difference, Benefits and Effects – Leafology

Dispensary White plains | Dispensary near me"

42. Missing OpenGraph metadata

Severity: P3

https://leafologycannabiscompany.com/blog/types-of-concentrates/
https://leafologycannabiscompany.com/blog/types-of-concentrates/
https://leafologycannabiscompany.com/blog/types-of-concentrates/
https://leafologycannabiscompany.com/blog/thc-vs-cbd/


Page URL: https://leafologycannabiscompany.com/blog/thc-vs-cbd/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

43. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/thc-vs-cbd/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

44. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-

shelf-life/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Do Cannabis Edibles Expire? Storage Tips and Shelf Life – Leafology

Dispensary White plains | Dispensary near me"

45. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-

shelf-life/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

46. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-

shelf-life/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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47. Title length 114 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Difference Between Pre Roll Joint, Blunt and Spliff Joint – Leafology

Dispensary White plains | Dispensary near me"

48. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

49. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

50. Title length 123 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Difference Between Cannabis Store vs Marijuana Store vs Dispensary –

Leafology Dispensary White plains | Dispensary near me"

51. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/
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52. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

53. Title length 110 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-legal-weed-dispensary-westchester-nyc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Exploring Legal Weed Dispensaries in Westchester, NYC – Leafology

Dispensary White plains | Dispensary near me"

54. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-legal-weed-dispensary-westchester-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

55. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-legal-weed-dispensary-westchester-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

56. Title length 123 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-

harrison-westchester-nyc/

Rule: tier2.meta.title-length

Detail
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Title should be 20-65 chars. Got: "Discover the Best Dry Herb Vaporizer at Leafology Cannabis Company –

Leafology Dispensary White plains | Dispensary near me"

57. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-

harrison-westchester-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

58. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-white-plains-scarsdale-

harrison-westchester-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

59. Title length 120 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Discover the Best Pre Roll Brands at Leafology Cannabis Company –

Leafology Dispensary White plains | Dispensary near me"

60. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

61. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/
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Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

62. Title length 128 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Exploring THC Tincture 1000mg: Insights from Leafology Cannabis Company

– Leafology Dispensary White plains | Dispensary near me"

63. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

64. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

65. Title length 132 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "A Slice of Delight, A Hint of Power: Unveiling the Watermelon Diesel Strain –

Leafology Dispensary White plains | Dispensary near me"

66. Missing OpenGraph metadata

Severity: P3

https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/
https://leafologycannabiscompany.com/blog/exploring-thc-tincture-1000mg-guide/
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Page URL: https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

67. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

68. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

69. Title length 121 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-devil-driver-strain/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Experience the Devil Driver Strain at Leafology Cannabis Company –

Leafology Dispensary White plains | Dispensary near me"

70. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-devil-driver-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

71. Missing Twitter card

Severity: P3

https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/
https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/
https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/
https://leafologycannabiscompany.com/blog/the-devil-driver-strain/
https://leafologycannabiscompany.com/blog/the-devil-driver-strain/


Page URL: https://leafologycannabiscompany.com/blog/the-devil-driver-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

72. Title length 131 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Exploring THC Concentrate Delivery in Westchester: Insights from Leafology

– Leafology Dispensary White plains | Dispensary near me"

73. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

74. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

75. Title length 140 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Finding the Best Pre-Roll Brands: Your Expert Guide from Leafology Cannabis

Company – Leafology Dispensary White plains | Dispensary near me"

76. Missing OpenGraph metadata

https://leafologycannabiscompany.com/blog/the-devil-driver-strain/
https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/
https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/
https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/
https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

77. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

78. Title length 148 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/finding-your-green/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Finding Your Green: A Leafology Guide to Choosing the Right Cannabis

Dispensary in New York – Leafology Dispensary White plains | Dispensary near me"

79. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/finding-your-green/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

80. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/finding-your-green/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

81. Title length 129 chars

https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/
https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/
https://leafologycannabiscompany.com/blog/finding-your-green/
https://leafologycannabiscompany.com/blog/finding-your-green/
https://leafologycannabiscompany.com/blog/finding-your-green/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Meet the Force, Perfectly Rolled: Discover Revelry’s Baby Yoda Pre-Rolls –

Leafology Dispensary White plains | Dispensary near me"

82. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

83. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

84. Title length 124 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Premium Flower Vaporizers: Leafology’s Choice for True Connoisseurs –

Leafology Dispensary White plains | Dispensary near me"

85. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

86. Missing Twitter card

https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/
https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/
https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/
https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/
https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

87. Title length 139 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Quest for the Perfect Puff: Finding the Best Dry Herb Vaporizer with

Leafology – Leafology Dispensary White plains | Dispensary near me"

88. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

89. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

90. Title length 140 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Unlocking Precision and Potency: A Guide to THC Tinctures, Including

1000mg Options – Leafology Dispensary White plains | Dispensary near me"

91. Missing OpenGraph metadata

https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/
https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/
https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/
https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-puff/
https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

92. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

93. Title length 160 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Search for Potent Weed: Discovering the Highest-Testing THC Strains in

Westchester, NY at Leafology – Leafology Dispensary White plains | Dispensary near me"

94. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

95. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

96. Title length 141 chars

https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/
https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/
https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/
https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/
https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Smart Savings: Discovering the Lowest Cost Weed Per Gram in Westchester

at Leafology – Leafology Dispensary White plains | Dispensary near me"

97. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

98. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

99. Title length 167 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Westchester Medical Weed Access Expanded: Leafology & Leafwell Bring

Savings to White Plains Cannabis Patients – Leafology Dispensary White plains | Dispensary near me"

100. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

101. Missing Twitter card

https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/
https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/
https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-in-westchester/
https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/
https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

102. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

103. Title length 182 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "More Than a Weed Store: Leafology’s New Mural Celebrates Community and

Cannabis Culture in Downtown White Plains, Westchester – Leafology Dispensary White plains | Dispensary near

me"

104. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

105. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

106. 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/
https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/
https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/
https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/
https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

107. Title length 161 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Best Pre Roll Brands in White Plains & Westchester: Leafology’s Top Picks for

Smooth, Flavorful Sessions – Leafology Dispensary White plains | Dispensary near me"

108. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

109. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

110. Title length 131 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Ultimate Guide to Cannabis Flower in White Plains & Westchester County

– Leafology Dispensary White plains | Dispensary near me"

111. Missing OpenGraph metadata

https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/
https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/
https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/
https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/
https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

112. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

113. Title length 164 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/topicals-in-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Buying Cannabis Topicals in White Plains & Westchester County: A Gentle,

Effective Way to Experience Relief – Leafology Dispensary White plains | Dispensary near me"

114. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/topicals-in-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

115. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/topicals-in-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

116. Title length 124 chars

https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/
https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/
https://leafologycannabiscompany.com/blog/topicals-in-white-plains/
https://leafologycannabiscompany.com/blog/topicals-in-white-plains/
https://leafologycannabiscompany.com/blog/topicals-in-white-plains/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "THC Relief Tincture: Fast-Acting Comfort in a Simple, Measured Dose –

Leafology Dispensary White plains | Dispensary near me"

117. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

118. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

119. Title length 154 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Buy Oral Cannabis Products in White Plains & Westchester County: Pills,

Capsules & Oils Explained – Leafology Dispensary White plains | Dispensary near me"

120. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

121. Missing Twitter card

https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/
https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/
https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/
https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/
https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/


Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

122. Title length 147 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/edibles-in-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Shop Cannabis Edibles in White Plains & Westchester County: Safety, Dosing

& Popular Picks – Leafology Dispensary White plains | Dispensary near me"

123. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/edibles-in-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

124. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/edibles-in-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

125. Title length 209 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-

county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Best Cannabis Vapes in White Plains & Westchester County: The Ultimate

GuideBest Cannabis Vapes in White Plains & Westchester County: The Ultimate Guide – Leafology Dispensary

White plains | Dispensary near me"

https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/
https://leafologycannabiscompany.com/blog/edibles-in-white-plains/
https://leafologycannabiscompany.com/blog/edibles-in-white-plains/
https://leafologycannabiscompany.com/blog/edibles-in-white-plains/
https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/


126. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-

county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

127. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-

county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

128. Title length 155 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Understanding Cannabis Concentrates in White Plains & Westchester

County: From Live Resin to Rosin – Leafology Dispensary White plains | Dispensary near me"

129. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

130. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-in-white-plains-westchester-county-the-ultimate-guide/
https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/
https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/
https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/


No twitter:card meta tag.

131. Title length 136 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/stress-relief-strains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Holiday Stress Relief With Top Cannabis Strains in White Plains and

Westchester – Leafology Dispensary White plains | Dispensary near me"

132. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/stress-relief-strains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

133. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/stress-relief-strains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

134. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/stress-relief-strains/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

135. Title length 138 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/blog/stress-relief-strains/
https://leafologycannabiscompany.com/blog/stress-relief-strains/
https://leafologycannabiscompany.com/blog/stress-relief-strains/
https://leafologycannabiscompany.com/blog/stress-relief-strains/
https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/


Title should be 20-65 chars. Got: "Winter Wellness in White Plains and Westchester With Cannabis for Aches

and Pains – Leafology Dispensary White plains | Dispensary near me"

136. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

137. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

138. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

139. Title length 140 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Stay Cozy and Stress-Free This Winter with Cannabis in White Plains and

Westchester – Leafology Dispensary White plains | Dispensary near me"

140. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/

Rule: tier2.meta.no-og

https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/
https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/
https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/
https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/
https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/


Detail

Page missing og:title and/or og:image.

141. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

142. Title length 106 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/winter-inspired-edibles/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis-Infused Comfort: Winter-Inspired Edibles – Leafology Dispensary

White plains | Dispensary near me"

143. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/winter-inspired-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

144. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/winter-inspired-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

145. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/winter-inspired-edibles/

Rule: tier2.a11y.img-missing-alt

https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-cannabis/
https://leafologycannabiscompany.com/blog/winter-inspired-edibles/
https://leafologycannabiscompany.com/blog/winter-inspired-edibles/
https://leafologycannabiscompany.com/blog/winter-inspired-edibles/
https://leafologycannabiscompany.com/blog/winter-inspired-edibles/


Detail

Images without alt fail a11y + hurt SEO.

146. Title length 144 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-strains-winter-nights/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Stay Cozy with Cannabis: Best Strains for Winter Nights in White Plains and

Westchester – Leafology Dispensary White plains | Dispensary near me"

147. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-strains-winter-nights/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

148. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-strains-winter-nights/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

149. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/best-strains-winter-nights/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

150. Title length 104 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/

Rule: tier2.meta.title-length

https://leafologycannabiscompany.com/blog/best-strains-winter-nights/
https://leafologycannabiscompany.com/blog/best-strains-winter-nights/
https://leafologycannabiscompany.com/blog/best-strains-winter-nights/
https://leafologycannabiscompany.com/blog/best-strains-winter-nights/
https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/


Detail

Title should be 20-65 chars. Got: "Celebrate the Holidays with Cannabis: Pre-Rolls – Leafology Dispensary

White plains | Dispensary near me"

151. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

152. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

153. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

154. Title length 117 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-

hydrated-skin/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Winter Skin Care: Cannabis for Pain Relief and Hydrated Skin – Leafology

Dispensary White plains | Dispensary near me"

155. Missing OpenGraph metadata

Severity: P3

https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/
https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/
https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/
https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/


Page URL: https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-

hydrated-skin/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

156. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-

hydrated-skin/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

157. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-

hydrated-skin/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

158. Title length 113 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-

your-goals/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "New Year’s Resolutions: How Cannabis Supports Your Goals – Leafology

Dispensary White plains | Dispensary near me"

159. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-

your-goals/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
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160. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-

your-goals/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

161. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-

your-goals/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

162. Title length 107 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-

february/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High Garden Carts Worth Checking Out This February – Leafology

Dispensary White plains | Dispensary near me"

163. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-

february/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

164. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-

february/

https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-your-goals/
https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-your-goals/
https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-your-goals/
https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-your-goals/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
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https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/


Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

165. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-

february/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

166. Title length 132 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-

heres-what-actually-matters/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Looking for a Weed Dispensary in White Plains? Here’s What Actually Matters

– Leafology Dispensary White plains | Dispensary near me"

167. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-

heres-what-actually-matters/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

168. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-

heres-what-actually-matters/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
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169. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-

heres-what-actually-matters/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

170. Title length 114 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-

enjoyment/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Top Pre Roll Picks for Simple, No-Prep Cannabis Enjoyment – Leafology

Dispensary White plains | Dispensary near me"

171. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-

enjoyment/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

172. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-

enjoyment/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

173. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-

enjoyment/

https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-heres-what-actually-matters/
https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-heres-what-actually-matters/
https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-enjoyment/
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Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

174. Title length 97 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Exploring THC Tinctures for Everyday Use – Leafology Dispensary White

plains | Dispensary near me"

175. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

176. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

177. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

178. Title length 118 chars

Severity: P3

https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/
https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/
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Page URL: https://leafologycannabiscompany.com/blog/sweet-treats-for-your-valentine-cone-edibles-

worth-exploring/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Sweet Treats for Your Valentine: Cone Edibles Worth Exploring – Leafology

Dispensary White plains | Dispensary near me"

179. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/sweet-treats-for-your-valentine-cone-edibles-

worth-exploring/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

180. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/sweet-treats-for-your-valentine-cone-edibles-

worth-exploring/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

181. Title length 117 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-

plains-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "MFNY Favorites and More at a Trusted White Plains Dispensary – Leafology

Dispensary White plains | Dispensary near me"

182. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-

plains-dispensary/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/blog/sweet-treats-for-your-valentine-cone-edibles-worth-exploring/
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Page missing og:title and/or og:image.

183. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-

plains-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

184. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-

plains-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

185. Title length 146 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-

resin-picks-at-a-white-plains-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Why Vape Pens Are a Go-To Option, Including Live Resin Picks at a White

Plains Dispensary – Leafology Dispensary White plains | Dispensary near me"

186. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-

resin-picks-at-a-white-plains-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

187. Missing Twitter card

Severity: P3
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Page URL: https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-

resin-picks-at-a-white-plains-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

188. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-

resin-picks-at-a-white-plains-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

189. Title length 120 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-

plains-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Why the Nanticoke Brand Stands Out at a White Plains Dispensary –

Leafology Dispensary White plains | Dispensary near me"

190. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-

plains-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

191. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-

plains-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-resin-picks-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-resin-picks-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-resin-picks-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-resin-picks-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-stands-out-at-a-white-plains-dispensary/


192. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

193. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

194. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/shop/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

195. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/shop/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

196. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/shop/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/shop/
https://leafologycannabiscompany.com/shop/
https://leafologycannabiscompany.com/shop/


197. Title length 75 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/order-confirmation/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Order Confirmation – Leafology Dispensary White plains | Dispensary near

me"

198. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/order-confirmation/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

199. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/order-confirmation/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

200. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/specials/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

201. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/specials/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/order-confirmation/
https://leafologycannabiscompany.com/order-confirmation/
https://leafologycannabiscompany.com/order-confirmation/
https://leafologycannabiscompany.com/specials/
https://leafologycannabiscompany.com/specials/


202. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/specials/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

203. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

204. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

205. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/about/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

206. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/about/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/specials/
https://leafologycannabiscompany.com/blog/
https://leafologycannabiscompany.com/blog/
https://leafologycannabiscompany.com/about/
https://leafologycannabiscompany.com/about/


207. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/about/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

208. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/contact/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

209. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/contact/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

210. Title length 75 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/terms-conditions/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Terms & Conditions – Leafology Dispensary White plains | Dispensary near

me"

211. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/terms-conditions/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/about/
https://leafologycannabiscompany.com/contact/
https://leafologycannabiscompany.com/contact/
https://leafologycannabiscompany.com/terms-conditions/
https://leafologycannabiscompany.com/terms-conditions/


212. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/terms-conditions/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

213. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/faq/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

214. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/faq/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

215. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

216. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/terms-conditions/
https://leafologycannabiscompany.com/faq/
https://leafologycannabiscompany.com/faq/
https://leafologycannabiscompany.com/visit/
https://leafologycannabiscompany.com/visit/


217. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

218. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/news/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

219. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/news/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

220. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/news/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

221. Title length 80 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/accessibility-statement/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Accessibility Statement – Leafology Dispensary White plains | Dispensary

near me"

https://leafologycannabiscompany.com/visit/
https://leafologycannabiscompany.com/news/
https://leafologycannabiscompany.com/news/
https://leafologycannabiscompany.com/news/
https://leafologycannabiscompany.com/accessibility-statement/


222. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/accessibility-statement/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

223. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/accessibility-statement/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

224. Title length 126 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-

westchester-delivery/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Shop New Weed Brands in White Plains – Leafology Westchester Delivery –

Leafology Dispensary White plains | Dispensary near me"

225. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-

westchester-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

226. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-

westchester-delivery/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/accessibility-statement/
https://leafologycannabiscompany.com/accessibility-statement/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/


No twitter:card meta tag.

227. Title length 76 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/high-roller-club-rewards/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High Roller Rewards – Leafology Dispensary White plains | Dispensary near

me"

228. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/high-roller-club-rewards/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

229. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/high-roller-club-rewards/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

230. Title length 92 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/whiteplainsdiner/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Home White Plains Diner Custom Menu – Leafology Dispensary White plains |

Dispensary near me"

231. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/whiteplainsdiner/

Rule: tier2.meta.no-og

https://leafologycannabiscompany.com/high-roller-club-rewards/
https://leafologycannabiscompany.com/high-roller-club-rewards/
https://leafologycannabiscompany.com/high-roller-club-rewards/
https://leafologycannabiscompany.com/whiteplainsdiner/
https://leafologycannabiscompany.com/whiteplainsdiner/


Detail

Page missing og:title and/or og:image.

232. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/whiteplainsdiner/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

233. Title length 74 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/medical-customers/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Medical Customers – Leafology Dispensary White plains | Dispensary near

me"

234. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/medical-customers/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

235. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/medical-customers/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

236. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/medical-customers/

Rule: tier2.a11y.img-missing-alt

https://leafologycannabiscompany.com/whiteplainsdiner/
https://leafologycannabiscompany.com/medical-customers/
https://leafologycannabiscompany.com/medical-customers/
https://leafologycannabiscompany.com/medical-customers/
https://leafologycannabiscompany.com/medical-customers/


Detail

Images without alt fail a11y + hurt SEO.

237. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

238. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

239. 2 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

240. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/flower/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

241. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/flower/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/delivery/
https://leafologycannabiscompany.com/delivery/
https://leafologycannabiscompany.com/delivery/
https://leafologycannabiscompany.com/flower/
https://leafologycannabiscompany.com/flower/


No twitter:card meta tag.

242. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/flower/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

243. Title length 66 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/pre-rolls/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Pre Rolls – Leafology Dispensary White plains | Dispensary near me"

244. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/pre-rolls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

245. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/pre-rolls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

246. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/pre-rolls/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://leafologycannabiscompany.com/flower/
https://leafologycannabiscompany.com/pre-rolls/
https://leafologycannabiscompany.com/pre-rolls/
https://leafologycannabiscompany.com/pre-rolls/
https://leafologycannabiscompany.com/pre-rolls/


247. Title length 67 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/vaporizers/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Vaporizers – Leafology Dispensary White plains | Dispensary near me"

248. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/vaporizers/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

249. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/vaporizers/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

250. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/vaporizers/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

251. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/vaporizers/
https://leafologycannabiscompany.com/vaporizers/
https://leafologycannabiscompany.com/vaporizers/
https://leafologycannabiscompany.com/vaporizers/
https://leafologycannabiscompany.com/edibles/


252. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

253. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

254. Title length 80 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/the-leafology-guarantee/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Leafology Guarantee – Leafology Dispensary White plains | Dispensary

near me"

255. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/the-leafology-guarantee/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

256. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/the-leafology-guarantee/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/edibles/
https://leafologycannabiscompany.com/edibles/
https://leafologycannabiscompany.com/the-leafology-guarantee/
https://leafologycannabiscompany.com/the-leafology-guarantee/
https://leafologycannabiscompany.com/the-leafology-guarantee/


257. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/home/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

258. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/home/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

259. Title length 87 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Green Wednesday Cannabis Deals – Leafology Dispensary White plains |

Dispensary near me"

260. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

261. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/home/
https://leafologycannabiscompany.com/home/
https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/
https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/
https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/


262. Title length 67 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Darien, CT – Leafology Dispensary White plains | Dispensary near me"

263. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

264. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

265. Title length 72 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dobbs Ferry, NY – Leafology Dispensary White plains | Dispensary near me"

266. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/darien-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/


267. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

268. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Harrison, NY – Leafology Dispensary White plains | Dispensary near me"

269. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

270. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

271. Title length 71 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mamaroneck, NY – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/


272. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

273. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

274. Title length 72 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mount Kisco, NY – Leafology Dispensary White plains | Dispensary near me"

275. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

276. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-dispensary/


277. Title length 73 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mount Vernon, NY – Leafology Dispensary White plains | Dispensary near

me"

278. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

279. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

280. Title length 71 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "New Canaan, CT – Leafology Dispensary White plains | Dispensary near me"

281. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/


282. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

283. Title length 73 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "New Rochelle, NY – Leafology Dispensary White plains | Dispensary near me"

284. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

285. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

286. Title length 68 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Norwalk, CT – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/


287. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

288. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

289. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Ossining, NY – Leafology Dispensary White plains | Dispensary near me"

290. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

291. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/


292. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Peekskill, NY – Leafology Dispensary White plains | Dispensary near me"

293. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

294. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

295. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

296. Title length 73 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Port Chester, NY – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/
https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/
https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/
https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/
https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/


297. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

298. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

299. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rye Brook, NY – Leafology Dispensary White plains | Dispensary near me"

300. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

301. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-dispensary/


302. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Scarsdale, NY – Leafology Dispensary White plains | Dispensary near me"

303. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

304. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

305. Title length 74 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Sleepy Hollow, NY – Leafology Dispensary White plains | Dispensary near

me"

306. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/


307. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

308. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Tarrytown, NY – Leafology Dispensary White plains | Dispensary near me"

309. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

310. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

311. Title length 68 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Yonkers, NY – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/


312. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

313. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

314. Title length 71 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/brass-knuckles/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Brass Knuckles – Leafology Dispensary White plains | Dispensary near me"

315. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/brass-knuckles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

316. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/brass-knuckles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/brand/brass-knuckles/
https://leafologycannabiscompany.com/brand/brass-knuckles/
https://leafologycannabiscompany.com/brand/brass-knuckles/


317. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

318. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

319. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/cone-edibles/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cone Edibles – Leafology Dispensary White plains | Dispensary near me"

320. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/cone-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

321. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/cone-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/brand/
https://leafologycannabiscompany.com/brand/
https://leafologycannabiscompany.com/brand/cone-edibles/
https://leafologycannabiscompany.com/brand/cone-edibles/
https://leafologycannabiscompany.com/brand/cone-edibles/


322. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/dank-gummies/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dank Gummies – Leafology Dispensary White plains | Dispensary near me"

323. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/dank-gummies/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

324. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/dank-gummies/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

325. Title length 68 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/dog-walkers/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dog Walkers – Leafology Dispensary White plains | Dispensary near me"

326. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/dog-walkers/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/brand/dank-gummies/
https://leafologycannabiscompany.com/brand/dank-gummies/
https://leafologycannabiscompany.com/brand/dank-gummies/
https://leafologycannabiscompany.com/brand/dog-walkers/
https://leafologycannabiscompany.com/brand/dog-walkers/


327. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/dog-walkers/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

328. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/eureka-vapes/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Eureka Vapes – Leafology Dispensary White plains | Dispensary near me"

329. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/eureka-vapes/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

330. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/eureka-vapes/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

331. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/holiday-vapes/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Holiday Vapes – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/brand/dog-walkers/
https://leafologycannabiscompany.com/brand/eureka-vapes/
https://leafologycannabiscompany.com/brand/eureka-vapes/
https://leafologycannabiscompany.com/brand/eureka-vapes/
https://leafologycannabiscompany.com/brand/holiday-vapes/


332. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/holiday-vapes/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

333. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/holiday-vapes/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

334. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/jams-edibles/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jams Edibles – Leafology Dispensary White plains | Dispensary near me"

335. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/jams-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

336. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/jams-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/brand/holiday-vapes/
https://leafologycannabiscompany.com/brand/holiday-vapes/
https://leafologycannabiscompany.com/brand/jams-edibles/
https://leafologycannabiscompany.com/brand/jams-edibles/
https://leafologycannabiscompany.com/brand/jams-edibles/


337. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/lychee-vapes/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Lychee Vapes – Leafology Dispensary White plains | Dispensary near me"

338. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/lychee-vapes/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

339. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/lychee-vapes/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

340. Title length 68 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/moods-vapes/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Moods Vapes – Leafology Dispensary White plains | Dispensary near me"

341. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/moods-vapes/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/brand/lychee-vapes/
https://leafologycannabiscompany.com/brand/lychee-vapes/
https://leafologycannabiscompany.com/brand/lychee-vapes/
https://leafologycannabiscompany.com/brand/moods-vapes/
https://leafologycannabiscompany.com/brand/moods-vapes/


342. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/moods-vapes/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

343. Title length 71 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/rythm-vape-pen/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rythm Vape Pen – Leafology Dispensary White plains | Dispensary near me"

344. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/rythm-vape-pen/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

345. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/rythm-vape-pen/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

346. Title length 75 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/weed-cones-edibles/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Weed Cones Edibles – Leafology Dispensary White plains | Dispensary near

me"

https://leafologycannabiscompany.com/brand/moods-vapes/
https://leafologycannabiscompany.com/brand/rythm-vape-pen/
https://leafologycannabiscompany.com/brand/rythm-vape-pen/
https://leafologycannabiscompany.com/brand/rythm-vape-pen/
https://leafologycannabiscompany.com/brand/weed-cones-edibles/


347. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/weed-cones-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

348. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/brand/weed-cones-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

349. Title length 72 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/promos-events/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Promos / Events – Leafology Dispensary White plains | Dispensary near me"

350. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/promos-events/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

351. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/promos-events/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/brand/weed-cones-edibles/
https://leafologycannabiscompany.com/brand/weed-cones-edibles/
https://leafologycannabiscompany.com/promos-events/
https://leafologycannabiscompany.com/promos-events/
https://leafologycannabiscompany.com/promos-events/


352. Title length 86 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/holidaydeals/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "12 Days of Cannabis Christmas – Leafology Dispensary White plains |

Dispensary near me"

353. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/holidaydeals/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

354. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/holidaydeals/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

355. Title length 83 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "White Plains NY Dispensary – Leafology Dispensary White plains |

Dispensary near me"

356. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/holidaydeals/
https://leafologycannabiscompany.com/holidaydeals/
https://leafologycannabiscompany.com/holidaydeals/
https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/
https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/


357. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

358. 3 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

359. Title length 94 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/dispensary-near/darien-ct/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Darien CT Cannabis Dispensary Near Me – Leafology Dispensary White

plains | Dispensary near me"

360. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/dispensary-near/darien-ct/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

361. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/dispensary-near/darien-ct/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/
https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/
https://leafologycannabiscompany.com/dispensary-near/darien-ct/
https://leafologycannabiscompany.com/dispensary-near/darien-ct/
https://leafologycannabiscompany.com/dispensary-near/darien-ct/


362. Title length 107 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dobbs Ferry Cannabis Delivery & Dispensary Service – Leafology Dispensary

White plains | Dispensary near me"

363. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

364. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

365. Title length 105 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/harrison-ny/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Harrison Cannabis Delivery & Dispensary Services – Leafology Dispensary

White plains | Dispensary near me"

366. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/harrison-ny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/
https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/
https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/
https://leafologycannabiscompany.com/weed-delivery/harrison-ny/
https://leafologycannabiscompany.com/weed-delivery/harrison-ny/


367. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/harrison-ny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

368. Title length 107 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mamaroneck Cannabis Delivery & Dispensary Services – Leafology

Dispensary White plains | Dispensary near me"

369. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

370. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

371. Title length 108 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mount Kisco Cannabis Delivery & Dispensary Services – Leafology

Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/weed-delivery/harrison-ny/
https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/
https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/
https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/
https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/


372. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

373. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

374. Title length 72 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/dispensary-near/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dispensary Near – Leafology Dispensary White plains | Dispensary near me"

375. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/dispensary-near/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

376. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/dispensary-near/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/
https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/
https://leafologycannabiscompany.com/dispensary-near/
https://leafologycannabiscompany.com/dispensary-near/
https://leafologycannabiscompany.com/dispensary-near/


377. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Weed Delivery – Leafology Dispensary White plains | Dispensary near me"

378. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

379. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/weed-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

380. Title length 125 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/edibles-dosing-guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Pro-Tips: Edibles and Gummies (the golden rule: start low – go slow) –

Leafology Dispensary White plains | Dispensary near me"

381. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/edibles-dosing-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/weed-delivery/
https://leafologycannabiscompany.com/weed-delivery/
https://leafologycannabiscompany.com/weed-delivery/
https://leafologycannabiscompany.com/edibles-dosing-guide/
https://leafologycannabiscompany.com/edibles-dosing-guide/


382. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/edibles-dosing-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

383. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/edibles-dosing-guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

384. Title length 111 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/how-to-keep-weed-fresh/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Pro-Tips: Cannabis Flower (how to keep your bud fresh) – Leafology

Dispensary White plains | Dispensary near me"

385. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/how-to-keep-weed-fresh/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

386. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/how-to-keep-weed-fresh/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/edibles-dosing-guide/
https://leafologycannabiscompany.com/edibles-dosing-guide/
https://leafologycannabiscompany.com/how-to-keep-weed-fresh/
https://leafologycannabiscompany.com/how-to-keep-weed-fresh/
https://leafologycannabiscompany.com/how-to-keep-weed-fresh/


387. Title length 149 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Pro-Tips: Cannabis Vapes (how to upkeep your vape pens and how to unclog

vapes / cartridges) – Leafology Dispensary White plains | Dispensary near me"

388. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

389. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

390. Title length 118 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/march-strain-madness-westchester/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "March Strain Madness: Westchester’s Ultimate Cannabis Bracket – Leafology

Dispensary White plains | Dispensary near me"

391. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/march-strain-madness-westchester/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/
https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/
https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/
https://leafologycannabiscompany.com/march-strain-madness-westchester/
https://leafologycannabiscompany.com/march-strain-madness-westchester/


392. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/march-strain-madness-westchester/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

393. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "4/20 Deals in Westchester: World Cup Summer Starts Here – Leafology

Dispensary White plains | Dispensary near me"

394. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

395. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

396. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://leafologycannabiscompany.com/march-strain-madness-westchester/
https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/
https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/
https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/
https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/


397. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "COA Results 1 – Leafology Dispensary White plains | Dispensary near me"

398. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

399. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

400. Title length 70 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "COA Results 2 – Leafology Dispensary White plains | Dispensary near me"

401. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/
https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/


402. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

403. Title length 71 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-1/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Example Pin #1 – Leafology Dispensary White plains | Dispensary near me"

404. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-1/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

405. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-1/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

406. Title length 71 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-2/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Example Pin #2 – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/
https://leafologycannabiscompany.com/blog/pin/example-pin-1/
https://leafologycannabiscompany.com/blog/pin/example-pin-1/
https://leafologycannabiscompany.com/blog/pin/example-pin-1/
https://leafologycannabiscompany.com/blog/pin/example-pin-2/


407. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

408. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

409. Title length 71 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-3/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Example Pin #3 – Leafology Dispensary White plains | Dispensary near me"

410. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-3/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

411. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/pin/example-pin-3/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/blog/pin/example-pin-2/
https://leafologycannabiscompany.com/blog/pin/example-pin-2/
https://leafologycannabiscompany.com/blog/pin/example-pin-3/
https://leafologycannabiscompany.com/blog/pin/example-pin-3/
https://leafologycannabiscompany.com/blog/pin/example-pin-3/


412. Title length 81 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Canna Cafe @ The Cookery – Leafology Dispensary White plains | Dispensary

near me"

413. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

414. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

415. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/calendar/pop-ups/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

416. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/calendar/pop-ups/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/
https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/
https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/
https://leafologycannabiscompany.com/calendar/pop-ups/
https://leafologycannabiscompany.com/calendar/pop-ups/


417. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/calendar/pop-ups/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

418. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/calendar/promos/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

419. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/calendar/promos/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

420. Title length 84 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/location/leafology-ny-white-plains/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Leafology NY – White Plains – Leafology Dispensary White plains |

Dispensary near me"

421. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/location/leafology-ny-white-plains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/calendar/pop-ups/
https://leafologycannabiscompany.com/calendar/promos/
https://leafologycannabiscompany.com/calendar/promos/
https://leafologycannabiscompany.com/location/leafology-ny-white-plains/
https://leafologycannabiscompany.com/location/leafology-ny-white-plains/


422. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/location/leafology-ny-white-plains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

423. Title length 107 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-

6377ef894f37d5000a8ea822/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Papa & Barkley – Topical – Cream – 30ML – 1:1 – DI – Leafology Dispensary

White plains | Dispensary near me"

424. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-

6377ef894f37d5000a8ea822/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

425. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-

6377ef894f37d5000a8ea822/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

426. Title length 110 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-

6377ef634f37d5000a8ea45b/

Rule: tier2.meta.title-length

https://leafologycannabiscompany.com/location/leafology-ny-white-plains/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/papa-barkley-topical-cream-30ml-1-1-di-6377ef894f37d5000a8ea822/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/


Detail

Title should be 20-65 chars. Got: "Empire – Edibles – Tincture – 125mg – Cherry Pie – DI – Leafology

Dispensary White plains | Dispensary near me"

427. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-

6377ef634f37d5000a8ea45b/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

428. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-

6377ef634f37d5000a8ea45b/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

429. Title length 110 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-

6377ef8d4f37d5000a8ea864/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Empire – Edibles – Tincture – 500mg – Cherry Pie – DI – Leafology

Dispensary White plains | Dispensary near me"

430. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-

6377ef8d4f37d5000a8ea864/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

431. Missing Twitter card

https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-

6377ef8d4f37d5000a8ea864/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

432. Title length 128 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-

lemon-glue-di-6377ef8e4f37d5000a8ea87f/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "ABX – Vape Cartridge – Live Resin – 1g – Hybrid – Super Lemon Glue – DI –

Leafology Dispensary White plains | Dispensary near me"

433. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-

lemon-glue-di-6377ef8e4f37d5000a8ea87f/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

434. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-

lemon-glue-di-6377ef8e4f37d5000a8ea87f/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

435. Title length 123 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-

larry-cake-di-6377ef534f37d5000a8e9d6c/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/empire-edibles-tincture-500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/


Title should be 20-65 chars. Got: "Flow Kana – Flower – Farmer’s Res. 3.5g – Hybrid – Larry Cake – DI –

Leafology Dispensary White plains | Dispensary near me"

436. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-

larry-cake-di-6377ef534f37d5000a8e9d6c/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

437. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-

larry-cake-di-6377ef534f37d5000a8e9d6c/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

438. Title length 119 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-

haze-di-6377ef904f37d5000a8ea8c6/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Select – Vape Cartridge – .3g – Sativa – Super Lemon Haze – DI – Leafology

Dispensary White plains | Dispensary near me"

439. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-

haze-di-6377ef904f37d5000a8ea8c6/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

440. Missing Twitter card

https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-

haze-di-6377ef904f37d5000a8ea8c6/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

441. Title length 111 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-

6377efab4f37d5000a8eab37/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "CRU – Prerolls – 3g 6pk – Hybrid – Chocolate Thai – DI – Leafology

Dispensary White plains | Dispensary near me"

442. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-

6377efab4f37d5000a8eab37/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

443. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-

6377efab4f37d5000a8eab37/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

444. Title length 111 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-

6377ef9e4f37d5000a8eaa27/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/


Title should be 20-65 chars. Got: "Gold Flora – Flower – 3.5g – Sativa – Golden Goat – DI – Leafology

Dispensary White plains | Dispensary near me"

445. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-

6377ef9e4f37d5000a8eaa27/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

446. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-

6377ef9e4f37d5000a8eaa27/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

447. Title length 120 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-

cake-di-6377ef9f4f37d5000a8eaa34/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Farmer and the Felon – Flower – 3.5g – Hybrid – Runtz Cake – DI – Leafology

Dispensary White plains | Dispensary near me"

448. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-

cake-di-6377ef9f4f37d5000a8eaa34/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

449. Missing Twitter card

https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-

cake-di-6377ef9f4f37d5000a8eaa34/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

450. Title length 105 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-

6377ef934f37d5000a8ea93a/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Chill – Edibles – 100mg – Cappuccino Crunch – DI – Leafology Dispensary

White plains | Dispensary near me"

451. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-

6377ef934f37d5000a8ea93a/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

452. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-

6377ef934f37d5000a8ea93a/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

453. Title length 119 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-

chocolate-di-6377ef904f37d5000a8ea8d5/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/


Title should be 20-65 chars. Got: "Papa & Barkley – Rosin Chocolate – 100mg – Milk Chocolate – DI – Leafology

Dispensary White plains | Dispensary near me"

454. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-

chocolate-di-6377ef904f37d5000a8ea8d5/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

455. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-

chocolate-di-6377ef904f37d5000a8ea8d5/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

456. Title length 108 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-

6377ef534f37d5000a8e9da4/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Honeydew Farms – Flower – 3.5g – Indica – Cake – DI – Leafology

Dispensary White plains | Dispensary near me"

457. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-

6377ef534f37d5000a8e9da4/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

458. Missing Twitter card

https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-

6377ef534f37d5000a8e9da4/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

459. Title length 115 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-

di-6377ef9a4f37d5000a8ea9b9/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Select – Vape Cartridge – .3g – Indica – Purple Punch – DI – Leafology

Dispensary White plains | Dispensary near me"

460. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-

di-6377ef9a4f37d5000a8ea9b9/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

461. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-

di-6377ef9a4f37d5000a8ea9b9/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

462. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-

6377ef7b4f37d5000a8ea6a6/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/


Title should be 20-65 chars. Got: "Kamatree – Flower – 3.5g – Hybrid – Georgia Pie – DI – Leafology Dispensary

White plains | Dispensary near me"

463. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-

6377ef7b4f37d5000a8ea6a6/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

464. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-

6377ef7b4f37d5000a8ea6a6/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

465. Title length 126 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-

citrus-sunburst-di-6377ef764f37d5000a8ea628/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Forbidden Flowers – Prerolls – 1g 2pk – Hybrid – Citrus Sunburst – DI –

Leafology Dispensary White plains | Dispensary near me"

466. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-

citrus-sunburst-di-6377ef764f37d5000a8ea628/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

467. Missing Twitter card

https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-

citrus-sunburst-di-6377ef764f37d5000a8ea628/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

468. Title length 103 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-

6377ef614f37d5000a8ea393/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Balanced – Flower – 3.5g – Hybrid – Nerdz – DI – Leafology Dispensary

White plains | Dispensary near me"

469. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-

6377ef614f37d5000a8ea393/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

470. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-

6377ef614f37d5000a8ea393/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

471. Title length 118 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-

blend-di-6377ef824f37d5000a8ea736/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/


Title should be 20-65 chars. Got: "Pure Beauty – Prerolls – Babies 3.5g 10pk – Indica Blend – DI – Leafology

Dispensary White plains | Dispensary near me"

472. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-

blend-di-6377ef824f37d5000a8ea736/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

473. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-

blend-di-6377ef824f37d5000a8ea736/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

474. Title length 127 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-

mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Bhang – Edibles – Chocolate – 10mg – Caramel Mocha Milk Chocolate – DI –

Leafology Dispensary White plains | Dispensary near me"

475. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-

mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

476. Missing Twitter card

https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-

mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

477. Title length 105 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-

6377ef834f37d5000a8ea765/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mota – Flower – 3.5g – Hybrid – Trinidad OG – DI – Leafology Dispensary

White plains | Dispensary near me"

478. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-

6377ef834f37d5000a8ea765/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

479. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-

6377ef834f37d5000a8ea765/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

480. Title length 118 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-

pie-di-6377ef794f37d5000a8ea679/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/


Title should be 20-65 chars. Got: "Pure Beauty – Prerolls – 1g – Indica – Mendo x Tahoe Pie – DI – Leafology

Dispensary White plains | Dispensary near me"

481. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-

pie-di-6377ef794f37d5000a8ea679/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

482. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-

pie-di-6377ef794f37d5000a8ea679/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

483. Title length 114 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-

di-6377ef8a4f37d5000a8ea82d/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High Caliber – Flower – 3.5g – Sativa – Cherry Punch – DI – Leafology

Dispensary White plains | Dispensary near me"

484. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-

di-6377ef8a4f37d5000a8ea82d/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

485. Missing Twitter card

https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-

di-6377ef8a4f37d5000a8ea82d/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

486. Title length 113 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-

di-6377ef734f37d5000a8ea5eb/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Bhang – Edibles – Chocolate – 10mg – Dark Chocolate – DI – Leafology

Dispensary White plains | Dispensary near me"

487. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-

di-6377ef734f37d5000a8ea5eb/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

488. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-

di-6377ef734f37d5000a8ea5eb/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

489. Title length 113 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-

di-6377ef584f37d5000a8e9f31/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/


Title should be 20-65 chars. Got: "Bhang – Edibles – Chocolate – 10mg – Milk Chocolate – DI – Leafology

Dispensary White plains | Dispensary near me"

490. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-

di-6377ef584f37d5000a8e9f31/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

491. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-

di-6377ef584f37d5000a8e9f31/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

492. Title length 115 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-

6377ef9a4f37d5000a8ea9c0/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Select – Elite – .5g Live Cartridge – Hybrid – SFV OG – DI – Leafology

Dispensary White plains | Dispensary near me"

493. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-

6377ef9a4f37d5000a8ea9c0/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

494. Missing Twitter card

https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-

6377ef9a4f37d5000a8ea9c0/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

495. Title length 110 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-

6377efb74f37d5000a8eac63/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Balanced – Flower – 3.5g – Hybrid – Banana Split – DI – Leafology

Dispensary White plains | Dispensary near me"

496. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-

6377efb74f37d5000a8eac63/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

497. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-

6377efb74f37d5000a8eac63/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

498. Title length 108 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-

6377efba4f37d5000a8eacb2/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/


Title should be 20-65 chars. Got: "Jet Fuel- Flower – 3.5g – Indica – Jet Fuel OG – DI – Leafology Dispensary

White plains | Dispensary near me"

499. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-

6377efba4f37d5000a8eacb2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

500. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-

6377efba4f37d5000a8eacb2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

501. Title length 116 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-

berry-di-6377efb84f37d5000a8eac7c/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Almora Farm – Preroll – 3.5g 6pk – Hybrid – Sour Berry – DI – Leafology

Dispensary White plains | Dispensary near me"

502. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-

berry-di-6377efb84f37d5000a8eac7c/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

503. Missing Twitter card

https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-

berry-di-6377efb84f37d5000a8eac7c/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

504. Title length 119 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-

orange-di-6377ef704f37d5000a8ea5c1/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Papa & Barkley – Edibles – Gummies – 100mg – Juicy Orange – DI –

Leafology Dispensary White plains | Dispensary near me"

505. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-

orange-di-6377ef704f37d5000a8ea5c1/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

506. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-

orange-di-6377ef704f37d5000a8ea5c1/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

507. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-

di-6377ef8e4f37d5000a8ea88f/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/


Title should be 20-65 chars. Got: "Brio – Edibles – Gummies – 100mg – Apricot Delight – DI – Leafology

Dispensary White plains | Dispensary near me"

508. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-

di-6377ef8e4f37d5000a8ea88f/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

509. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-

di-6377ef8e4f37d5000a8ea88f/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

510. Title length 116 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-

verde-di-6377ef764f37d5000a8ea631/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Legion of Bloom – Flower – 3.5g – Hybrid – Chili Verde – DI – Leafology

Dispensary White plains | Dispensary near me"

511. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-

verde-di-6377ef764f37d5000a8ea631/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

512. Missing Twitter card

https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-

verde-di-6377ef764f37d5000a8ea631/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

513. Title length 117 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-

glue-di-6377ef584f37d5000a8e9f12/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Eighth Brother – Flower – 3.54g – Indica – Gorilla Glue – DI – Leafology

Dispensary White plains | Dispensary near me"

514. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-

glue-di-6377ef584f37d5000a8e9f12/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

515. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-

glue-di-6377ef584f37d5000a8e9f12/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

516. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-

glue-di-6377ef584f37d5000a8e9f12/

Rule: tier2.a11y.img-missing-alt

Detail

https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/


Images without alt fail a11y + hurt SEO.

517. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-

di-6377ef6f4f37d5000a8ea5a8/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Eighth Brother – Flower – 3.54g – Hybrid – OG Kush – DI – Leafology

Dispensary White plains | Dispensary near me"

518. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-

di-6377ef6f4f37d5000a8ea5a8/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

519. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-

di-6377ef6f4f37d5000a8ea5a8/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

520. Title length 122 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-

fruit-rosemary-di-6377ef574f37d5000a8e9eaf/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cann – Edibles – Infused Beverage 6pk – Grape Fruit Rosemary – DI –

Leafology Dispensary White plains | Dispensary near me"

521. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-

fruit-rosemary-di-6377ef574f37d5000a8e9eaf/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

522. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-

fruit-rosemary-di-6377ef574f37d5000a8e9eaf/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

523. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-

6377ef6c4f37d5000a8ea588/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Henry’s – Flower – 3.5g – Hybrid – Key Lime Pie – DI – Leafology Dispensary

White plains | Dispensary near me"

524. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-

6377ef6c4f37d5000a8ea588/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

525. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-

6377ef6c4f37d5000a8ea588/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/


No twitter:card meta tag.

526. Title length 116 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-

choice-di-6377ef824f37d5000a8ea745/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Flow Kana – Flower – Gold 3.5g – Hybrid – Rolls Choice – DI – Leafology

Dispensary White plains | Dispensary near me"

527. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-

choice-di-6377ef824f37d5000a8ea745/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

528. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-

choice-di-6377ef824f37d5000a8ea745/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

529. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-

6377ef854f37d5000a8ea7ad/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Honeydew Farms – Flower – 3.5g – Hybrid – MAC 1 – DI – Leafology

Dispensary White plains | Dispensary near me"

530. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-

6377ef854f37d5000a8ea7ad/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

531. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-

6377ef854f37d5000a8ea7ad/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

532. Title length 120 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-

mints-di-6377efbc4f37d5000a8ead0d/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Farmer and the Felon – Flower – 3.5g – Hybrid – Kush Mints – DI – Leafology

Dispensary White plains | Dispensary near me"

533. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-

mints-di-6377efbc4f37d5000a8ead0d/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

534. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-

mints-di-6377efbc4f37d5000a8ead0d/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/


No twitter:card meta tag.

535. Title length 118 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-

creamsicle-di-6377efa94f37d5000a8eab0d/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High Garden – Flower – 3.5g – Hybrid – Orange Creamsicle – DI – Leafology

Dispensary White plains | Dispensary near me"

536. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-

creamsicle-di-6377efa94f37d5000a8eab0d/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

537. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-

creamsicle-di-6377efa94f37d5000a8eab0d/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

538. Title length 107 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-

6377ef5d4f37d5000a8ea18f/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Fire Cut – Flower – 3.5g – Indica – Cake Boss – DI – Leafology Dispensary

White plains | Dispensary near me"

539. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-

6377ef5d4f37d5000a8ea18f/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

540. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-

6377ef5d4f37d5000a8ea18f/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

541. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-

6377efb54f37d5000a8eac24/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cali Lotus – Flower – 3.5g – Hybrid – Cali Cake – DI – Leafology Dispensary

White plains | Dispensary near me"

542. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-

6377efb54f37d5000a8eac24/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

543. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-

6377efb54f37d5000a8eac24/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/


No twitter:card meta tag.

544. Title length 123 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-

cherry-charm-di-6377efbb4f37d5000a8eace1/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Forbidden Flowers – Prerolls – 1g 2pk – Sativa – Cherry Charm – DI –

Leafology Dispensary White plains | Dispensary near me"

545. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-

cherry-charm-di-6377efbb4f37d5000a8eace1/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

546. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-

cherry-charm-di-6377efbb4f37d5000a8eace1/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

547. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-

6377ef914f37d5000a8ea8e4/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Honeyleaf – Flower – 3.5g – Sativa – Snickerdoodle – DI – Leafology

Dispensary White plains | Dispensary near me"

548. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-

6377ef914f37d5000a8ea8e4/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

549. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-

6377ef914f37d5000a8ea8e4/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

550. Title length 104 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-

6377ef8d4f37d5000a8ea86c/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Stoney – Infused Preroll – 1g – Strawberry – DI – Leafology Dispensary White

plains | Dispensary near me"

551. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-

6377ef8d4f37d5000a8ea86c/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

552. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-

6377ef8d4f37d5000a8ea86c/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/


No twitter:card meta tag.

553. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-

6377ef8d4f37d5000a8ea86c/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

554. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-

di-6377ef634f37d5000a8ea48d/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Lolo – Flower – 3.5g – Hybrid – London Pound Mintz – DI – Leafology

Dispensary White plains | Dispensary near me"

555. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-

di-6377ef634f37d5000a8ea48d/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

556. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-

di-6377ef634f37d5000a8ea48d/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

557. Title length 118 chars

Severity: P3

https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/


Page URL: https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-

jelly-di-6377efb84f37d5000a8eac81/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Simple Farms – Flower – 3.5g – Hybrid – Strawberry Jelly – DI – Leafology

Dispensary White plains | Dispensary near me"

558. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-

jelly-di-6377efb84f37d5000a8eac81/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

559. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-

jelly-di-6377efb84f37d5000a8eac81/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

560. Title length 121 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-

hitter-di-6377efa84f37d5000a8eab05/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Wrap & Rake – Accessories – Glass – 3″ Chillum (One-Hitter) – DI –

Leafology Dispensary White plains | Dispensary near me"

561. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-

hitter-di-6377efa84f37d5000a8eab05/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/


Page missing og:title and/or og:image.

562. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-

hitter-di-6377efa84f37d5000a8eab05/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

563. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-

6377efa54f37d5000a8eaaba/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Malibu Gold – Flower – 3.5g – Hybrid – 24K Cake – DI – Leafology

Dispensary White plains | Dispensary near me"

564. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-

6377efa54f37d5000a8eaaba/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

565. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-

6377efa54f37d5000a8eaaba/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

566. Title length 141 chars

Severity: P3

https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/


Page URL: https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-

dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jetty – Concentrates – Unrefined Live Resin Dablicator – 1g – Sativa – THC

Bomb – DI – Leafology Dispensary White plains | Dispensary near me"

567. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-

dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

568. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-

dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

569. Title length 102 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-

6377ef534f37d5000a8e9d85/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Nativ – Flower – 3.5g – Sativa – Tropaya – DI – Leafology Dispensary White

plains | Dispensary near me"

570. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-

6377ef534f37d5000a8e9d85/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/


Page missing og:title and/or og:image.

571. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-

6377ef534f37d5000a8e9d85/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

572. Title length 108 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-

6377ef614f37d5000a8ea3f4/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Nativ – Flower – 3.5g – Hybrid – Iced Lemonade – DI – Leafology Dispensary

White plains | Dispensary near me"

573. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-

6377ef614f37d5000a8ea3f4/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

574. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-

6377ef614f37d5000a8ea3f4/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

575. 1 image(s) missing alt text

Severity: P3

https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/


Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-

6377ef614f37d5000a8ea3f4/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

576. Title length 107 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-

6377efbc4f37d5000a8ead06/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Caliva – Flower – 3.5g – Hybrid – Georgia Pie – DI – Leafology Dispensary

White plains | Dispensary near me"

577. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-

6377efbc4f37d5000a8ead06/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

578. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-

6377efbc4f37d5000a8ead06/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

579. Title length 117 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-

souffle-di-6377efab4f37d5000a8eab26/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/


Title should be 20-65 chars. Got: "Caliva – Flower – 3.5g – Hybrid – Peanut Butter Souffle – DI – Leafology

Dispensary White plains | Dispensary near me"

580. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-

souffle-di-6377efab4f37d5000a8eab26/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

581. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-

souffle-di-6377efab4f37d5000a8eab26/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

582. Title length 110 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-

6377ef744f37d5000a8ea60c/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rollers Delight – Flower – 28g – Hybrid – Gelato – DI – Leafology Dispensary

White plains | Dispensary near me"

583. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-

6377ef744f37d5000a8ea60c/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

584. Missing Twitter card

https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-

6377ef744f37d5000a8ea60c/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

585. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-

6377ef614f37d5000a8ea3ae/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rollers Delight – Flower – 7g – Hybrid – Gelato – DI – Leafology Dispensary

White plains | Dispensary near me"

586. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-

6377ef614f37d5000a8ea3ae/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

587. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-

6377ef614f37d5000a8ea3ae/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

588. Title length 136 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-

ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/

Rule: tier2.meta.title-length

Detail

https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/


Title should be 20-65 chars. Got: "Moxie – Concentrates – Live Resin Sauce – 1g – Hybrid – Ice Cream Sherbert

– DI – Leafology Dispensary White plains | Dispensary near me"

589. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-

ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

590. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-

ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

591. Title length 114 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-

6377efac4f37d5000a8eab40/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rollers Delight – Flower – 14g – Indica – PB Souffle – DI – Leafology

Dispensary White plains | Dispensary near me"

592. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-

6377efac4f37d5000a8eab40/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

593. Missing Twitter card

https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-

6377efac4f37d5000a8eab40/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

594. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-

6377ef7c4f37d5000a8ea6b8/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "THC Living – Topical – Roll-on – 3 oz – Freeze 1:1 – DI – Leafology

Dispensary White plains | Dispensary near me"

595. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-

6377ef7c4f37d5000a8ea6b8/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

596. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-

6377ef7c4f37d5000a8ea6b8/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

597. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-

6377ef7c4f37d5000a8ea6b8/

Rule: tier2.a11y.img-missing-alt

Detail

https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/


Images without alt fail a11y + hurt SEO.

598. Title length 118 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-

burst-di-6377efb84f37d5000a8eac8d/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Papa & Barkley – Edibles – Gummies – 100mg – Berry Burst – DI – Leafology

Dispensary White plains | Dispensary near me"

599. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-

burst-di-6377efb84f37d5000a8eac8d/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

600. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-

burst-di-6377efb84f37d5000a8eac8d/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

601. Title length 117 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-

apple-di-6377ef764f37d5000a8ea62c/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Papa & Barkley – Edibles – Gummies – 100mg – Tart Apple – DI – Leafology

Dispensary White plains | Dispensary near me"

602. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-

apple-di-6377ef764f37d5000a8ea62c/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

603. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-

apple-di-6377ef764f37d5000a8ea62c/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

604. Title length 105 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-

6377efb54f37d5000a8eac11/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Nativ – Flower – 3.5g – Indica – PB Souffle – DI – Leafology Dispensary

White plains | Dispensary near me"

605. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-

6377efb54f37d5000a8eac11/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

606. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-

6377efb54f37d5000a8eac11/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/


No twitter:card meta tag.

607. Title length 106 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-

6377efa24f37d5000a8eaa58/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Yummi Karma – Tincture – 300mg – Stay Lifted – DI – Leafology Dispensary

White plains | Dispensary near me"

608. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-

6377efa24f37d5000a8eaa58/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

609. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-

6377efa24f37d5000a8eaa58/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

610. Title length 121 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-

yoda-di-6377efb94f37d5000a8eac9f/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jetpacks – Infused Preroll – .5g 6pk – Indica – Master Yoda – DI – Leafology

Dispensary White plains | Dispensary near me"

611. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-

yoda-di-6377efb94f37d5000a8eac9f/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

612. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-

yoda-di-6377efb94f37d5000a8eac9f/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

613. Title length 124 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-

martian-di-6377ef8f4f37d5000a8ea8b0/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jetpacks – Infused Preroll – .5g 6pk – Indica – Purple Martian – DI –

Leafology Dispensary White plains | Dispensary near me"

614. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-

martian-di-6377ef8f4f37d5000a8ea8b0/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

615. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-

martian-di-6377ef8f4f37d5000a8ea8b0/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/


No twitter:card meta tag.

616. Title length 110 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-

6377efb24f37d5000a8eabb4/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mota – Prerolls – 3.5g 10pk – Sativa – Chem Sour – DI – Leafology

Dispensary White plains | Dispensary near me"

617. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-

6377efb24f37d5000a8eabb4/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

618. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-

6377efb24f37d5000a8eabb4/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

619. Title length 113 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-

di-6377efaa4f37d5000a8eab17/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Floracal – Flower – 3.5g – Sativa – Peach Crescendo – DI – Leafology

Dispensary White plains | Dispensary near me"

620. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-

di-6377efaa4f37d5000a8eab17/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

621. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-

di-6377efaa4f37d5000a8eab17/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

622. Title length 113 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-

watermelon-di-6377ef7e4f37d5000a8ea6ea/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Deep Sea Moonrock – Tinctures – 1000mg – Watermelon – DI – Leafology

Dispensary White plains | Dispensary near me"

623. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-

watermelon-di-6377ef7e4f37d5000a8ea6ea/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

624. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-

watermelon-di-6377ef7e4f37d5000a8ea6ea/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/


No twitter:card meta tag.

625. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-

di-6377ef934f37d5000a8ea92c/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Deep Sea Moonrock – Flower – 1g – Vanilla Mango – DI – Leafology

Dispensary White plains | Dispensary near me"

626. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-

di-6377ef934f37d5000a8ea92c/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

627. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-

di-6377ef934f37d5000a8ea92c/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

628. Title length 108 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-

6377ef6b4f37d5000a8ea576/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Big Chief – Vape Cartridge – 1g – Indica – GDP – DI – Leafology Dispensary

White plains | Dispensary near me"

629. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-

6377ef6b4f37d5000a8ea576/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

630. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-

6377ef6b4f37d5000a8ea576/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

631. Title length 104 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-

6377ef724f37d5000a8ea5e3/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Jeeters – Preroll – 1g – Sativa – Honeydew – DI – Leafology Dispensary White

plains | Dispensary near me"

632. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-

6377ef724f37d5000a8ea5e3/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

633. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-

6377ef724f37d5000a8ea5e3/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/


No twitter:card meta tag.

634. Title length 128 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-

indica-granimals-di-6377ef634f37d5000a8ea47d/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Roller’s Delight – Preroll – 3.5g 7pk Lucky 7 – Indica – Granimals – DI –

Leafology Dispensary White plains | Dispensary near me"

635. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-

indica-granimals-di-6377ef634f37d5000a8ea47d/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

636. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-

indica-granimals-di-6377ef634f37d5000a8ea47d/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

637. Title length 144 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-

hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Legion of Bloom – Vape Cartridge – Live Resin – 1g – Hybrid – Peanut Butter

Breath – DI – Leafology Dispensary White plains | Dispensary near me"

638. Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/


Severity: P3

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-

hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

639. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-

hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

640. Title length 106 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-

6377ef684f37d5000a8ea557/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "1Lyfe – Preroll – 1g – Hybrid – Indian Spice – DI – Leafology Dispensary

White plains | Dispensary near me"

641. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-

6377ef684f37d5000a8ea557/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

642. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-

6377ef684f37d5000a8ea557/

Rule: tier2.meta.no-twitter-card

Detail

https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/


No twitter:card meta tag.

643. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-

6377ef684f37d5000a8ea557/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

644. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-

6377ef714f37d5000a8ea5db/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "STIIIZY – Vape Cartridge – 1g – Gelato – Hybrid – DI – Leafology Dispensary

White plains | Dispensary near me"

645. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-

6377ef714f37d5000a8ea5db/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

646. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-

6377ef714f37d5000a8ea5db/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

647. Title length 120 chars

Severity: P3

https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/


Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-

punch-di-6377ef874f37d5000a8ea7f1/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rove – Concentrate – Diamonds – 1g – Hybrid – Cherry Punch – DI –

Leafology Dispensary White plains | Dispensary near me"

648. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-

punch-di-6377ef874f37d5000a8ea7f1/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

649. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-

punch-di-6377ef874f37d5000a8ea7f1/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

650. Title length 114 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-

di-6377ef8d4f37d5000a8ea874/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Left Coast – Vape Pod – 1g – Indica- Northern Lights – DI – Leafology

Dispensary White plains | Dispensary near me"

651. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-

di-6377ef8d4f37d5000a8ea874/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/


Page missing og:title and/or og:image.

652. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-

di-6377ef8d4f37d5000a8ea874/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

653. Title length 110 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-

6377efb44f37d5000a8eac08/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Left Coast – Vape Pod – 1g – Sativa – Lemon Haze – DI – Leafology

Dispensary White plains | Dispensary near me"

654. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-

6377efb44f37d5000a8eac08/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

655. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-

6377efb44f37d5000a8eac08/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

656. Title length 110 chars

Severity: P3

https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/


Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-

6377ef7b4f37d5000a8ea6ae/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Wonderbrett – Flower – 3.5g – Hybrid – Lemon OZK – DI – Leafology

Dispensary White plains | Dispensary near me"

657. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-

6377ef7b4f37d5000a8ea6ae/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

658. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-

6377ef7b4f37d5000a8ea6ae/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

659. Title length 133 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-

passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Kanha – Edibles – Nano Gummies – 100mg – Indica – Passionfruit Paradise –

DI – Leafology Dispensary White plains | Dispensary near me"

660. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-

passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/


Page missing og:title and/or og:image.

661. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-

passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

662. Title length 115 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-

mimosa-di-6377efae4f37d5000a8eab68/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Kurvana – ASCND Vape Cartridge – 1g – Hybrid – Mimosa – DI – Leafology

Dispensary White plains | Dispensary near me"

663. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-

mimosa-di-6377efae4f37d5000a8eab68/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

664. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-

mimosa-di-6377efae4f37d5000a8eab68/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

665. Title length 113 chars

Severity: P3

https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/


Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-

di-6377ef944f37d5000a8ea95a/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Fun Uncle – Flower – 3.5g – Hybrid – OG Berry Blast – DI – Leafology

Dispensary White plains | Dispensary near me"

666. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-

di-6377ef944f37d5000a8ea95a/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

667. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-

di-6377ef944f37d5000a8ea95a/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

668. Title length 112 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-

6377ef634f37d5000a8ea497/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Fun Uncle – Flower – 3.5g – Indica – Bouquet Blitz – DI – Leafology

Dispensary White plains | Dispensary near me"

669. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-

6377ef634f37d5000a8ea497/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/


Page missing og:title and/or og:image.

670. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-

6377ef634f37d5000a8ea497/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

671. Title length 121 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-

cruise-232-di-6377efb04f37d5000a8eab95/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Canndescent – Preroll – 3g 6pk – Indica-Hybrid – Cruise 232 – DI –

Leafology Dispensary White plains | Dispensary near me"

672. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-

cruise-232-di-6377efb04f37d5000a8eab95/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

673. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-

cruise-232-di-6377efb04f37d5000a8eab95/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

674. Title length 126 chars

Severity: P3

https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/


Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-

1-x-do-lato-di-6377efb74f37d5000a8eac73/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Punch Rocket – Infused Preroll – 1.6g – Hybrid – Mac 1 X Do Lato – DI –

Leafology Dispensary White plains | Dispensary near me"

675. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-

1-x-do-lato-di-6377efb74f37d5000a8eac73/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

676. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-

1-x-do-lato-di-6377efb74f37d5000a8eac73/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

677. Title length 135 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-

herer-x-strawpicana-di-6377ef784f37d5000a8ea669/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Punch Rocket – Infused Preroll – 1.6g – Hybrid – Jack Herer X Strawpicana –

DI – Leafology Dispensary White plains | Dispensary near me"

678. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-

herer-x-strawpicana-di-6377ef784f37d5000a8ea669/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/


Page missing og:title and/or og:image.

679. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-

herer-x-strawpicana-di-6377ef784f37d5000a8ea669/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

680. Title length 126 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-

chocolate-chip-di-6377ef6a4f37d5000a8ea570/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dr. Norms – Edible – 10mg 10pk Cookies – Vegan PB Chocolate Chip – DI –

Leafology Dispensary White plains | Dispensary near me"

681. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-

chocolate-chip-di-6377ef6a4f37d5000a8ea570/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

682. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-

chocolate-chip-di-6377ef6a4f37d5000a8ea570/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

683. Title length 108 chars

Severity: P3

https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/


Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-

di-6377ef924f37d5000a8ea91f/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Yummi Karma – Tincture – 1000mg – Wicked Apple – DI – Leafology

Dispensary White plains | Dispensary near me"

684. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-

di-6377ef924f37d5000a8ea91f/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

685. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-

di-6377ef924f37d5000a8ea91f/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

686. Title length 115 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-

gelato-di-6377ef5a4f37d5000a8ea00f/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rove – Concentrate – Diamonds – Hybrid – Mango Gelato – DI – Leafology

Dispensary White plains | Dispensary near me"

687. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-

gelato-di-6377ef5a4f37d5000a8ea00f/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/


Page missing og:title and/or og:image.

688. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-

gelato-di-6377ef5a4f37d5000a8ea00f/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

689. Title length 114 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-

di-6377efa04f37d5000a8eaa41/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Malibu Gold – Flower – 3.5g – Sativa – Platinum Jack – DI – Leafology

Dispensary White plains | Dispensary near me"

690. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-

di-6377efa04f37d5000a8eaa41/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

691. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-

di-6377efa04f37d5000a8eaa41/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

692. Title length 105 chars

Severity: P3

https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/


Page URL: https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-

6377ef834f37d5000a8ea75d/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Kurvana – Accessories – Battery – Dove Grey – DI – Leafology Dispensary

White plains | Dispensary near me"

693. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-

6377ef834f37d5000a8ea75d/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

694. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-

6377ef834f37d5000a8ea75d/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

695. Title length 113 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-

di-6377ef684f37d5000a8ea54e/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Wonderbrett – Flower – 3.5g – Hybrid – Pink Picasso – DI – Leafology

Dispensary White plains | Dispensary near me"

696. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-

di-6377ef684f37d5000a8ea54e/

Rule: tier2.meta.no-og

Detail

https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/


Page missing og:title and/or og:image.

697. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-

di-6377ef684f37d5000a8ea54e/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

698. Title length 109 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-

6377ef704f37d5000a8ea5b5/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Gold Flora – Flower – 3.5g – Indica – Kush Cake – DI – Leafology Dispensary

White plains | Dispensary near me"

699. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-

6377ef704f37d5000a8ea5b5/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

700. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-

6377ef704f37d5000a8ea5b5/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

701. Title length 107 chars

Severity: P3

https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/


Page URL: https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-

6377ef664f37d5000a8ea52e/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Mota – Concentrates – 1g – Hybrid – Papaya OG – DI – Leafology Dispensary

White plains | Dispensary near me"

702. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-

6377ef664f37d5000a8ea52e/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

703. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-

6377ef664f37d5000a8ea52e/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

704. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pax-era/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

705. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pax-era/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/pax-era/
https://leafologycannabiscompany.com/product/pax-era/


706. Title length 97 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Raspberry Sativa Enhanced Gummies | 50mg – Leafology Dispensary White

plains | Dispensary near me"

707. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

708. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

709. Title length 89 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/ginger-beer-50mg/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Ginger Beer w/ Live Resin | 50mg – Leafology Dispensary White plains |

Dispensary near me"

710. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/ginger-beer-50mg/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/
https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/
https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/
https://leafologycannabiscompany.com/product/ginger-beer-50mg/
https://leafologycannabiscompany.com/product/ginger-beer-50mg/


711. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/ginger-beer-50mg/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

712. Title length 79 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/raspberry-truffle-bite/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Raspberry Truffle Bite – Leafology Dispensary White plains | Dispensary near

me"

713. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/raspberry-truffle-bite/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

714. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/raspberry-truffle-bite/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

715. Title length 72 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pineapple-skunk/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Pineapple Skunk – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/product/ginger-beer-50mg/
https://leafologycannabiscompany.com/product/raspberry-truffle-bite/
https://leafologycannabiscompany.com/product/raspberry-truffle-bite/
https://leafologycannabiscompany.com/product/raspberry-truffle-bite/
https://leafologycannabiscompany.com/product/pineapple-skunk/


716. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pineapple-skunk/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

717. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/pineapple-skunk/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

718. Title length 94 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cream Soda Indica Magic Drops | 150mg – Leafology Dispensary White

plains | Dispensary near me"

719. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

720. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/product/pineapple-skunk/
https://leafologycannabiscompany.com/product/pineapple-skunk/
https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/
https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/
https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/


721. Title length 67 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/grapefruit/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Grapefruit – Leafology Dispensary White plains | Dispensary near me"

722. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/grapefruit/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

723. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/grapefruit/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

724. Title length 87 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Northern Lights Cartridge | 1g – Leafology Dispensary White plains |

Dispensary near me"

725. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/product/grapefruit/
https://leafologycannabiscompany.com/product/grapefruit/
https://leafologycannabiscompany.com/product/grapefruit/
https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/
https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/


726. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

727. Title length 78 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Hypnos Tincture | 1oz – Leafology Dispensary White plains | Dispensary near

me"

728. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

729. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

730. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/banana-bread/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Banana Bread – Leafology Dispensary White plains | Dispensary near me"

https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/
https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/
https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/
https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/
https://leafologycannabiscompany.com/product/banana-bread/


731. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/banana-bread/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

732. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/banana-bread/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

733. Title length 67 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/uranium-v2/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Uranium V2 – Leafology Dispensary White plains | Dispensary near me"

734. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/uranium-v2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

735. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/uranium-v2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/product/banana-bread/
https://leafologycannabiscompany.com/product/banana-bread/
https://leafologycannabiscompany.com/product/uranium-v2/
https://leafologycannabiscompany.com/product/uranium-v2/
https://leafologycannabiscompany.com/product/uranium-v2/


736. Title length 84 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Dark Chocolate Spark | 10mg – Leafology Dispensary White plains |

Dispensary near me"

737. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

738. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

739. Title length 69 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/sirius-black/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Sirius Black – Leafology Dispensary White plains | Dispensary near me"

740. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/sirius-black/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/
https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/
https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/
https://leafologycannabiscompany.com/product/sirius-black/
https://leafologycannabiscompany.com/product/sirius-black/


741. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/sirius-black/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

742. Title length 76 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/g-13-cartridge-1g/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "G-13 Cartridge | 1g – Leafology Dispensary White plains | Dispensary near

me"

743. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/g-13-cartridge-1g/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

744. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/g-13-cartridge-1g/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

745. Title length 92 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "North American Elite Cartridge | 1g – Leafology Dispensary White plains |

Dispensary near me"

https://leafologycannabiscompany.com/product/sirius-black/
https://leafologycannabiscompany.com/product/g-13-cartridge-1g/
https://leafologycannabiscompany.com/product/g-13-cartridge-1g/
https://leafologycannabiscompany.com/product/g-13-cartridge-1g/
https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/


746. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

747. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

748. Title length 73 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/brownie-truffles/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Brownie Truffles – Leafology Dispensary White plains | Dispensary near me"

749. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/brownie-truffles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

750. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/brownie-truffles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/
https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/
https://leafologycannabiscompany.com/product/brownie-truffles/
https://leafologycannabiscompany.com/product/brownie-truffles/
https://leafologycannabiscompany.com/product/brownie-truffles/


751. Title length 91 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Almond Truffle Bites 5-pack | 50mg – Leafology Dispensary White plains |

Dispensary near me"

752. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

753. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

754. Title length 67 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/trainwreck/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Trainwreck – Leafology Dispensary White plains | Dispensary near me"

755. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/trainwreck/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/
https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/
https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/
https://leafologycannabiscompany.com/product/trainwreck/
https://leafologycannabiscompany.com/product/trainwreck/


756. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/trainwreck/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

757. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dog-park/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

758. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dog-park/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

759. 1 image(s) missing alt text

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/dog-park/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

760. Title length 88 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Lunchbox Alchemy | Cherry Squib – Leafology Dispensary White plains |

Dispensary near me"

https://leafologycannabiscompany.com/product/trainwreck/
https://leafologycannabiscompany.com/product/dog-park/
https://leafologycannabiscompany.com/product/dog-park/
https://leafologycannabiscompany.com/product/dog-park/
https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/


761. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

762. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

763. Title length 81 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/indica-transdermal-patch/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Indica Transdermal Patch – Leafology Dispensary White plains | Dispensary

near me"

764. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/indica-transdermal-patch/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

765. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/indica-transdermal-patch/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/
https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/
https://leafologycannabiscompany.com/product/indica-transdermal-patch/
https://leafologycannabiscompany.com/product/indica-transdermal-patch/
https://leafologycannabiscompany.com/product/indica-transdermal-patch/


766. Title length 84 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Grape Gatsby PAX Pod | 0.5g – Leafology Dispensary White plains |

Dispensary near me"

767. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

768. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

769. Title length 77 chars

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "GSC Cured Resin | 1g – Leafology Dispensary White plains | Dispensary near

me"

770. Missing OpenGraph metadata

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/
https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/
https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/
https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/
https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/


771. Missing Twitter card

Severity: P3

Page URL: https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

772. Heavy JS payload (mobile): 810KB

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier3.weight.js-mobile

Detail

JavaScript transfer exceeds 250KB budget.

773. Heavy page weight (mobile): 3534KB

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier3.weight.total-mobile

Detail

Total transfer exceeds 2500KB budget.

774. Heavy JS payload (desktop): 811KB

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier3.weight.js-desktop

Detail

JavaScript transfer exceeds 250KB budget.

775. Heavy page weight (desktop): 6338KB

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier3.weight.total-desktop

Detail

Total transfer exceeds 2500KB budget.

https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/


776. Missing security header: x-content-type-options

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.header.x-content-type-options

Detail

x-content-type-options not present on homepage response. Affects fortress score and CSP posture.

777. Missing security header: referrer-policy

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.header.referrer-policy

Detail

referrer-policy not present on homepage response. Affects fortress score and CSP posture.

778. Missing security header: permissions-policy

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.header.permissions-policy

Detail

permissions-policy not present on homepage response. Affects fortress score and CSP posture.

779. package.json publicly accessible

Severity: P3

Page URL: https://leafologycannabiscompany.com/package.json

Rule: tier5.exposed.package-json

Detail

package.json is served publicly; reveals dependency versions for attackers.

780. SSL Labs grade: unknown

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.fortress.ssl-grade

Detail

Qualys SSL Labs: SSL Labs HTTP 400. Aim for A+ via strong TLS 1.3, HSTS, CAA, and preload.

https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/package.json
https://leafologycannabiscompany.com/


781. DNSSEC not enabled

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.fortress.dnssec-missing

Detail

DNSSEC adds cryptographic verification to DNS responses. Consider enabling via your registrar.

782. No CAA DNS records

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.fortress.caa-missing

Detail

CAA records restrict which CAs may issue certs for your domain, preventing rogue issuance. Add CAA for

letsencrypt.org / digicert.com / etc.

783. DMARC policy is p=none (monitoring only)

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier5.fortress.dmarc-weak

Detail

DMARC published at p=none — monitoring mode only. After 2-4 weeks of clean reports, tighten to p=quarantine

→ p=reject.

784. Lighthouse mobile audit failed to run

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lighthouse.mobile-failed

Detail

The "start lh:driver:navigate" performance mark has not been set

785. Lighthouse perf (desktop): 87/100

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lighthouse.perf-desktop

Detail

Score 87 is below target 90. See HTML report for details.

https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/


786. Lighthouse a11y (desktop): 91/100

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lighthouse.a11y-desktop

Detail

Score 91 is below target 95. See HTML report for details.

787. Lighthouse seo (desktop): 85/100

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lighthouse.seo-desktop

Detail

Score 85 is below target 95. See HTML report for details.

788. LH desktop: Preload Largest Contentful Paint image

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lh-opportunity.prioritize-lcp-image-desktop

Detail

If the LCP element is dynamically added to the page, you should preload the image in order to improve LCP.

https://web.dev/articles/optimize-lcp#optimize_when_the_resource_is_discovered" target="_blank"

rel="noreferrer">Learn more about preloading LCP elements.

789. LH desktop: Eliminate render-blocking resources (Est savings of

10 ms)

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lh-opportunity.render-blocking-resources-desktop

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

790. LH desktop: Minify JavaScript (Est savings of 34 KiB)

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lh-opportunity.unminified-javascript-desktop

https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
https://leafologycannabiscompany.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Leafology%20Cannabis%20Co%20WP/%3Ca%20href=
https://leafologycannabiscompany.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Leafology%20Cannabis%20Co%20WP/%3Ca%20href=
https://leafologycannabiscompany.com/


Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

791. LH desktop: Reduce unused CSS (Est savings of 89 KiB)

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lh-opportunity.unused-css-rules-desktop

Detail

Reduce unused rules from stylesheets and defer CSS not used for above-the-fold content to decrease bytes

consumed by network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-css-rules/"

target="_blank" rel="noreferrer">Learn how to reduce unused CSS.

792. LH desktop: Reduce unused JavaScript (Est savings of 665 KiB)

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier8.lh-opportunity.unused-javascript-desktop

Detail

Reduce unused JavaScript and defer loading scripts until they are required to decrease bytes consumed by

network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-javascript/"

target="_blank" rel="noreferrer">Learn how to reduce unused JavaScript.

793. A11y: ARIA role should be appropriate for the element (×15)

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier9.a11y.aria-allowed-role

Detail

Ensure role attribute has an appropriate value for the element

Impact: minor

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/aria-allowed-role?application=playwright

794. Dutchie menu iframe not found on /, /menu, or /shop

Severity: P3

Page URL: https://leafologycannabiscompany.com/

Rule: tier-revenue.dutchie.iframe-absent

Detail

file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Leafology%20Cannabis%20Co%20WP/%3Ca%20href=
https://leafologycannabiscompany.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Leafology%20Cannabis%20Co%20WP/%3Ca%20href=
https://leafologycannabiscompany.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Leafology%20Cannabis%20Co%20WP/%3Ca%20href=
https://leafologycannabiscompany.com/
https://dequeuniversity.com/rules/axe/4.11/aria-allowed-role?application=playwright
https://leafologycannabiscompany.com/


No Dutchie iframe detected. If this client uses a different menu provider, add it to clients.yaml dutchieSlug=null

+ we'll stop flagging.

Findings by Page

Grouped by URL — useful when working through the site one page at a time.

https://leafologycannabiscompany.com/

_38 findings on this page_

[P1] Slow LCP (mobile): 6652ms 🔴  DO FIRST

Your homepage takes 6.6 seconds to display its largest visual element (usually a hero image or banner) on

mobile devices. Google and users consider anything over 2.5 seconds slow. This delay happens b

[P1] Lighthouse bestPractices (desktop): 56/100 🟠  HIGH

Your site's Lighthouse Best Practices score is 56 out of 100, which is significantly below the healthy target of

90. This score reflects issues with how your site handles security, third-party code, b

[P1] A11y: Elements must meet minimum color contrast ratio thresholds (×36) 🔴  DO FIRST

Your website has 36 places where text and background colors don't have enough contrast — meaning visitors

with low vision or color blindness can't easily read buttons, links, and menu items. The most

[P1] A11y: All touch targets must be 24px large, or leave sufficient space (×5) 🔴  DO FIRST

Your navigation menu has five small dropdown buttons (the tiny arrows that expand submenus) that are only

19×8 pixels. Accessibility standards require all clickable elements to be at least 24×24 pixel

[P2] Missing meta description

[P2] Missing security header: strict-transport-security

[P2] Missing security header: x-frame-options

[P2] Missing security header: content-security-policy

[P2] 428 tap targets under 44px at mobile-320

[P2] 452 tap targets under 44px at mobile-375

[P2] 455 tap targets under 44px at mobile-414

[P2] 459 tap targets under 44px at tablet-768

[P2] A11y: Heading levels should only increase by one

[P2] A11y: All page content should be contained by landmarks (×6)

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] Heavy JS payload (mobile): 810KB

[P3] Heavy page weight (mobile): 3534KB

[P3] Heavy JS payload (desktop): 811KB

[P3] Heavy page weight (desktop): 6338KB

[P3] Missing security header: x-content-type-options

[P3] Missing security header: referrer-policy

https://leafologycannabiscompany.com/


[P3] Missing security header: permissions-policy

[P3] SSL Labs grade: unknown

[P3] DNSSEC not enabled

[P3] No CAA DNS records

[P3] DMARC policy is p=none (monitoring only)

[P3] Lighthouse mobile audit failed to run

[P3] Lighthouse perf (desktop): 87/100

[P3] Lighthouse a11y (desktop): 91/100

[P3] Lighthouse seo (desktop): 85/100

[P3] LH desktop: Preload Largest Contentful Paint image

[P3] LH desktop: Eliminate render-blocking resources (Est savings of 10 ms)

[P3] LH desktop: Minify JavaScript (Est savings of 34 KiB)

[P3] LH desktop: Reduce unused CSS (Est savings of 89 KiB)

[P3] LH desktop: Reduce unused JavaScript (Est savings of 665 KiB)

[P3] A11y: ARIA role should be appropriate for the element (×15)

[P3] Dutchie menu iframe not found on /, /menu, or /shop

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-

indulge-your-senses-exploring-the-flavorful-world-of-cannabis-edibles-

in-white-plains-westchester/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about cannabis edibles in White Plains is missing a meta description — the 150-160 character

summary that appears below the page title in Google search results. Without it, Google may a

[P2] No JSON-LD schema 🟠  HIGH

Your blog post isn't labeled with machine-readable metadata (JSON-LD) that search engines use to understand

what the page is about. This is like publishing a book without a title or table of contents

[P3] Title length 127 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 2 image(s) missing alt text

https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about Watermelon Diesel strain doesn't include JSON-LD structured data — machine-readable

code that tells Google what the page is about (in this case, a blog post about a cannabis strai

[P3] Title length 132 chars

[P3] Missing OpenGraph metadata

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/
https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/
https://leafologycannabiscompany.com/blog/no-smoke-no-problem-indulge-your-senses-exploring-the-flavorful-world-of-cannabis-edibles-in-white-plains-westchester/
https://leafologycannabiscompany.com/blog/watermelon-diesel-strain/


[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/westchester-medical-weed-

access/

_6 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post doesn't have a meta description — a 160-character summary that appears below the page title in

Google search results. Without it, Google generates a random snippet from your content, wh

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about medical cannabis access has no structured data markup — that's code that tells Google

what the page is about in a machine-readable format. Without it, search engines have to guess

[P3] Title length 167 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post page is missing a meta description — a 150-160 character summary that appears below the page

title in Google search results. Without it, Google may auto-generate a snippet from your pag

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about the White Plains cannabis mural has no structured data — think of it as metadata that tells

Google what the page is about in a machine-readable format. Without it, search engines

[P3] Title length 182 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/stress-relief-strains/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 136 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/
https://leafologycannabiscompany.com/blog/westchester-medical-weed-access/
https://leafologycannabiscompany.com/blog/white-plains-cannabis-mural/
https://leafologycannabiscompany.com/blog/stress-relief-strains/


https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-

pains/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 138 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/winter-inspired-edibles/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 106 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/best-strains-winter-nights/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 144 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-

cannabis-pre-rolls/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 104 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/
https://leafologycannabiscompany.com/blog/cannabis-for-aches-and-pains/
https://leafologycannabiscompany.com/blog/winter-inspired-edibles/
https://leafologycannabiscompany.com/blog/best-strains-winter-nights/
https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/
https://leafologycannabiscompany.com/blog/celebrate-the-holidays-with-cannabis-pre-rolls/


https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-

for-pain-relief-and-hydrated-skin/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 117 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/new-years-resolutions-how-

cannabis-supports-your-goals/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/high-garden-carts-worth-

checking-out-this-february/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 107 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/looking-for-a-weed-

dispensary-in-white-plains-heres-what-actually-matters/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 132 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
https://leafologycannabiscompany.com/blog/winter-skin-care-cannabis-for-pain-relief-and-hydrated-skin/
https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-your-goals/
https://leafologycannabiscompany.com/blog/new-years-resolutions-how-cannabis-supports-your-goals/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
https://leafologycannabiscompany.com/blog/high-garden-carts-worth-checking-out-this-february/
https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-heres-what-actually-matters/
https://leafologycannabiscompany.com/blog/looking-for-a-weed-dispensary-in-white-plains-heres-what-actually-matters/


[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-

no-prep-cannabis-enjoyment/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 114 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-

everyday-use/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 97 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-

a-trusted-white-plains-dispensary/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 117 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-

option-including-live-resin-picks-at-a-white-plains-dispensary/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 146 chars

https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-enjoyment/
https://leafologycannabiscompany.com/blog/top-pre-roll-picks-for-simple-no-prep-cannabis-enjoyment/
https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/
https://leafologycannabiscompany.com/blog/exploring-thc-tinctures-for-everyday-use/
https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/mfny-favorites-and-more-at-a-trusted-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-resin-picks-at-a-white-plains-dispensary/
https://leafologycannabiscompany.com/blog/why-vape-pens-are-a-go-to-option-including-live-resin-picks-at-a-white-plains-dispensary/


[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/

_6 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P2] 6 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/medical-customers/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 74 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/pre-rolls/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 66 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/vaporizers/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 67 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/
https://leafologycannabiscompany.com/medical-customers/
https://leafologycannabiscompany.com/pre-rolls/
https://leafologycannabiscompany.com/vaporizers/


https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-

dispensary-destination/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 83 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://leafologycannabiscompany.com/edibles-dosing-guide/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 125 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/promos-events/420-dispensary-

deals-westchester/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/
https://leafologycannabiscompany.com/visit/peekskill-ny-cannabis-dispensary-destination/
https://leafologycannabiscompany.com/visit/white-plains-ny-dispensary/
https://leafologycannabiscompany.com/edibles-dosing-guide/
https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/
https://leafologycannabiscompany.com/promos-events/420-dispensary-deals-westchester/


https://leafologycannabiscompany.com/product/eighth-brother-flower-3-

54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 117 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-

strawberry-di-6377ef8d4f37d5000a8ea86c/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 104 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-

iced-lemonade-di-6377ef614f37d5000a8ea3f4/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 108 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-

3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-indica-gorilla-glue-di-6377ef584f37d5000a8e9f12/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/stoney-infused-preroll-1g-strawberry-di-6377ef8d4f37d5000a8ea86c/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-hybrid-iced-lemonade-di-6377ef614f37d5000a8ea3f4/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/
https://leafologycannabiscompany.com/product/thc-living-topical-roll-on-3-oz-freeze-1-1-di-6377ef7c4f37d5000a8ea6b8/


[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-

indian-spice-di-6377ef684f37d5000a8ea557/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 106 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/blog/the-beginners-guide-to-

different-cannabis-strains-in-white-plains/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about cannabis strains doesn't have a meta description — the 150-160 character summary that

appears under your page title in Google search results. Without it, Google will randomly pull

[P2] No JSON-LD schema 🟠  HIGH

Your blog post lacks JSON-LD structured data — machine-readable code that tells Google what your content is

about. Without it, search engines can't confidently categorize your post as a guide, article

[P3] Title length 122 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about cannabis and pain relief is missing a meta description—the 150-160 character summary

that appears under your page title in Google search results. Without it, Google generates a ra

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about cannabis and pain relief doesn't include structured data—invisible code that tells Google

what type of content it is (article, product, FAQ, etc.). Without it, search engines have

[P3] Title length 83 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/product/1lyfe-preroll-1g-hybrid-indian-spice-di-6377ef684f37d5000a8ea557/
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/the-beginners-guide-to-different-cannabis-strains-in-white-plains/
https://leafologycannabiscompany.com/blog/what-can-weed-do-for-pain/


https://leafologycannabiscompany.com/blog/the-science-of-cannabis-

understanding-terpenes-and-flavonoids-in-white-plains/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about cannabis terpenes and flavonoids is missing a meta description — the 150-160 character

summary that appears below your page title in Google search results. Without it, Google gene

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about cannabis terpenes has no structured data markup—machine-readable code that tells

Google what the page is about. Google uses this to understand content type, author, publish date,

[P3] Title length 119 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/no-smoke-no-problem/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about smoke-free cannabis consumption has no meta description—the short text snippet that

appears under your page title in Google search results. Without it, Google generates a random e

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about cannabis products lacks structured data — machine-readable markup that tells Google

what your content is about. Without it, search engines have to guess whether a page is a produc

[P3] Title length 78 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-

vaping-in-westchester-elevating-your-cannabis-experience-with-potent-

and-portable-options/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post lacks a meta description—the 150-160 character summary that appears under your page title in

Google search results. Without it, Google generates a random snippet from your content, whic

[P2] No JSON-LD schema 🟠  HIGH

Your blog post doesn't include structured data — machine-readable code that tells Google and other search

engines what your content is about. Without it, search engines have to guess whether a page is

[P3] Title length 147 chars

[P3] Missing OpenGraph metadata

https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/
https://leafologycannabiscompany.com/blog/the-science-of-cannabis-understanding-terpenes-and-flavonoids-in-white-plains/
https://leafologycannabiscompany.com/blog/no-smoke-no-problem/
https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-elevating-your-cannabis-experience-with-potent-and-portable-options/
https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-elevating-your-cannabis-experience-with-potent-and-portable-options/
https://leafologycannabiscompany.com/blog/no-smoke-no-problem-vaping-in-westchester-elevating-your-cannabis-experience-with-potent-and-portable-options/


[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-

elevate-your-culinary-creations-cooking-with-cannabis-in-white-plains-

westchester/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post page doesn't have a meta description — the 155-character summary that appears below the

page title in Google search results. Without it, Google generates a random snippet from your cont

[P2] No JSON-LD schema 🟠  HIGH

Your blog post is missing structured data—a machine-readable format that tells Google what your content is

about. Without it, search engines treat your post as plain text and can't easily understand t

[P3] Title length 111 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/differences-between-

distillate-live-resin-and-rosin-vapes-in-white-plains-westchester/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about vape types is missing a meta description — the short text (usually 150–160 characters)

that appears under your page title in Google search results. Without it, Google generates a

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about vape types is missing structured data — machine-readable code that tells Google what

your content is about. Without it, search engines have to guess whether you're selling product

[P3] Title length 149 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/what-is-cannabis-tincture/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about cannabis tinctures doesn't have a meta description — the 155-character summary that

appears under your page title in Google search results. Without it, Google generates a random s

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about cannabis tinctures has no structured data markup — essentially, search engines can't

automatically understand what the page is about. Structured data (JSON-LD) is like a digital l

https://leafologycannabiscompany.com/blog/no-smoke-no-problem-elevate-your-culinary-creations-cooking-with-cannabis-in-white-plains-westchester/
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[P3] Title length 121 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about cannabis flower has no structured data markup — this is invisible code that tells Google

what your page is about. Without it, search engines have to guess whether your content is

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about vapes vs. pre-rolls doesn't have a meta description — the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random s

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about vapes vs pre-rolls has no structured data — extra code that tells search engines what

content is on the page. Without it, Google cannot easily understand that this is a comparison

[P3] Title length 117 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post doesn't have a meta description—the 155-character summary that appears below the page title

in Google search results. Without it, Google generates a random excerpt from your content, wh

[P2] No JSON-LD schema 🟠  HIGH

Your blog post lacks JSON-LD structured data, which is invisible markup that tells search engines what your

content is about. Without it, Google has to guess whether a page is a product listing, an ar

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/what-is-cannabis-flower/
https://leafologycannabiscompany.com/blog/vapes-vs-pre-rolls/
https://leafologycannabiscompany.com/blog/choose-the-right-cannabis/


https://leafologycannabiscompany.com/blog/types-of-concentrates/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about cannabis concentrates has no meta description — the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random snippet

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about cannabis concentrates doesn't include JSON-LD structured data—machine-readable code

that tells Google what the page is about (an article, its author, publish date, etc.). Without

[P3] Title length 125 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/thc-vs-cbd/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about THC vs CBD doesn't have a meta description — the 160-character summary that appears

below the page title in Google search results. Without it, Google generates a random excerpt fr

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about THC vs CBD has no structured data markup — metadata that tells Google what type of

content this is (article, product, FAQ, etc.). Without it, search engines have to guess the page

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-

storage-tips-and-shelf-life/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your blog post about cannabis edibles doesn't have a meta description—the 160-character summary that

appears below your page title in Google search results. Without it, Google generates a random snipp

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about cannabis edibles doesn't include JSON-LD schema markup — machine-readable code that

tells search engines what the page is about, who wrote it, and when it was published. Without i

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/types-of-concentrates/
https://leafologycannabiscompany.com/blog/thc-vs-cbd/
https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-shelf-life/
https://leafologycannabiscompany.com/blog/do-cannabis-edibles-expire-storage-tips-and-shelf-life/


https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-

joint/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about pre-rolls has no structured data—a machine-readable format that tells Google exactly

what type of content this is, who wrote it, and when it was published. Without it, search engi

[P3] Title length 114 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/cannabis-vs-marijuana-vs-

dispensary/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Meta descriptions are the 160-character summaries that appear under your page title in Google search results.

Without one, Google will auto-generate a snippet from your page text, which often looks in

[P2] No JSON-LD schema

[P3] Title length 123 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/exploring-legal-weed-

dispensary-westchester-nyc/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post doesn't have a meta description — the 160-character summary that appears below your headline

in Google search results. Without it, Google will auto-generate one from your page text, whi

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/best-dry-herb-vaporizers-

white-plains-scarsdale-harrison-westchester-nyc/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/
https://leafologycannabiscompany.com/blog/pre-roll-joint-blunt-spliff-joint/
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This blog post about dry herb vaporizers doesn't have a meta description — the 155-character summary that

appears under your page title in Google search results. Without it, Google generates a random

[P2] No JSON-LD schema 🟠  HIGH

Your blog post doesn't include structured data — machine-readable code that tells Google what your content is

about (e.g., article title, author, publish date). Without it, search engines have to gues

[P3] Title length 123 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-

brands-nyc/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post about pre-roll brands doesn't have a meta description — the 160-character summary that

appears below the page title in Google search results. Without it, Google generates a random snipp

[P2] No JSON-LD schema 🟠  HIGH

Your blog posts lack JSON-LD structured data — machine-readable code that tells Google what your content is

about (e.g., article title, author, publish date). Without it, search engines have to guess

[P3] Title length 120 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/exploring-thc-tincture-

1000mg-guide/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post doesn't have a meta description — the 155-character snippet that appears below your page title

in Google search results. Without it, Google generates a random excerpt from your content,

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about THC tinctures has no structured data—invisible HTML markup that tells Google what your

page is about. Without it, search engines guess at your content's meaning and may rank you l

[P3] Title length 128 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/the-devil-driver-strain/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/
https://leafologycannabiscompany.com/blog/discover-the-best-pre-roll-brands-nyc/
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This blog post about the Devil Driver strain is missing a meta description—the 150–160 character summary that

appears below the page title in Google search results. Without it, Google may auto-generat

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about the Devil Driver strain has no structured data—that's metadata in a machine-readable

format that tells Google what the page is about. Without it, search engines have to guess whet

[P3] Title length 121 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about THC concentrates doesn't have a meta description—the 160-character summary that

appears below the page title in Google search results. Without it, Google auto-generates a snippet

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about THC concentrates doesn't include JSON-LD structured data — machine-readable code

that tells Google what your content is about. Without it, search engines have to guess whether you

[P3] Title length 131 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-

brands/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about pre-roll brands doesn't have a meta description — the short text (usually 150–160

characters) that appears below your page title in Google search results. Without it, Google gener

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about pre-roll brands has no structured data markup — that's code that tells Google what the

page is about (a blog post, product review, etc.). Without it, search engines have to guess

[P3] Title length 140 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/finding-your-green/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

https://leafologycannabiscompany.com/blog/exploring-thc-concentrate/
https://leafologycannabiscompany.com/blog/finding-the-best-pre-roll-brands/
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This blog post doesn't have a meta description—the 155-character summary that appears under your page title

in Google search results. Without it, Google will auto-generate something from your page tex

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about finding your green product doesn't include JSON-LD schema markup — structured data

that tells Google what your content is about (a blog post, product review, etc.). Search engines

[P3] Title length 148 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about Revelry's Baby Yoda Pre-Rolls has no structured data markup—that's metadata in a

machine-readable format (JSON-LD) that tells Google what the page is about. Without it, search eng

[P3] Title length 129 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post page is missing a meta description — the 155-character summary that appears below your page

title in Google search results. Without it, Google may auto-generate a snippet from your cont

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about vaporizers doesn't include JSON-LD schema — that's code that tells Google what your

content is about (a blog post, a product, an article, etc.). Without it, search engines have to

[P3] Title length 124 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/the-quest-for-the-perfect-

puff/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This blog post page doesn't have a meta description — that's the 155-character summary that appears under

your page title in Google search results. Without it, Google generates one automatically, whic

[P2] No JSON-LD schema

https://leafologycannabiscompany.com/blog/revelrys-baby-yoda-pre-rolls/
https://leafologycannabiscompany.com/blog/premium-flower-vaporizers/
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[P3] Title length 139 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-

options/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about tinctures doesn't have a meta description—the 160-character summary that appears under

your page title in Google search results. Without it, Google generates a random snippet from

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about tinctures has no structured data markup—that's metadata (think: a digital label) that tells

search engines what the page is about, who wrote it, when it was published, and whether

[P3] Title length 140 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/strains-in-westchester-ny/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post about cannabis strains in Westchester lacks a meta description — a 160-character summary that

appears below the page title in Google search results. Without it, Google may auto-generate

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about cannabis strains doesn't include structured data—a standardized format that tells search

engines what your content is about. This makes it harder for Google to understand and cate

[P3] Title length 160 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/lowest-cost-weed-per-gram-

in-westchester/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post has no meta description — the 155-character summary that appears below your page title in

Google search results. Without it, Google may auto-generate a snippet from your page content, w

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about weed pricing has no structured data—think of it as metadata that tells Google what your

page is really about. Without it, search engines have to guess whether your content is a ne

https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/
https://leafologycannabiscompany.com/blog/tinctures-including-1000mg-options/
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[P3] Title length 141 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-

white-plains/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your blog post about pre-roll brands in White Plains is missing a meta description — that's the 160-character

summary that appears under your page title in Google search results. Without it, Google ge

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about pre-roll brands has no JSON-LD structured data — this is code that tells Google what your

content is about (article, product, organization, etc.). Without it, search engines have

[P3] Title length 161 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 131 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/topicals-in-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 164 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 124 chars

https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/
https://leafologycannabiscompany.com/blog/best-pre-roll-brands-in-white-plains/
https://leafologycannabiscompany.com/blog/guide-to-cannabis-flower/
https://leafologycannabiscompany.com/blog/topicals-in-white-plains/
https://leafologycannabiscompany.com/blog/relief-tincture-white-plains/


[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-

in-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 154 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/edibles-in-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 147 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/best-cannabis-vapes-in-

white-plains-westchester-county-the-ultimate-guidebest-cannabis-vapes-

in-white-plains-westchester-county-the-ultimate-guide/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 209 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/concentrates-in-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 155 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/buy-oral-cannabis-products-in-white-plains/
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https://leafologycannabiscompany.com/blog/stress-free-this-winter-with-

cannabis/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 140 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/sweet-treats-for-your-

valentine-cone-edibles-worth-exploring/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/why-the-nanticoke-brand-

stands-out-at-a-white-plains-dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 120 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/shop/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/order-confirmation/

_5 findings on this page_
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[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 75 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/specials/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/about/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/terms-conditions/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 75 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/specials/
https://leafologycannabiscompany.com/about/
https://leafologycannabiscompany.com/terms-conditions/
https://leafologycannabiscompany.com/visit/


https://leafologycannabiscompany.com/news/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/accessibility-statement/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 80 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/high-roller-club-rewards/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/delivery/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 2 image(s) missing alt text

https://leafologycannabiscompany.com/flower/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/news/
https://leafologycannabiscompany.com/accessibility-statement/
https://leafologycannabiscompany.com/high-roller-club-rewards/
https://leafologycannabiscompany.com/delivery/
https://leafologycannabiscompany.com/flower/


[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/edibles/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/the-leafology-guarantee/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 80 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/green-wednesday-cannabis-deals/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 87 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/darien-ct-cannabis-

dispensary-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 67 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/dobbs-ferry-ny-cannabis-

dispensary/

_5 findings on this page_

https://leafologycannabiscompany.com/edibles/
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[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/mamaroneck-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/mount-kisco-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

https://leafologycannabiscompany.com/visit/harrison-ny-cannabis-dispensary/
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https://leafologycannabiscompany.com/visit/mount-vernon-ny-cannabis-dispensary/


[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-

dispensary-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/new-rochelle-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/norwalk-ct-cannabis-

dispensary-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 68 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/
https://leafologycannabiscompany.com/visit/new-canaan-ct-cannabis-dispensary-white-plains/
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https://leafologycannabiscompany.com/visit/ossining-ny-cannabis-dispensary/


[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/rye-brook-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/scarsdale-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/sleepy-hollow-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 74 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/port-chester-ny-cannabis-dispensary/
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https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/visit/yonkers-ny-cannabis-

dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 68 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/brass-knuckles/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/cone-edibles/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/dank-gummies/

_5 findings on this page_

[P2] Missing meta description

https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/
https://leafologycannabiscompany.com/visit/tarrytown-ny-cannabis-dispensary/
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https://leafologycannabiscompany.com/brand/dank-gummies/


[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/dog-walkers/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 68 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/eureka-vapes/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/holiday-vapes/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/jams-edibles/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/lychee-vapes/

https://leafologycannabiscompany.com/brand/dog-walkers/
https://leafologycannabiscompany.com/brand/eureka-vapes/
https://leafologycannabiscompany.com/brand/holiday-vapes/
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_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/moods-vapes/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 68 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/rythm-vape-pen/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/weed-cones-edibles/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 75 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/promos-events/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/moods-vapes/
https://leafologycannabiscompany.com/brand/rythm-vape-pen/
https://leafologycannabiscompany.com/brand/weed-cones-edibles/
https://leafologycannabiscompany.com/promos-events/


https://leafologycannabiscompany.com/holidaydeals/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 86 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/dispensary-near/darien-ct/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 94 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/weed-delivery/dobbs-ferry-ny/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 107 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/weed-delivery/harrison-ny/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 105 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/weed-delivery/mamaroneck-ny/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 107 chars

[P3] Missing OpenGraph metadata

https://leafologycannabiscompany.com/holidaydeals/
https://leafologycannabiscompany.com/dispensary-near/darien-ct/
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[P3] Missing Twitter card

https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 108 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/dispensary-near/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/weed-delivery/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/how-to-keep-weed-fresh/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 111 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/how-to-unclog-weed-vape-pen/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

https://leafologycannabiscompany.com/weed-delivery/mount-kisco-ny/
https://leafologycannabiscompany.com/dispensary-near/
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[P3] Title length 149 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/march-strain-madness-

westchester/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/cp_coa/coa-results-1/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/cp_coa/coa-results-2/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/pin/example-pin-1/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/pin/example-pin-2/
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_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/pin/example-pin-3/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/calendar/pop-ups/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/location/leafology-ny-white-plains/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 84 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/papa-barkley-topical-

cream-30ml-1-1-di-6377ef894f37d5000a8ea822/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 107 chars

[P3] Missing OpenGraph metadata

https://leafologycannabiscompany.com/blog/pin/example-pin-3/
https://leafologycannabiscompany.com/calendar/pop-ups/
https://leafologycannabiscompany.com/location/leafology-ny-white-plains/
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[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/empire-edibles-tincture-

125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/empire-edibles-tincture-

500mg-cherry-pie-di-6377ef8d4f37d5000a8ea864/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/abx-vape-cartridge-live-

resin-1g-hybrid-super-lemon-glue-di-6377ef8e4f37d5000a8ea87f/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 128 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/flow-kana-flower-farmer-

s-res-3-5g-hybrid-larry-cake-di-6377ef534f37d5000a8e9d6c/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 123 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/empire-edibles-tincture-125mg-cherry-pie-di-6377ef634f37d5000a8ea45b/
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https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-

sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 119 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-

hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 111 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-

sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 111 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/farmer-and-the-felon-

flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 120 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-sativa-super-lemon-haze-di-6377ef904f37d5000a8ea8c6/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/cru-prerolls-3g-6pk-hybrid-chocolate-thai-di-6377efab4f37d5000a8eab37/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-sativa-golden-goat-di-6377ef9e4f37d5000a8eaa27/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-runtz-cake-di-6377ef9f4f37d5000a8eaa34/


https://leafologycannabiscompany.com/product/chill-edibles-100mg-

cappuccino-crunch-di-6377ef934f37d5000a8ea93a/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 105 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/papa-barkley-rosin-

chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 119 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/honeydew-farms-flower-

3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 108 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-

indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 115 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/chill-edibles-100mg-cappuccino-crunch-di-6377ef934f37d5000a8ea93a/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/papa-barkley-rosin-chocolate-100mg-milk-chocolate-di-6377ef904f37d5000a8ea8d5/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-indica-cake-di-6377ef534f37d5000a8e9da4/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/
https://leafologycannabiscompany.com/product/select-vape-cartridge-3g-indica-purple-punch-di-6377ef9a4f37d5000a8ea9b9/


https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-

hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/forbidden-flowers-

prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 126 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/balanced-flower-3-5g-

hybrid-nerdz-di-6377ef614f37d5000a8ea393/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 103 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/pure-beauty-prerolls-

babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/kamatree-flower-3-5g-hybrid-georgia-pie-di-6377ef7b4f37d5000a8ea6a6/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-hybrid-citrus-sunburst-di-6377ef764f37d5000a8ea628/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-nerdz-di-6377ef614f37d5000a8ea393/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-babies-3-5g-10pk-indica-blend-di-6377ef824f37d5000a8ea736/


https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-

10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 127 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-

trinidad-og-di-6377ef834f37d5000a8ea765/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 105 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-

indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-

sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 114 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-caramel-mocha-milk-chocolate-di-6377ef794f37d5000a8ea681/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/mota-flower-3-5g-hybrid-trinidad-og-di-6377ef834f37d5000a8ea765/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/pure-beauty-prerolls-1g-indica-mendo-x-tahoe-pie-di-6377ef794f37d5000a8ea679/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/
https://leafologycannabiscompany.com/product/high-caliber-flower-3-5g-sativa-cherry-punch-di-6377ef8a4f37d5000a8ea82d/


https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-

10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-

10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/select-elite-5g-live-

cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 115 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/balanced-flower-3-5g-

hybrid-banana-split-di-6377efb74f37d5000a8eac63/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-dark-chocolate-di-6377ef734f37d5000a8ea5eb/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/bhang-edibles-chocolate-10mg-milk-chocolate-di-6377ef584f37d5000a8e9f31/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/select-elite-5g-live-cartridge-hybrid-sfv-og-di-6377ef9a4f37d5000a8ea9c0/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/
https://leafologycannabiscompany.com/product/balanced-flower-3-5g-hybrid-banana-split-di-6377efb74f37d5000a8eac63/


https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-

indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 108 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-

6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 116 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/papa-barkley-edibles-

gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 119 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/brio-edibles-gummies-

100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/jet-fuel-flower-3-5g-indica-jet-fuel-og-di-6377efba4f37d5000a8eacb2/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/almora-farm-preroll-3-5g-6pk-hybrid-sour-berry-di-6377efb84f37d5000a8eac7c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-juicy-orange-di-6377ef704f37d5000a8ea5c1/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/
https://leafologycannabiscompany.com/product/brio-edibles-gummies-100mg-apricot-delight-di-6377ef8e4f37d5000a8ea88f/


https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-

5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 116 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/eighth-brother-flower-3-

54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/cann-edibles-infused-

beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 122 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-

hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/legion-of-bloom-flower-3-5g-hybrid-chili-verde-di-6377ef764f37d5000a8ea631/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/eighth-brother-flower-3-54g-hybrid-og-kush-di-6377ef6f4f37d5000a8ea5a8/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/cann-edibles-infused-beverage-6pk-grape-fruit-rosemary-di-6377ef574f37d5000a8e9eaf/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/
https://leafologycannabiscompany.com/product/henry-s-flower-3-5g-hybrid-key-lime-pie-di-6377ef6c4f37d5000a8ea588/


https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-

5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 116 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/honeydew-farms-flower-

3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/farmer-and-the-felon-

flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 120 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-

hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/flow-kana-flower-gold-3-5g-hybrid-rolls-choice-di-6377ef824f37d5000a8ea745/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/honeydew-farms-flower-3-5g-hybrid-mac-1-di-6377ef854f37d5000a8ea7ad/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/farmer-and-the-felon-flower-3-5g-hybrid-kush-mints-di-6377efbc4f37d5000a8ead0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/
https://leafologycannabiscompany.com/product/high-garden-flower-3-5g-hybrid-orange-creamsicle-di-6377efa94f37d5000a8eab0d/


https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-

indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 107 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-

hybrid-cali-cake-di-6377efb54f37d5000a8eac24/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/forbidden-flowers-

prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 123 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-

sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/fire-cut-flower-3-5g-indica-cake-boss-di-6377ef5d4f37d5000a8ea18f/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/cali-lotus-flower-3-5g-hybrid-cali-cake-di-6377efb54f37d5000a8eac24/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/forbidden-flowers-prerolls-1g-2pk-sativa-cherry-charm-di-6377efbb4f37d5000a8eace1/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/
https://leafologycannabiscompany.com/product/honeyleaf-flower-3-5g-sativa-snickerdoodle-di-6377ef914f37d5000a8ea8e4/


https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-

london-pound-mintz-di-6377ef634f37d5000a8ea48d/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/simple-farms-flower-3-

5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/wrap-rake-accessories-

glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 121 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-

hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/lolo-flower-3-5g-hybrid-london-pound-mintz-di-6377ef634f37d5000a8ea48d/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/simple-farms-flower-3-5g-hybrid-strawberry-jelly-di-6377efb84f37d5000a8eac81/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/wrap-rake-accessories-glass-3-chillum-one-hitter-di-6377efa84f37d5000a8eab05/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-hybrid-24k-cake-di-6377efa54f37d5000a8eaaba/


https://leafologycannabiscompany.com/product/jetty-concentrates-

unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-

6377ef6f4f37d5000a8ea5b0/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 141 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-

tropaya-di-6377ef534f37d5000a8e9d85/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 102 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/caliva-flower-3-5g-

hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 107 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/caliva-flower-3-5g-

hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 117 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/jetty-concentrates-unrefined-live-resin-dablicator-1g-sativa-thc-bomb-di-6377ef6f4f37d5000a8ea5b0/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-sativa-tropaya-di-6377ef534f37d5000a8e9d85/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-georgia-pie-di-6377efbc4f37d5000a8ead06/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/
https://leafologycannabiscompany.com/product/caliva-flower-3-5g-hybrid-peanut-butter-souffle-di-6377efab4f37d5000a8eab26/


https://leafologycannabiscompany.com/product/rollers-delight-flower-

28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-

hybrid-gelato-di-6377ef614f37d5000a8ea3ae/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/moxie-concentrates-live-

resin-sauce-1g-hybrid-ice-cream-sherbert-di-

6377ef704f37d5000a8ea5b8/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 136 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-

indica-pb-souffle-di-6377efac4f37d5000a8eab40/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 114 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-28g-hybrid-gelato-di-6377ef744f37d5000a8ea60c/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/rollers-delight-flower-7g-hybrid-gelato-di-6377ef614f37d5000a8ea3ae/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/moxie-concentrates-live-resin-sauce-1g-hybrid-ice-cream-sherbert-di-6377ef704f37d5000a8ea5b8/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/
https://leafologycannabiscompany.com/product/rollers-delight-flower-14g-indica-pb-souffle-di-6377efac4f37d5000a8eab40/


https://leafologycannabiscompany.com/product/papa-barkley-edibles-

gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 118 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/papa-barkley-edibles-

gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 117 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-

pb-souffle-di-6377efb54f37d5000a8eac11/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 105 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/yummi-karma-tincture-

300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 106 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-berry-burst-di-6377efb84f37d5000a8eac8d/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/papa-barkley-edibles-gummies-100mg-tart-apple-di-6377ef764f37d5000a8ea62c/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/nativ-flower-3-5g-indica-pb-souffle-di-6377efb54f37d5000a8eac11/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-300mg-stay-lifted-di-6377efa24f37d5000a8eaa58/


https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-

5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 121 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-

5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 124 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-

sativa-chem-sour-di-6377efb24f37d5000a8eabb4/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/floracal-flower-3-5g-

sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-master-yoda-di-6377efb94f37d5000a8eac9f/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/jetpacks-infused-preroll-5g-6pk-indica-purple-martian-di-6377ef8f4f37d5000a8ea8b0/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/mota-prerolls-3-5g-10pk-sativa-chem-sour-di-6377efb24f37d5000a8eabb4/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/
https://leafologycannabiscompany.com/product/floracal-flower-3-5g-sativa-peach-crescendo-di-6377efaa4f37d5000a8eab17/


https://leafologycannabiscompany.com/product/deep-sea-moonrock-

tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/deep-sea-moonrock-

flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-

1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 108 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-

honeydew-di-6377ef724f37d5000a8ea5e3/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 104 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-tinctures-1000mg-watermelon-di-6377ef7e4f37d5000a8ea6ea/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/deep-sea-moonrock-flower-1g-vanilla-mango-di-6377ef934f37d5000a8ea92c/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/big-chief-vape-cartridge-1g-indica-gdp-di-6377ef6b4f37d5000a8ea576/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/
https://leafologycannabiscompany.com/product/jeeters-preroll-1g-sativa-honeydew-di-6377ef724f37d5000a8ea5e3/


https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-

5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 128 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/legion-of-bloom-vape-

cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-

6377ef624f37d5000a8ea426/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 144 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-

gelato-hybrid-di-6377ef714f37d5000a8ea5db/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/rove-concentrate-

diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 120 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/roller-s-delight-preroll-3-5g-7pk-lucky-7-indica-granimals-di-6377ef634f37d5000a8ea47d/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/legion-of-bloom-vape-cartridge-live-resin-1g-hybrid-peanut-butter-breath-di-6377ef624f37d5000a8ea426/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/stiiizy-vape-cartridge-1g-gelato-hybrid-di-6377ef714f37d5000a8ea5db/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-1g-hybrid-cherry-punch-di-6377ef874f37d5000a8ea7f1/


https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-

indica-northern-lights-di-6377ef8d4f37d5000a8ea874/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 114 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-

sativa-lemon-haze-di-6377efb44f37d5000a8eac08/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-

hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 110 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/kanha-edibles-nano-

gummies-100mg-indica-passionfruit-paradise-di-

6377ef864f37d5000a8ea7d5/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 133 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-indica-northern-lights-di-6377ef8d4f37d5000a8ea874/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/left-coast-vape-pod-1g-sativa-lemon-haze-di-6377efb44f37d5000a8eac08/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-lemon-ozk-di-6377ef7b4f37d5000a8ea6ae/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/
https://leafologycannabiscompany.com/product/kanha-edibles-nano-gummies-100mg-indica-passionfruit-paradise-di-6377ef864f37d5000a8ea7d5/


https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-

cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 115 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-

hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-

indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 112 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/canndescent-preroll-3g-

6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 121 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/kurvana-ascnd-vape-cartridge-1g-hybrid-mimosa-di-6377efae4f37d5000a8eab68/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-hybrid-og-berry-blast-di-6377ef944f37d5000a8ea95a/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/fun-uncle-flower-3-5g-indica-bouquet-blitz-di-6377ef634f37d5000a8ea497/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/
https://leafologycannabiscompany.com/product/canndescent-preroll-3g-6pk-indica-hybrid-cruise-232-di-6377efb04f37d5000a8eab95/


https://leafologycannabiscompany.com/product/punch-rocket-infused-

preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 126 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/punch-rocket-infused-

preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-

6377ef784f37d5000a8ea669/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 135 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-

10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 126 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/yummi-karma-tincture-

1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 108 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-mac-1-x-do-lato-di-6377efb74f37d5000a8eac73/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/punch-rocket-infused-preroll-1-6g-hybrid-jack-herer-x-strawpicana-di-6377ef784f37d5000a8ea669/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/dr-norms-edible-10mg-10pk-cookies-vegan-pb-chocolate-chip-di-6377ef6a4f37d5000a8ea570/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/
https://leafologycannabiscompany.com/product/yummi-karma-tincture-1000mg-wicked-apple-di-6377ef924f37d5000a8ea91f/


https://leafologycannabiscompany.com/product/rove-concentrate-

diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 115 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-

sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 114 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/kurvana-accessories-

battery-dove-grey-di-6377ef834f37d5000a8ea75d/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 105 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-

hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 113 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/rove-concentrate-diamonds-hybrid-mango-gelato-di-6377ef5a4f37d5000a8ea00f/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/malibu-gold-flower-3-5g-sativa-platinum-jack-di-6377efa04f37d5000a8eaa41/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/kurvana-accessories-battery-dove-grey-di-6377ef834f37d5000a8ea75d/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/
https://leafologycannabiscompany.com/product/wonderbrett-flower-3-5g-hybrid-pink-picasso-di-6377ef684f37d5000a8ea54e/


https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-

indica-kush-cake-di-6377ef704f37d5000a8ea5b5/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 109 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/mota-concentrates-1g-

hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 107 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/raspberry-sativa-

enhanced-gummies-50mg/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 97 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/ginger-beer-50mg/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 89 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/raspberry-truffle-bite/

_5 findings on this page_

https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/
https://leafologycannabiscompany.com/product/gold-flora-flower-3-5g-indica-kush-cake-di-6377ef704f37d5000a8ea5b5/
https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/mota-concentrates-1g-hybrid-papaya-og-di-6377ef664f37d5000a8ea52e/
https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/
https://leafologycannabiscompany.com/product/raspberry-sativa-enhanced-gummies-50mg/
https://leafologycannabiscompany.com/product/ginger-beer-50mg/
https://leafologycannabiscompany.com/product/raspberry-truffle-bite/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 79 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/pineapple-skunk/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/cream-soda-indica-magic-

drops-150mg/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 94 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/grapefruit/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 67 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/northern-lights-cartridge-

1g/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 87 chars

[P3] Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/pineapple-skunk/
https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/
https://leafologycannabiscompany.com/product/cream-soda-indica-magic-drops-150mg/
https://leafologycannabiscompany.com/product/grapefruit/
https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/
https://leafologycannabiscompany.com/product/northern-lights-cartridge-1g/


[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 78 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/banana-bread/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/uranium-v2/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 67 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/dark-chocolate-spark-

10mg/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 84 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/sirius-black/

_5 findings on this page_

https://leafologycannabiscompany.com/product/hypnos-tincture-1oz/
https://leafologycannabiscompany.com/product/banana-bread/
https://leafologycannabiscompany.com/product/uranium-v2/
https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/
https://leafologycannabiscompany.com/product/dark-chocolate-spark-10mg/
https://leafologycannabiscompany.com/product/sirius-black/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/g-13-cartridge-1g/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/north-american-elite-

cartridge-1g/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 92 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/brownie-truffles/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/almond-truffle-bites-5-

pack-50mg/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 91 chars

[P3] Missing OpenGraph metadata

https://leafologycannabiscompany.com/product/g-13-cartridge-1g/
https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/
https://leafologycannabiscompany.com/product/north-american-elite-cartridge-1g/
https://leafologycannabiscompany.com/product/brownie-truffles/
https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/
https://leafologycannabiscompany.com/product/almond-truffle-bites-5-pack-50mg/


[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/trainwreck/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 67 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/dog-park/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-

squib/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 88 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/indica-transdermal-patch/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 81 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-

5g/

_5 findings on this page_

https://leafologycannabiscompany.com/product/trainwreck/
https://leafologycannabiscompany.com/product/dog-park/
https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/
https://leafologycannabiscompany.com/product/lunchbox-alchemy-cherry-squib/
https://leafologycannabiscompany.com/product/indica-transdermal-patch/
https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/
https://leafologycannabiscompany.com/product/grape-gatsby-pax-pod-0-5g/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 84 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/contact/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/faq/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-

plains-leafology-westchester-delivery/

_4 findings on this page_

[P2] Missing meta description

[P3] Title length 126 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/whiteplainsdiner/

_4 findings on this page_

https://leafologycannabiscompany.com/product/gsc-cured-resin-1g/
https://leafologycannabiscompany.com/contact/
https://leafologycannabiscompany.com/faq/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/
https://leafologycannabiscompany.com/shop-new-weed-brands-in-white-plains-leafology-westchester-delivery/
https://leafologycannabiscompany.com/whiteplainsdiner/


[P2] Missing meta description

[P3] Title length 92 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/brand/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/blog/events/canna-cafe-the-

cookery/

_4 findings on this page_

[P2] Missing meta description

[P3] Title length 81 chars

[P3] Missing OpenGraph metadata

[P3] 1 image(s) missing alt text

https://leafologycannabiscompany.com/calendar/promos/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/product/pax-era/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/home/

_3 findings on this page_

[P2] Missing meta description

https://leafologycannabiscompany.com/brand/
https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/
https://leafologycannabiscompany.com/blog/events/canna-cafe-the-cookery/
https://leafologycannabiscompany.com/calendar/promos/
https://leafologycannabiscompany.com/product/pax-era/
https://leafologycannabiscompany.com/home/


[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://leafologycannabiscompany.com/package.json

_1 finding on this page_

[P3] package.json publicly accessible

https://leafologycannabiscompany.com/wp-login.php

_1 finding on this page_

[P0] Sensitive artifact exposed: /wp-login.php 🔴  DO FIRST

Your WordPress admin login page (/wp-login.php) is publicly accessible and visible to search engines and

attackers. While this is WordPress's default behavior, it's a security risk because bad actors
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